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Preface

Cisco Offshore Wind Farm Release 1.2 implementation guide includes advanced REP ring design and a standalone compact onshore
substation implementation details for the turbine operator network, along with the asset operator network. It also discusses offshore
wind farm solution use cases, such as wind farm operator enterprise network services, physical security, miscellaneous systems,
supervisory control and data acquisition (SCADA) for wind turbine generators, and more. Implementation guidance also is provided for
the Cisco Ultra-Reliable Wireless (URWB) network for service operations vessel (SOV) to offshore substation (OSS) connectivity.

This document includes information about the solution architecture and possible deployment models and provides guidelines for
deployment. It also discusses best practices and potential issues to be aware of when deploying the reference architecture.

This Release 1.2 supersedes and replaces the Cisco Offshore Wind Farm Release 1.1 Implementation Guide.

Document Objective and Scope

This implementation guide provides comprehensive details about the Cisco renewable energy offshore wind farm asset operator’s
network infrastructure implementation. This implementation leverages Cisco Industrial Ethernet switches, Cisco Catalyst 9300 and 9500
Series switches, Cisco Next Generation Firewall (NGFW), Cisco Digital Network Architecture Center (Cisco Catalyst Center), Cisco C9800
WLC and APs, and URWB.

This document also provides detailed information about wind farm implementation use cases, including physical safety and security and
offshore wind farm network enterprise services such as IP telephony, network security, and so on. The implementation steps that are
described in this document can be used as a reference for wind farm deployments as described in Cisco Solution for Renewable Energy:
Offshore Wind Farm 1.2 Design Guide:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind Farm/Wind-Farm 1-2 Design Guide.pdf

Detailed implementation for other wind farm use cases such as the turbine vendor’s control network, power automation and control,
and marine related systems that are not validated in this solution and are outside the scope of this document.

This document provides detailed information about the implementation of the Cisco Renewal Energy Offshore Wind Farm operator’s
network, which includes the implementation of a wind farm offshore, onshore access and core network services, Cisco SD-WAN
backhaul, network security service, wind farm data enter, and management applications.

This document provides example of offshore wind farm operator’s network configurations and WAN backhaul with private multiprotocol
label switching (MPLS) network configuration for the deployment models and network topologies that are validated in the solution.
Detailed implementation of network routing protocols and configuring MPLS network backhaul is beyond the scope of this document.

Audience

The audience for this guide includes, but is not limited to, system architects; network, computer, and systems engineers who manage
offshore wind farm assets; field consultants; Cisco Solution Support specialists; and customers.

You should be familiar with networking protocols and IP routing, basic network security, and QoS. You also should have some
understanding of server virtualization using hypervisor and the Cisco Renewable Energy Offshore Wind Farm Solution Architecture,
which is described in https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind Farm/Wind-Farm 1-

2 Design Guide.pdf.



https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/Wind-Farm_1-2_Design_Guide.pdf
https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/WF_1-1_DG.pdf?dtid=odicdc000509f
https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/WF_1-1_DG.pdf?dtid=odicdc000509f
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Introduction

Chapter 1: Introduction

Most countries are investing in renewable energy generation to accelerate the move toward carbon neutrality. The following
technologies are growing steadily and being deployed at scale:

= Onshore and offshore wind
= Onshore solar farms
= Onshore battery storage

Other renewable technologies also are being researched and developed, such as wave, tidal, and energy storage technologies. We will
start to see more innovative renewable energy deployments in the future.

Some countries are leading the push to integrate renewable energy into the grid. China and the UK are examples of countries leading
the way with large deployments of wind farms, both onshore and offshore. European countries in general are setting big targets for
offshore wind farms. And the United States is predicted to become a major offshore wind energy producer in the coming decade. Cisco
can help with renewable energy technologies, and this document focuses on the challenges offshore wind farms are facing and the
solutions that Cisco offers to address them.

Deploying and operating renewable technologies can be challenging. They need to operate in harsh and remote locations, a secure and
reliable network is required, and that network needs to work flawlessly with the various OT and IT technologies that form the solution.

The offshore wind farm solution architecture includes ruggedized access network devices, such as Cisco Industrial Ethernet (IE) switches
and Cisco Industrial Routers (IR). It also includes Cisco Catalyst 9300 and 9500 Series switches, Cisco Next Generation Firewalls (NGFW)
and the Cisco Unified Computing Systems (UCS) servers, C9800 Wireless LAN Controllers (WLCs), URWB, and other network
infrastructure components. These devices and components provide a scalable and secure network for wind farm solution use cases.

The wind farm solution implementation is based on the design that is recommended in

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind _Farm/Wind-Farm 1-2 Design Guide.pdf

Implementation Flow

Figure 1-1 shows the implementation flow that this document describes for an offshore wind farm network. We recommend that a wind
farm network be implemented according to this flow.

Figure 1-1: Wind Farm Solution Implementation Flow
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The document addresses the implementation of the following network building blocks in sequence to implement an end-to-end offshore

wind farm solution:

=  Implementation of an offshore substation (OSS) network, which includes OSS core Catalyst 9500 Series switches StackWise Virtual
(SVL), an infrastructure access switch stack using Catalyst 9300 Series switches, a farm area network (FAN) ring aggregation switch
stack, and an OSS DMZ network with a firewall.

=  Implementation of a FAN ring topology on Cisco Catalyst Industrial Ethernet switches, including REP configuration for FAN
resiliency, and a turbine area network (TAN) with REP subtended rings for high availability.

a


https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/Wind-Farm_1-2_Design_Guide.pdf
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Deployment of an OSS infrastructure access network switch stack and related applications such as Cisco Cyber Vision Center (local),
Cisco Secure Network Analytics (SNA) NetFlow collector, OPC-UA Server applications, and more.

Implementation of an onshore substation (ONSS) network, which includes ONSS core Catalyst 9500 Series switches StackWise
Virtual (SVL), an ONSS network access switch stack using Catalyst 9300 Series switches, and an ONSS DMZ network with a firewall.

Implementation of WAN backhaul using Cisco Industrial 8340 Series rugged routers (IR8340) leveraging a Cisco SD-WAN
deployment.

Deployment of wind farm control center network components, including a WAN headend, a firewall, and applications such as Cisco
Catalyst Center, Cisco ISE, Cyber Vision Global Center, SNA Manager, and so on.

Deployment of wireless network components, such as WLC, access points, URWB radios, and so on for wind farm wireless
network access.

Implementation of network management services using Cisco Catalyst Center, and automated provisioning of wind farm
network components using Cisco Catalyst Center workflows and day N template features.

Configuration of network security components, such as Firepower, Cyber Vision network sensors, SNA NetFlow, and so on, and
quality of service (QoS) provisioning in the OSS network.
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Chapter 2: Solution Network Topology and
Addressing

This chapter discusses the various topologies that are used for the wind farm solution validation and implementation. It includes the
following topics:

Solution Validation Topologies
Network VRFs and VLANs
IP Addressing

Solution Components

Solution Validation Topologies

Two deployment topologies have been validated as part of the Offshore Wind Farm CVD Solution validation effort:

Offshore wind farm wired network topology with turbine area networks (TAN), a farm area network (FAN), an offshore substation
(0SS), an onshore substation (ONSS), WAN backhaul, and a control center. See Figure 2-1, which shows the offshore wind farm
wired network topology, including endpoints for various validated wind farm use cases.

Offshore wind farm wireless network topology, consisting of Cisco WLCs and access points that provide Wi-Fi access for the OSS,
FAN, and TAN, and a URWB network that provides wireless connectivity for SOVs back to the OSS. See Figure 2-2.
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Figure 2-1: Wind Farm 1.2 Wired Network Topology
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Figure 2-2: Wind Farm 1.1 Wireless Network Topology
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Network VRFs and VLANs

This section describes example virtual routing and forwarding (VRF) and VLANSs that are configured in the wind farm solution network
and layer 3 routing configuration between OSS and ONSS core networks. The wind farm network is segmented by using VLANs for
various end points and applications traffic. There is a dedicated VRF and VLAN for each service and endpoint and for application traffic in
the network. Table 2-1 provides examples of VRFs and VLANSs in the network.
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Table 2-1: Examples of VLANs and VRFs Validated in this Implementation

VRF Name VLAN ID VLAN Name and Description

Management_VRF = 100 = (OSSinfrastructure applications and services VLAN
(VRF for network management = 101 = Network device management VLAN
traffic) = 102 = Cyber Vision sensors IP subnet for collection network
= 103 = Wi-Fi APs management VLAN
= 104 = Network management traffic simulation VLAN
= 105 = REP admin VLAN
= 106 =  URWB management VLAN
VnV_VRF = 500 = VLANSs for CCTV cameras in FAN and TAN
(voice and video VRF) = 600 = [P telephony devices voice VLAN
Wi-Fi access = 900 = Employee and contractor Wi-Fi access
= 901 = Guest Wi-Fi access
URWB = 1000 =  URWSB traffic
OT_VRF = 700 = SCADA OT traffic VLAN in TAN and turbine base network
(TBN)

(SCADA and other OT traffic)
Example: turbine controller VLAN, SCADA clients

Global routing table (GRT) = 800 = (OSS local VLAN in OSS network only (not to be routed)
= 801 = ONSS local VLAN in ONSS network only (not to be routed)

Table 2.2 VLANs used in Turbine operator network

VLAN Name VLAN ID Descrip¢pn
Multicast_VLAN 5 Used for multicast
PVLAN_vlan 10 Primary VLAN (Used for OPC-UA)
Traffic-test 20 Traffic test VLAN
Isolated_vlan 101 Isolated secondary VLAN
Management_VLAN 111 Management VLAN

IP Addressing

This section describes example IP addressing prefixes that are used in the topologies that Figure 2-1 and Figure 2-2 show.

Note: The IP addresses that are shown in this section are examples used only for the solution validation as internal subnetworks in the
CVD lab. This information provides a reference for selecting subnets for the solution implementation. We recommend choosing private
network prefixes and an IP addressing scheme based on the solution deployment and devices that are connected to the offshore wind
farm network.
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Table 2-2: Example list of IP Addressing Validated in this Implementation

VRF Name

VLAN ID

Subnet ID

Default
Gateway

Description

Management_VRF 100 10.10.100.0/24 10.10.100.1 0SS infrastructure applications and
services VLAN
101 10.10.101.0/24 10.10.101.1 Network switches, routers, FP
management VLAN
102 10.10.102.0/24 10.10.102.1 Cyber Vision sensors IP subnet for
collection network
103 10.10.103.0/24 10.10.103.1 Wi-Fi AP management
104 10.10.104.0/24 10.10.104.1 VLAN for network management traffic
105 10.10.105.0/24 10.10.105.1 REP admin VLAN
106 10.10.106.0/24 10.10.106.1 URWB management
VnV_VRF 500 172.16.50.0/24 172.16.50.1 VLAN for CCTV cameras in TAN and FAN
501 172.16.51.0/24 172.16.51.1 VLAN for video traffic simulation
600 172.16.60.0/24 172.16.60.1 VLAN for voice communications (IP
telephony) in TAN and FAN
601 172.16.61.0/24 172.16.61.1 VLAN for voice traffic simulation
Wi-Fi access 900 172.16.90.0/24 172.16.90.1 VLAN for employee and contractor Wi-Fi
901 172.16.91.0/24 172.16.91.1 VLAN for guest Wi-Fi
URWB access 1000 172.18.100.0/24 172.18.100.1 VLAN for URWB traffic
OT_VRF 700 172.16.70.0/24 172.16.70.1 SCADA OT traffic VLAN in TAN and TBN
Example: turbine controller VLAN, SCADA
Clients
701 172.16.71.0/24 172.16.71.1 SCADA OT traffic simulation VLAN
Global routing table 800 172.16.80.0/24 172.16.80.1 0SS Local VLAN in OSS network only
(GRT) (Nonroutable across OSS and ONSS)
801 172.16.81.0/24 172.16.81.1 ONSS Local VLAN in ONSS network only

(Nonroutable across OSS and ONSS)

Solution Components

This section lists the Cisco hardware and software component versions that are validated in the wind farm solution implementation

topologies that Figure 2-1 and Figure 2-2 show.

It also describes the wind farm third-party hardware and software components that are validated in this implementation.

10
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Table 2-3: Cisco Components and Versions Validated in the Wind Farm Solution

Hardware Model

Role in Offshore Wind Farm

Software or Firmware Version

IE3400-8P2S, Turbine nacelle switch, non-HA 17.11.1

IE3400-8T2S

IE3400-8P2S, Turbine nacelle switch, HA 17.111

IE3400-8T2S

IE3400-8P2S, Turbine base switch 17.11.1

IE3400-8T2S

C9300-24UX Farm area aggregation 17.11.1

C9500-16X 0SS core switch, HA 17.11.1

C9300-24UX OSS IT network access switch 17.11.1

C3850-24UX ONSS core switch 16.12.1

Firepower 2140 0SS and ONSS DMZ firewall 7.0.1

Firepower Management Center Firewall management application 7.0.1

(FMC)

IR8340 ONSS WAN edge router 17.11.1

DN2-HW-APL Cisco Catalyst Center Network 2.3.6.0
Management Appliance

UCS-C240-M5S Unified Computing System (UCS) 3.1.3c

Cisco ISE Virtual Appliance AAA server 3.2

loX Sensor App Cyber Vision network sensors 4.1.2

Cisco Cyber Vision Center Global OT security dashboard 4.1.2

and local

C9800-L-C-K9 Wireless LAN controller 17.11.1

IW6300-AP Cisco IW6300 ruggedized AP for Wi-Fi 17.11.1
access

AIR-AP9120 Cisco AP for Wi-Fi access 17.11.1

URWB FM3500 and FM4500 URWB mesh point 9.4

URWB FM1000 Gateway URWB mesh gateway 1.6.0

URWB FM-Monitor VM URWB FM-Monitor 1.0.1

Cisco Secure Network Analytics IT and OT security management 74.1

(Stealthwatch)

ASR-1002-HX Control center headend router 17.3.4a

Cisco SD-WAN vManage, vSmart, WAN management 20.8.1

vBond

11
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Table 2-4: Third-party Hardware and Software Validated in this Wind Farm Solution

Hardware Model Role in Offshore Wind Farm Software/Firmware Version
AXIS P3717-PLE Turbine physical security 10.3.0

(CCTV) camera
Axis Device Manager Video server for CCTV camera 5.9.42
(ADM)
Microsoft Windows 2016 AD, DHCP, and DNS servers in Windows 2016 Server Edition
Server control center

Note: Ensure that you enable appropriate licenses for the features and functions for the network components that are listed in Table 2-3
and Table 2-4. See the product data sheets for more information.

12
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Chapter 3: Offshore Substation Network
Implementation

This chapter includes the following topics:

= Offshore Substation Core Network Implementation
= Configuring FAN Ring Aggregation Switch Stack

= Configuring OSS Infrastructure Network Access

L 0SS Network DMZ with Firewall

Offshore Substation Core Network Implementation

Cisco Catalyst 9500 Series switches can be used as core switches in the wind farm solution. For redundancy, Cisco StackWise Virtual
(SVL) is configured between two 9500 switches, with each switch sharing an interface with the distribution layer and access switches.

An SVL domain is elected as the central management point for the entire system when accessed via a management IP address or
console. The switch that acts as the single management point is referred to as the StackWise Virtual active switch. The peer chassis is
referred to as the SV standby switch. The StackWise Virtual standby switch also is considered to be a hot-standby switch because it is
ready to become the active switch and it takes over all functions of the active switch if the active switch fails.

The connection to the distribution layer is accomplished with interfaces that are configured as switchport trunks. Switched Virtual
Interface (SVI) is used for the layer 3 configuration, and the SVIs serve as the default gateways for management VLANSs.

Bringing Up Catalyst 9500 StackWise Virtual

Configuration of 9500 starts with configuring SVL. Figure 3-1 shows how the cabling of the two Cisco 9500 switches must be done before
starting SVL configuration:

Figure 3.1: DAD and SVL links for 9500 SVL

StackWise Virtual link

Dual Active Detection link

™
[Tg]
®
@
Active Standby &

Figure 3-2 shows the workflow for the initial bring-up of the Catalyst 9500 Series switches.

Figure 3-2: Workflow for Initial Bring-Up of Catalyst 9500 Series Switches in the Wind Farm OSS Core
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388447

This solution uses one connection for the SVL and one connection for the dual active detection link. For detailed SVL configuration steps
and prerequisites, see “Configuring Cisco StackWise Virtual” in High Availability Configuration Guide, Cisco 10S XE Bengaluru 17.5.x
(Catalyst 9500 Switches):

https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9500/software/release/17-
5/configuration _guide/ha/b 175 ha 9500 cg/configuring cisco stackwise virtual.html
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After the physical connection of the 9500 switches is complete, follow these steps to complete the SVL configuration:
1. Perform these actions to configure SVL

a. Reassign the switch numbers of the two switches to switch numbers 1 and 2, and assign priorities as follows:

9500-1:
Switch 1 priority 15

9500-2:

switch 1 renumber 2
switch 1 priority

b. Complete the following SVL configuration on each of the switches:
9500-1:

stackwise-virtual
domain 2
!
interface TenGigabitEthernetl/1/1
stackwise-virtual link 1
|
interface TenGigabitEthernetl/1/5
stackwise-virtual dual-active-detection
!

9500-2:

interface TenGigabitEthernet2/1/1
stackwise-virtual link 1
!

interface TenGigabitEthernet2/1/5
stackwise-virtual dual-active-detection

c. Reloadthe two switches to cause the SVL configuration to take effect.

d. Enterthe following command on each 9500 switch to verify that switches are now in SVL mode:

show stackwise-virtual

The command output should show that the two switches are in Active Standby mode and show their configured switch
numbers.

2. Configure layer 3 for 9500 SVL

a. Configure a switched virtual interface (SVI) for management VLAN 101, assign an IP address to it, and forwarding VRF in
Management_VRF:

hostname WF-0SS-C9500
vlan 100
name OSS INFRA VLAN
!
vlan 101
name OSS NET MGMT
!
interface Vl1anlO1l
vrf forwarding Management VRF
ip address 10.10.101.1 255.255.255.0
!
vrf definition Management VRF
rd 100:1
!
address-family ipv4
route-target export 100:1
route-target import 100:
route-target export 100:1
stitching
route-target import 100:1
stitching
exit-address-family
|
address-family ipvé
route-target export 100:1

=
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route-target import 100:1

route-target export 100:1
stitching

route-target import 100:1
stitching
exit-address-family

b. Configure OSPF routing for underlay network reachability between OSS and ONSS core switches:
router ospf 1
router-id 192.168.5.2
network 172.16.1.0 0.0.0.3 area O
network 192.168.2.2 0.0.0.0 area O
network 192.168.5.2 0.0.0.0 area O
network 192.168.7.2 0.0.0.0 area 0

c.  Configure the core face VLAN on the C9500 SVL VTEP:
|
vlan configuration 11
member vni 5000
!
d. Configure Switch Virtual Interface (SVI) for the core facing VLAN:

interface Vlanll

vrf forwarding Management VRF
ip unnumbered Loopback0

no autostate

e. Configure Switch Virtual Interface (SVI) for the access facing VLAN:
interface V1anl00
vrf forwarding Management VRF
ip address 10.10.100.1 255.255.255.0
ip helper-address 192.168.6.2
!
f.  Configure loopback interface on the VTEP:
interface Loopback0
ip address 192.168.5.2 255.255.255.255
|
g. Configure NVE interface on the VTEP:
interface nvel
no ip address
source-interface Loopback0
host-reachability protocol bgp
member vni 5000 vrf Management VRF
!
h.  Configure BGP with IPv4 or IPv6 or both address families on the VTEP:
router bgp 1
bgp log-neighbor-changes
bgp update-delay 1
bgp graceful-restart
no bgp default ipvé4-unicast
neighbor 192.168.5.1 remote-as 1
neighbor 192.168.5.1 update-source Loopback0
!

15
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address-family ipv4
exit-address-family
!
address-family 12vpn evpn
neighbor 192.168.5.1 activate
neighbor 192.168.5.1 send-community both
exit-address-family
!
address-family ipv4 vrf Management VRF
advertise 1l2vpn evpn
redistribute static
redistribute connected
exit-address-family
!
address-family ipv6 vrf Management VRF
redistribute connected
redistribute static
advertise 12vpn evpn
exit-address-family
!
i.  After EVPN VXLAN BGP core routing is configured on the peer ONSS core C9500 SVL switch, you can verify the VXLAN NVE peer
status, BGP routing tables using the following CLls:
WE-0SS-C9500#show nve peers

'M' - MAC entry download flag 'A' - Adjacency download flag

'4'" - Ipv4 flag '6' - IPv6 flag

Interface VNI Type Peer-IP RMAC/Num_RTs eVNI state flags UP time
nvel 5000 L3CP 192.168.5.1 ccb6.c864.£7d4 5000 UP A/M/4 2d0%h

WF-0SS-C9500#show bgp 12vpn evpn all
BGP table version is 132, local router ID is 192.168.7.2
Status codes: s suppressed, d damped, h history, * wvalid, > best, i - internal,
r RIB-failure, S Stale, m multipath, b backup-path, f RT-Filter,
x best-external, a additional-path, c¢ RIB-compressed,

t secondary path, L long-lived-stale,
Origin codes: i - IGP, e - EGP, ? - incomplete

RPKI validation codes: V valid, I invalid, N Not found

Network Next Hop Metric LocPrf Weight Path
Route Distinguisher: 100:1 (default for vrf Management VRF)
*> [51[100:1]1[0][16][172.114.0.0]1/17

0.0.0.0 0 32768 2
x> [51[100:1]1[0]1[24]7[10.10.1.01/17

10.10.100.2 0 32768 2
x> [51[100:1]1[0][24][10.10.100.0]1/17

0.0.0.0 0 32768 2
* 1 [5][100:1]1[0][24]1([10.10.201.01/17

192.168.5.1 0 100 07
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* i 192.168.5.1 0 100 02
*>1 192.168.5.1 0 100 02
Refer to the following URL for more details on EVPN VXLAN BGP Core routing implementation steps network VTEPs:

https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9500/software/release/17-
3/configuration guide/vxlan/b 173 bgp evpn vxlan 9500 cg/configuring evpn vxlan layer 3 overlay network.html

3. Configure layer 2 for 9500 SVL
a. Configure port-channels and trunk port on the links going to the Catalyst 9300 FAN aggregation:

interface TenGigabitEthernetl/0/3
description ##Connection to 9300 Agg##
channel-group 1 mode desirable
]
interface TenGigabitEthernet2/0/3
description ##Connection to 9300 Agg##
channel-group 1 mode desirable
|
!
interface Port-channell
switchport mode trunk
!

b.  Configure port-channels and trunk port on links going to the C9300 access switch of the OSS infrastructure network and
on the links going to the ONSS core:

interface TenGigabitEthernetl/1/3
channel-group 2 mode desirable
description ##Connection to 9300 Access##
|

interface TenGigabitEthernet2/1/3
channel-group 2 mode desirable
description ##Connection to 9300 Access##
|

!

interface Port-channel2
switchport mode trunk

!

interface TenGigabitEthernetl/1/7
channel-group 3 mode desirable
description ##ConnectionTo3850##
!

interface TenGigabitEthernet2/1/7
channel-group 3 mode desirable
description ##ConnectionTo3850##
!

interface Port-channel3
switchport mode trunk

|

Configuring FAN Ring Aggregation Switch Stack

A pair of Cisco Catalyst 9300 Series switches in a stack is configured as a FAN ring aggregation switch in the wind farm network. This
section describes the implementation of a FAN ring aggregation switch stack.

Catalyst 9300 Switch Stack for FAN Aggregation

Figure 3-3 shows the workflow configuring a Cisco Catalyst 9300 access switch stack.
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Figure 3-3: Workflow for Configuring Catalyst 9300 Access Switch Stack
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1. Configure a 9300 access switch stack by connecting the stack cables for each switch and booting each switch.
When the switches come up, they are in a stack. The active and standby switches are selected automatically.

Alternatively, you can assign a priority and switch number to a switch manually. The switch that is to be the active switch should be
assigned a higher priority.

For information about Cisco Catalyst 9300 Series switch stack configuration, see “Managing Switch Stacks” in Stacking and High
Availability Configuration Guide, Cisco 10S XE Amsterdam 17.3.x Catalyst 9300 Switches:

https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9300/software/release/17-
3/configuration _guide/stck mgr ha/b 173 stck mgr_ha 9300 cg/managing switch stacks.html

2. Configure layer 3 for the 9300 switch stack:

a. Configure the management SVl interface as Vlan101 and assign an IP address to Vlan101:
hostname WF-0SS-C9300Agg
vlan 101
interface Vl1anlO1l

ip address 10.10.101.13 255.255.255.0

b.  Configure the ip routing command and then configure the default route to point to the 9500 SVL:
ip routing
|
ip route 0.0.0.0 0.0.0.0 10.10.101.1

3. Configure Layer 2 for the Cisco Catalyst 9300 switch stack:

a. Configure port-channels and trunk port on links going to the Catalyst 9500 SVL:
!
interface TenGigabitEthernetl/1/3

description ##ConnectionTo9500##

channel-group 1 mode desirable
I

interface TenGigabitEthernet2/1/3
description ##ConnectionTo9500##
channel-group 1 mode desirable

|

interface Port-channell
switchport mode trunk

b. Enterthe following command to verify that the port-channel is up and that the trunk port is created:

show etherchannel summary

Configuring OSS Infrastructure Network Access

Before configuring layer 2 and layer 3 for the C9300 stack of the OSS infrastructure network, ensure that the switch stack
configuration for the C9300 is complete as described in the previous section. The follow these steps on the C9300 stack.

1. Perform these actions to complete the layer 3 configuration for the C9300 stack from the CLI:
a. Configure the management VLAN and the SVIin Vlan101:

hostname 0SS-C9300-Access
vlan 101
|
interface VlanlO1l
ip address 10.10.101.5 255.255.255.0
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b. Configure the Catalyst 9500 SVL as the default gateway:

ip default-gateway 10.10.101.1
]

2. Perform these actions to configure layer 2 for the C9300 stack from the CLI:
a. Configure port-channels and the trunk port on links that are connected to the Catalyst 9500 SVL:

interface TenGigabitEthernetl/1/1

description ##ConnectionTo95004#4#
channel-group 1 mode desirable

|

interface TenGigabitEthernet2/1/1
description ##ConnectionTo9500##
channel-group 1 mode desirable

|

interface Port-channell
switchport mode trunk

b. Enterthe following command to verify that the port-channel is up and that the trunk port is created:

show etherchannel summary

Number of channel-groups in use: 1

Number of aggregators: 1
Group Port-channel Protocol Ports
+ + +
1 Pol (SU) PAgP Tel/1/1(P) Te2/1/1(P)

show interfaces trunk
Port Mode Encapsulation Status Native vlan
Poll on 802.1q trunking 1

OSS Network DMZ with Firewall

This section describes the implementation of a firewall in an OSS DMZ network.

Cisco Firepower Next Generation Firewall (NGFW) Implementation

Cisco Firepower is an integrated suite of network security and traffic management products that is deployed either on purpose-built
platforms or as a software solution. In the wind farm solution, the 2140 series Firepower model is used. In this implementation, a

Firepower device is managed by the Firepower Management Center (FMC). The FMC s installed in the Control Center UCS as shown
in Figure 2-1.

FMC is a fault-tolerant, purpose-built network appliance that provides a centralized management console and database repository
for a Firepower system deployment. FMC controls the network management features on devices, including switching, routing, NAT,
VPN, and so on.

In the wind farm solution, FMC is deployed as a virtual machine. It must be configured in the same network as the management
ports of Firepower NGFWs.

Figure 3-4 shows the workflow for the Firepower configuration.

Figure 3-4: Workflow for Configuring Firepower
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For more information about FMC and the configuration steps for management of Firepower, see “Getting Started With Firepower” in
Firepower Management Center Configuration Guide:

https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-
v70/introduction to the cisco firepower system.html
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After the FMC is installed as a virtual appliance as described in “Getting Started With Firepower,” open the FMC console and configure
the management IP address (which should have reachability to the FPR management IP address), configure the default gateway, and log

in credentials.

Next, log in to a Microsoft Windows PC that is in a network that the FMC can reach and open the FMC in a web browser. Enter the
configured FMC IP address and login credentials. The FMC is now ready to start configuring Firepower.

Firepower Installation and High Availability Configuration

In the wind farm solution, Firepower is used to provide network security between zones and secure access to third-party OPC-UA clients
that are connected behind a firewall. Firepower is configured with high availability (HA) to provide redundancy in the setup. An HA pair
of Firepower Threat Defense (FTD) devices results in a single logical system for policy application, system updates, and registration. With
HA, the system can fail over either manually or automatically.

A third-party turbine vendor SCADA network connects to the OSS DMZ network through a firewall, as described in
Cisco Solution for Renewable Energy: Offshore Wind Farm 1.1 Design Guide:
https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind _Farm/WF 1-1 DG.pdf?dtid=odicdc000509

OPC-UA clients from the OSS infrastructure network access OPC-UA servers in the third-party network via secure Firepower policies.

Before configuring Firepower as described in the following sections, follow these steps to configure Firepower for routed mode and to
be managed via the FMC.

1. Configure routed mode.

Routed mode for Firepower must be chosen as a part of the initial configuration when the FTD device boots up for the first time. If
Firepower was not configured for routed mode when the FTD device booted for the first time, enter the following command in the
Firepower CLI to configure Firepower for routed mode:

> configure firewall routed

This will destroy the current interface configurations, are you sure that you want to
proceed? [y/N] y

The firewall mode was changed successfully.

For more detailed information, see “Transparent or Routed Firewall Mode for Firepower Threat Defense” in Firepower
Management Center Configuration Guide, Version 7.0:

https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-
v70/interface_overview_for_firepower_threat_defense.html

2. Configure management via the FMC.

See Cisco Firepower 2100 Getting Started Guide for the steps to perform the initial configuration of Firepower Threat Defense (FTD)
and configure the management of the FTD via the FMC:

https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/fp2100/ftd-fdm-2100-gsg.html
Configuring Firepower for Wind Farm Solution Use Cases
Figure 3-5: Workflow for Configuring Cisco Firepower Using FMC
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To configure Firepower, follow these steps.
1. Afteradding both devices to the Firepower Management Center, perform the following steps to configure high availability:
a. Under Devices, choose Device Management.
b. From the Add drop-down menu, choose High Availability.
c. Inthe Add High Availability Pair dialog box, enter a logical name for the high availability pair in the Name field.
d. Under Device Type, choose Firepower Threat Defense.
e. Choose the Primary Peer device for the high availability pair.
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k.

Choose the Secondary Peer device for the high availability pair.

Click Continue.

From the LAN Failover Link drop-down list, choose an interface with enough bandwidth to reserve for failover
communications.

Note: Only interfaces that do not have a logical name and do not belong to a security zone are listed in the Interface drop-
down list in the Add High Availability Pair dialog box.

Enter any identifying logical name for the link in the dialog box that appears.
Enter a primary IP address for the failover link on the active unit. This address should be on an unused subnet.

Note: 169.254.0.0/16 and fd00:0:0:*::/64 are Firepower internally-used subnets and cannot be used for the failover or state
links.

Click OK . It then takes a few minutes for system data to be synchronized.

For more detailed information about configuring high availability and cabling FPRs for high availability, see “High Availability for
FTD” in Firepower Management Center Configuration Guide, Version 7.0:

https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-
v70/high_availability_for_firepower_threat_defense.html

2. Perform the following steps to configure Firepower interfaces:

a.

b.

Choose Devices > Device Management and click the edit icon that corresponds to the HA pair.

Click the Edit icon next to the interface to be configured and configure the details for that interface, as shown in Figure 3-6.
Figure 3-6: Configuring Interfaces

Edit Physical Interface (7]

General IPvd IPv6 Advanced Hardware Configuration FMC Access

Name:
OPC_Client_Int

Enabled
Description

Going to OPC Client

Mode

None v

Security Zone

inside_zone v

MTU:
1500

Propagate Security Group Tag:

cancel | [IEES)

Repeat Steps 2a and 2b as needed to bring up the other Firepower interfaces and assign IP addresses and names to them.

3. Perform the following steps to configure routing for network reachability via Firepower.

Because Firepower acts as the firewall between the DMZ and the outside network, a static default route must be configured on
Firepower so that permitted devices can reach the DMZ.

a
b.

C.

Choose Devices > Device Management and click the edit icon that corresponds to the HA pair.
Click the Routing tab.
Click Static Route.
Click Add Route.
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e. Click the IPv4 radio button.

f.  From the Interface drop-down list, choose the interface to which this static route applies.

g. Inthe Available Network window, a network object for the destination network can be added clicking + . To add a static
default route, choose the network any-ipv4 ( 0.0.0.0/0) from the Available Network window.

h. Inthe Gateway field, enter the IP address or network/hosts object of the gateway router, which is the next hop for this route.

i In the Metric field, enter the number of hops to the destination network.

Valid values range from 1 to 255. The default value is 1. See Figure 3-7.

Figure 3-7: Example of Adding a Static Default Route

Edit Static Route Configuration

Type: e IPv4 Pv6
Interface™
OPC_UA_Serverintf v

(Interface starting with this icon [#signifies it is available for route leak)
]

Available Network c +
Q, Search | Add

9500VIan100

IPv4-Benchmark-Tests
IPv4-Link-Local

IPv4-Multicast
IPv4-Private-10.0.0.0-8 -

Ensure that egress virtualrouter has route to that destination
Gateway

10.10.106.11 v B

Metnc:

1

Tunneled:

Route Tracking:

The configured routes appear as shown in Figure 3-8.

Figure 3-8: Example View of a Static Route Configured in Firepower

Leaked from

Network a Interface Virtual Router
v |Pvd Routes
any-ipvé OPC_UA_Serverint Global

?2 X
Selected Network
any-ipvé4 v
OK Cancel
+ Aad Houte
Gateway Tunneled Maetric Tracked
10.10.106.11 false 1 £ u

Note: The output shown above is a sample output and a large section of output may have been omitted. For more detailed
information, see “Static and Default Routes for Firepower Threat Defense” in Firepower Management Center Configuration Guide,

Version 7.0:

https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-

v70/static and default routes for firepower threat defense.html

4. Perform the following actions to configure an access control policy:

An access control policy allows or disallows communication between different zones.

a. Choose Policies > Access Control > New Policy from the Main menu.

b. Click Add Rule and configure the policy. See Figure 3-9 for an example.
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Figure 3-9: Adding an Access Control Policy

Editing Rule - AllowOPC (2]

Name
[ Atowore Enabled Move

Action Time Range
© Allow o B Neone |+

Zones Networks VLANTags Ak Users Applications Ports URLs Dynamic Attributes Inspection Logging Comments

Available Zones C Source Zones (1) Destination Zones (1)

Q, Search by name outside_zone inside_zone

inside_zone

outside_zone

c. Choose Edit policy > Add Rule and add the source and destination zone for allowing communication between the OPC-UA
server in a third-party network and OPC-UA client in an OSS network.

d. Under Ports, create a port object by clicking + > Add object and then entering details for the port objects, as shown in Figure
3-10.

Figure 3-10: Creating a Port Object

Editing Rule - AllowOPC

Name

| AllowOPC | (¥ Enabled Wove
Action Ti_m_e Ra
| ©Allow v 5 | None

Zones Networks VLAN Tags A Users Applications

Available Ports ¢ L
Add Object

Add Group

| Q Search by name or value

| AOL i
e. For OPCUA communication, create a port object with the following UDP ports:

48010
49320
53530
62620
62626

See Figure 3-11 for an example.
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Figure 3-11: Adding Ports Objects

New Port Objects )

Name
0PC62620

Protocol

e TCP
ubP
ICMP
IPv6-ICMP
Other

Port
[ 62620

Allow Overrides

f.  Choose any item from the Available Ports window as the source port, choose the ports that you created in Step 4e as the
destination ports, and click Save. See Figure 3-12.

Figure 3-12: Adding Access Control Policy

Editing Rule - AllowOPC

Name
AllowOPC Enabled Move
Action Time Range
@ Allow - 7] None v |+
Zones Networks VIANTags A Users Applications Ports URLs Dynamic Attributes Inspection Logging Comments
—
Available Ports + Selected Source Ports (0) Selected Destination Ports (5)
Q, Search by name or value any [ OPCE2620 0]
Add to S -
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Bittorrent OPCPor53530 ]
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Click Deploy.

Figure 3-13: Rules Configured Under Access Control Policy
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Chapter 4: Farm Area Network
Implementation

This chapter describes how to manually bring up a farm area network (FAN) ring in a wind farm by using switch CLI commands. You also
can perform this procedure by using the Cisco Catalyst Center REP provisioning workflow, which simplifies the configuration and
management of devices (see Onboard TAN Switches).

This chapter includes the following topics:
= Configuring a Farm Area Network Ring

. Configuring a Turbine Area Network

Configuring a Farm Area Network Ring

Figure 4-1 shows the workflow for bringing up a farm area network (FAN) ring.

Figure 4-1: FAN Ring Bring-up Workflow

Complete physical
cabling of FAN ring’s

Configure REP

Complete initial for FAN ring and

configs on each of

Base switches as the Base switches

per the topology

verify reachability
to the gateway

388365

FAN Ring Topology and REP Ring Configuration

After completing physical connections for bringing up FAN ring, configure each of the 3400 switches as follows to create VLANs and
bring up the management interface:

hostname name

vlan 101

name Management_vlan
vlan 105

name REP_ADMIN_VLAN
rep admin vlan 105
interface Vlan101

ip address dhcp
interface range gi 1/1-2
switchport mode trunk

A sample configuration for a 3400 switch is as follows:

hostname FAN-BS1
vlan 101

name Management vlan
vlan 105

name REP ADMIN VLAN
interface VlanlOl
ip address dhcp

rep admin vlan 105

Configuring REP for the FAN Ring

REP configuration for the FAN ring is done with the 9300 aggregation switch interface as the edge port. The configuration in the FAN ring
must be performed in either the clockwise or counterclockwise direction.

1. Enterthe following commands on the 9300 aggregation switch:

Conft

Vlan 105

Rep admin vlan 105
Intrange Te 1/1/2,2/1/2
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Rep segment 1 edge

2. Configure the neighboring 3400 switches in either a clockwise or counterclockwise direction by entering the following commands
on each switch:

Conft

Rep admin vlan 105
Int range gi 1/1-2
Rep segment 1

2. Replicate this 3400 configuration on all 3400 switches of the FAN ring sequentially in the direction chosen in Step 2.

3. After all switches in the FAN ring are configured, verify REP by entering the show rep topology CLI command in any of the member
switches.

For more detailed information about REP configuration, see REP Command Reference:

https://www.cisco.com/c/en/us/td/docs/optical/cpt/r9 3/command/reference/cpt93 cr/cpt93 cr chapter 0111.pdf

Configuring a Turbine Area Network

Configuring Turbine Area Network without High Availability
A turbine area network (TAN) without high availability is configured by linearly by connecting a 3400 switch to a node of the FAN ring
using two links that are formed into a port-channel. The port-channel provides redundancy.

Here is a sample configuration on a base switch that forms part of the TAN:

!

int range gi 2/1-2

channel-group 3 mode desirable

switchport mode trunk

switchport trunk allowed vlan 1-2507,2509-4094

The same base switch configuration must be repeated on the TAN switches on the interfaces that connect to the base switch.

Configuring TAN with High Availability and REP Subtended Ring

TAN high availability with a REP subtended ring is created with two kinds of REP segments:
=  REPclosed segment (TAN2): In this type of REP ring, the primary and secondary edges of the REP reside on the same switch
= REPopen segment (TAN3): In this type of REP ring, the primary and secondary edge of the REP reside on different switches

TAN2 Ring Configuration

A TAN2 ring is formed similarly to the FAN ring with edge ports configured on the base switch, as shown in the wind farm topology in
figure 2-1. Switches should be configured as follows:

= Base switch configuration:

Int range Te 1/1/1,2/1/1

Rep segment 2 edge

rep stcn segment 1 /* to send a segment TCN for this new segment in the main REP ring
segment*/

= TAN switch configuration:

Rep admin vlan 105
Int range gi 1/1-2
Rep segment 2

=  TANS3 ring configuration (REP open segment).

TAN3 ring is formed similarly to the FAN ring, except that the edge port is configured on two different 3400s.

FAN-BS4#conf t
Int range Gi 2/1
Rep segment 3 edge
rep stcn segment 1
FAN-BS3#conf t
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Int range Gi 2/1
Rep segment 3 edge
rep stcn segment 1
TAN3-BSl#conf t

Rep admin vlan 105
Int range gi 1/1-1/2
Rep segment 3
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Chapter 5: Implementing OSS Infrastructure
Applications and Services

This chapter includes the following topics:

= Cisco Cyber Vision Center Local Installation and Configuration

= Cisco Stealthwatch Flow Collector Installation and Configuration

= SCADA OPC-UA Server Installation and Configuration

= Cisco Cyber Vision Sensor installation on a 9300 Switch to Detect OPC-UA Traffic

Cisco Cyber Vision Center Local Installation and Configuration

This section describes the deployment of Cisco Cyber Vision Center (CVC) local in an offshore substation infrastructure network, and the
deployment of network sensors on IE3400 Series switches in the TAN and FAN.

Cisco Cyber Vision Center Installation

CVC can be deployed as a virtual machine (VM) or as a hardware appliance. In Figure 2-1, Cyber Vision Center (local) is deployed as a VM
on a Cisco Unified Computing System (UCS) in the OSS infrastructure network. After CVC (local) is installed, it is registered with Cyber
Vision Global Center in the control center for centralized management and monitoring.

For CVD installation instructions and resource recommendations, see Cisco Cyber Vision Center VM Installation Guide, Release 4.1.2:

https://www.cisco.com/c/en/us/td/docs/security/cyber vision/publications/Center-VM/Release-4-1-
2/b Cisco Cyber Vision Center VM Installation Guide.html

We recommended that the CVC application be installed in the OSS network with dual interfaces, one interface for management and the
other for sensor communication. The following is an example of the IP addressing schema used in the CVC installation:

=  Administration interface (eth0): 10.104.206.225 (routable IP address for CVC Ul access)

=  Collection interface (eth1): 10.10.100.30 (OSS infrastructure VLAN)

=  Collection network gateway: 10.10.100.1 (0SS infrastructure gateway)

L NTP: 10.10.100.1

See “Operational Technology Flow and Device Visibility using Cisco Cyber Vision” in

Cisco Solution for Renewable Energy: Offshore Wind Farm 1.1 Design Guide:
https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind Farm/WF 1-1 DG.pdf?dtid=odicdc000509

for detailed design and deployment considerations for CVC and network sensors on TAN and FAN |E switches.

Configuring Cyber Vision Center Data Synchronization

To synchronize local CVC data with CVC Global in the control center, follow the instructions in “Configure Center data synchronization”
in Cisco Cyber Vision Center VM Installation Guide, Release 4.1.2:

https://www.cisco.com/c/en/us/td/docs/security/cyber vision/publications/Center-VM/Release-4-1-
2/b Cisco Cyber Vision Center VM Installation Guide/m Configure the Center CENTER VM v3 4 0 O.html#topic 5397

Cisco Stealthwatch Flow Collector Installation and Configuration

The Stealthwatch Flow Collector (SFC) is responsible for collecting all NetFlow telemetry that is generated by a network’s flow-capable
devices. The SFC is the heart of the Stealthwatch system and is where data normalization and analysis occur.

The Stealthwatch Management Console (also known as Stealthwatch Manager) and Stealthwatch Flow Collector (SFC) are deployed as
virtual appliances on ESXI hosts in the wind farm control center and OSS infrastructure, respectively. Install the SMC in the control
center before installing the SFC in the OSS infrastructure network.

For more detailed information about Stealthwatch design, see “Cisco Secure Network Analytics (Stealthwatch)”in
Cisco Solution for Renewable Energy: Offshore Wind Farm 1.1 Design Guide:
https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind Farm/WF 1-1 DG.pdf?dtid=odicdc000509
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For information about installing the SMC and SFC Virtual Edition without datastore see Cisco Secure Network Analytics Virtual Edition
Appliance Installation Guide 7.4.2:

https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system installation configuration/7 4 2 VE Appliance Installati
on Guide DV 1 3.pdf

For information about configuring the SMC and SFC Virtual Edition without datastore, see Cisco Secure Network Analytics System
Configuration Guide 7.4.2:

https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system installation configuration/7 4 2 System Configuration
Guide DV 1 2.pdf

Note: Make sure to register the SFC with the SMC after the flow collector is installed and configured with basic network settings.

Note: Make sure to activate Cisco Smart Software Licensing for the SNA appliances (SMC and SFC) after the installation and
configuration. For information about SNA licensing, see Cisco Secure Network Analytics Smart Software Licensing Guide 7.4.2:

https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/license/7 4 2 Smart Software Licensing Guide DV 1 0.pdf

SCADA OPC-UA Server Installation and Configuration

As shown in Figure 5-1, ports 48010, 49320, 53530, 62620, and 62626 must be allowed for Firepower for successful OPC-UA
communication between the OPC-UA server and OPC-UA client.

Figure 5-1: OPC-UA Server in Third-Party Network and OPC-UA Client in OSS Infrastructure Network
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The OPC-UA client application provides the following options for OPC-UA client/server communication:
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= Anonymous and unsecure OPC-UA packet simulation
=  Username and password-based secure OPC-UA
= x.509 certificate based secure OPC-UA communication between a client and server

Figure 5-2 shows a Wireshark trace of the OPC-UA packet flow. It begins with an OPC-UA hello message from the client, when the
simulated OPC-UA packets are sent from server to the client. The OPC-UA client application can connect to the OPC-UA server
application via HTTP and TCP over secure and unsecure communication media.

Figure 5-2: OPC-UA Wireshark Capture

Time Source Destination Protocol | Length Info

135.915848 19.18.180.5 19.18,108.11 Upcua 140 Hello message

135.946843 16.19.108.11 19.18.108.5 Opcla 82 Acknowledge message

135.947761 16.10.100.5 10.19.108.11 Opcla 186 OpenSecureChannel message: OpenSecureChannelRequest

135.957329 16.10.108.11 10.19.108.5 Opcla 189 OpenSecureChannel message: OpenSecureChannelResponse

135.959055 16.19.188.5 18.10.100.11 Opcla 1382 UA Secure Conversation Message: CreateSessionRequest

136.091659 16,10.100.11 19.10.100.5 Opcla 1254 UA Secure Conversation Message (Message fragment 125)

136.092228 10.10.100.11 10.10.100.5 Opcla 938 UA Secure Conversation Message: CreateSessionResponse (Message Reassembled)

136.9893731 10.10.108.5 1@8.10.100.11 Opcla 203 UA Secure Conversation Message: ActivateSessionRequest
136.096490 18.10.108.11 19.18.100.5 Opcla 150 UA Secure Conversation Message: ActivateSessionResponse

136.996790 16.10.1008.5 19.10.100.11 Opcla 172 UA Secure Conversation Message: CreateSubscriptionRequest
136.125188 16.10.1098.11 18.108.100.5 Opcla 126 UA Secure Conversation Message: CreateSubscriptionResponse
136.125830 18.10.188.5 18.10.100.11 Opcla 412 UA Secure Conversation Message: CreateMonitoredItemsRequest
136.138914 16.10.100.11 10,10.100.5 OpeUa 252 UA Secure Conversation Message: CreateMonitoredItemsResponse
136.139478 18.18.188.5 19.10.1008.11 Opcla 182 UA Secure Conversation Message: ReadRequest

136. 146002 18.190.100.11 19.10.1080.5 OpcUa 491 UA Secure Conversation Message: ReadResponse

136.146468 16,10.108.5 19.10.100,11 Opcla 182 UA Secure Conversation Message: ReadRequest

136.150277 18.10.108.11 1@.10.100.5 Opcla 296 UA Secure Conversation Message: ReadResponse

OPC-UA message types and Flow

Figure 5-3 shows the OPC-UA message types from the Hello message to the close of the OPC-UA session.

Figure 5-3: OPC-UA Message Types
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Any OPC-UA client application from vendors such as Unified Automation, Matricon, Kepware, and others provides options for fetching
data using HTTP or TCP, as shown in Figure 5-4.

Figure 5-4: OPC-UA Client application Supporting Different Encryption Types
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\V/| Always prompt for Security Settings

Figure 5-5 shows the OPC-UA client application fetching parameters from an OPC-UA server application over TCP.

Figure 5-5: OPC-UA Client Fetching Data from and OPC-UA Server
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Figure 5-6 shows the Prosys OPC-UA server application provisioned to establish a connection to a server over TCP or HTTP.

Note: If an OPC-UA client application is in a different network than the distributed controlled system-process control network (DCS-
PCN), there is a DNS entry in the C:\windows\System32\etc\hosts file, as shown in Figure 5-6.
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Figure 5-6: OPC-UA Server

Server Status: & Running

PubSub Status: &2 Running

connection Address (UA TCP):  opc.tcp://DESKTOP-GGIM2QU:53530/0PCUA/SimulationServer ([0)
Connection Address (UA HTTPS): opc.hitps://DESKTOP-GGIM2QU:53443/0PCUA/SimulationServer
PubSub Connection Address: opc.udp://224.0.5.1:4840 (D)

Current Server Time: 2023-04-05 10:47:29+0530
Server Starting Time: 2023-04-05 10:38:44+0530
Edition: Free

Figure 5-7 shows a hosts file that is configured with a DNS entry for an OPC-UA client connection to an OPC-UA server over TCP or HTTP.

Figure 5-7: DNS Entry for OPC-UA Server and Client in Hosts File
Copyright (c) 1993-2009 Microsoft Corp.

This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

#

#

#

#

# This file contains the mappings of IP addresses to host names. Each
# entry should be kept on an individual line. The IP address should

# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.

#

# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a '#' symbol.

#
#
#
#
#

For example:

102.54.94.97 rhino.acme.com # source server
38.25.63.18 X.acme.com # x client host

# localhost name resolution is handled within DNS itself.
# 127.90.0.1 localhost
# isl localhost

f138.6.18.91 www.yourdomain.com

Cisco Cyber Vision Sensor installation on a 9300 Switch to Detect OPC-UA
Traffic

The general workflow for installing Cyber Vision sensors on 9300 switches is as follows:

Step 1: Mount the USB SSD on a 9300 switch and install the Cyber Vision sensor application on the mounted drive.
Step 2: Configure the Cyber Vision sensor application on the 9300 switch so that OPC-UA traffic can be detected.
Step 3: Install the Cyber Vision sensor on the 9300 switch from the Cyber Vision Center.

Step 4: Edit the yaml file on the 9300 switch and add OPC-UA ports.

Step 5: Verify the OPC-UA flow in Cisco Cyber Vision Center.

These steps are described in detail in the following sections.
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Step 1: Mount the USB SSD on a 9300 Switch and Install the Cyber Vision Sensor Application on the Mounted
Drive

To install the CVC sensor application on a 9300 switch, mount the USB SSD on the switch and install the CVC sensor application on the
USB-SSD drive. For more detailed instructions, see “Installing a USB 3.0 SSD” in Cisco Catalyst 9300 Series Switches Hardware
InstallatioGuide:

https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9300/hardware/install/b c9300 hig/m 9300 installing a us
b30ssd.html

After you install the CVC sensor application, verify that the switch can reach the Cyber Vision Center by pinging the CVC collection of IP
address from the 9300 switch. Ensure that there is IP reachability to the CVC local manager instance from OSS-access on the 9300, as
shown in Figure 5-8.

Figure 5-8: Ping CVC Collection IP address from C-9300

Password:

0SS-C9300-Access#ping 16.10.160.30

Type escape sequence to abort.

Sending 5, 100-byte ICMP Echos to 10.10.100.30, timeout is 2 seconds:
Success rate is 1@0@ percent (5/5), round-trip min/avg/max = 1/1/1 ms
055-C9300-Access#]l

Step 2: Configure the Cyber Vision Sensor Application on the 9300 Switch

1. Configure the following IP addresses on the 9300 switch to bring up the Cyber Vision sensor application and integrate the switch
with CVC:

=  CVCAdmin Interface (eth0)
= Collectioninterface (eth1)

= Collection network gateway
" NTP

2. Configure the IP addresses in Cisco Cyber Vision as shown in Figure 5-9 (sample IP addresses shown).

Figure 5-9: Cyber Vision Configuration Parameters

Get Cisco device configuration

Device IP: Device port:
10.10.100.4 443

Capture IP address: Capture prefix length:
169.254.1.2 30

Capture VLAN number: Collection IP address:
2508 10.10.101.5
Collection prefix length: Collection VLAN number:
24 101

Collection gateway: Use global credentials:
10.10.101.1 No

Disk size:

Use up to 15GB
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3. Enableiox on the C-9300 switch:
configure terminal
iox
end !

For more detailed information, see “Initial Configuration” steps in Cisco Cyber Vision Network Sensor Installation Guide for Cisco IE3300
10G, Cisco IE3400 and Cisco Catalyst 9300, Release 4.1.0:

https://www.cisco.com/c/en/us/td/docs/security/cyber vision/publications/IE3400/b Cisco Cyber Vision Network Sensor Installatio
n Guide for Cisco IE3300 10G Cisco |IE3400 and Cisco Catalyst 9300/m Installation procedures 1E3400 Catalyst 9300 v3 4 0 O.

html#topic 5146

Step 3: Install the Cyber Vision Sensor on the 9300 Switch from the Cyber Vision Center
1. Install the Cyber Vision extension file:
a. Download the extension (.ext file) from cisco.com.
b. InCyber Vision Center, choose Admin > Extensions.
c.  Click Import Extension File button and then browse to the extension file.
2. Install a sensor:
a. InCyber Vision Center, choose Admin > Sensors > Sensors.
b. Click Deploy Cisco Device.
c. Inthe IP address field, enter the IP address of the switch.
d. Inthe Port field, enter 443 for a network sensor.
e. Inthe User field, enter the username for logging in to the switch.
f.  Inthe Password field, enter the password that is associated with the user account on the switch.
g. Inthe Center IP field, enter the IP address of the Center that the sensors should use for communication.
For dual interface Center deployments, we recommend that you enter the eth1 IP address.
h.  Under Capture mode, choose options as needed to designate what data the sensor processes.
In this validation, the Optimal (default) option was selected.
i.  Click Deploy.
3. Configure the additional options that appear:
a. Inthe Capture IP address field, enter the ERSPAN destination IP address for the sensor.
b. Inthe Capture prefix length field, enter the prefix that is associated with the ERSPAN IP address.
c. Inthe Capture VLAN number field, enter the monitoring session destination VLAN.
d. Inthe Collection IP address field, enter the IP address of the ethO interface of the sensor.
This IP address is used for communication with the CVC.
e. Inthe Collection prefix length field, enter the prefix that is associated with the sensor IP address.

f.  Inthe Collection gateway field, enter the IP address of the gateway that the sensor should use for communicating through the
network.

g. Inthe Collection VLAN number field, enter the VLAN of the sensor IP address.

Under Application type, click the radio button of the type of sensor you wish to deploy. For the Passive and Active Discovery
option, additional information is required:

i. Inthe IP address field, enter an IP address for the sensor to use in Active Discovery. Note that this IP address needs to be
from the same subnet as the end devices that you wish to discover. If active discovery is necessary on the same subnet as
the sensor itself, you can click the USE COLLECTION button.

ii. Inthe Prefix length field, enter the prefix associated with the IP address.
iii. Inthe VLAN field, enter the VLAN for the subnet.

i.  (Optional) Click the ADD ONE button to configure another Active Discovery interface. This secondary interface should be
configured for performing active discovery on a different subnet than what was specified for the first interface.

j.  Click deploy.

34


https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/IE3400/b_Cisco_Cyber_Vision_Network_Sensor_Installation_Guide_for_Cisco_IE3300_10G_Cisco_IE3400_and_Cisco_Catalyst_9300/m_Installation_procedures_IE3400_Catalyst_9300_v3_4_0_0.html#topic_5146
https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/IE3400/b_Cisco_Cyber_Vision_Network_Sensor_Installation_Guide_for_Cisco_IE3300_10G_Cisco_IE3400_and_Cisco_Catalyst_9300/m_Installation_procedures_IE3400_Catalyst_9300_v3_4_0_0.html#topic_5146
https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/IE3400/b_Cisco_Cyber_Vision_Network_Sensor_Installation_Guide_for_Cisco_IE3300_10G_Cisco_IE3400_and_Cisco_Catalyst_9300/m_Installation_procedures_IE3400_Catalyst_9300_v3_4_0_0.html#topic_5146

Cisco Offshore Wind Farm Solution 1.2 Implementation Guide

Implementing OSS Infrastructure Applications and Services

For more information about Cyber Vision sensor installation on a 9300 switch, see “Procedure with the Cyber Vision sensor
management extension” in Cisco Cyber Vision Network Sensor Installation Guide for Cisco IE3300 10G, Cisco IE3400 and Cisco Catalyst
9300, Release 4.1.0.

https://www.cisco.com/c/en/us/td/docs/security/cyber vision/publications/IE3400/b Cisco Cyber Vision Network Sensor Installatio
n_Guide for Cisco IE3300 10G Cisco |IE3400 and Cisco Catalyst 9300/m Installation procedures 1E3400 Catalyst 9300 v3 4 0 O.
html#topic 5701

Figure 5-10 shows the sensor installation from CVC on a 9300 using the extension method.

Figure 5-10: Cyber Vision Installation via Extension

cure | hilps/10.64. 86807/ mfadmin/s. -4 end a8 & »0O@R
EN -
d Syl P
Sensor Explorer
o "
v | ®)
Figure 11 shows the status of the sensor deployment on the CVC Dashboard after completing the installation.
Figure 5-11: Cyber Vision Installation Completion Display on CVC Dashboard
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Step 4: Edit the yaml File on the 9300 Switch and Add OPC-UA Ports
OCP-UA ports must be added to the CVC sensor for the detection of the OPC-UA flows and traffic.
1. Update the /iox_data/etc/flow/config.yaml file on the 9300 switch to add the required ports.
The following example shows ports 48010, 49320, 53530, 62620, and 62626 added in the config.yaml file.

0SS5-C9300-Access#app-hosting connect appid ccv _sensor iox x86 64 session
sh-5.0# cd /iox data/etc/flow/
sh-5.0# vi config.yml
gopacket:
opcua:
mapping: tcp:4840, tcp:51210,
tcp:12403,tcp:49320,tcp:53530,tcp:62626,tcp:48010,tcp:62620

2. Enterthe following command to reload the 9300 switch:

flowctl reload

Step 5: Verify the OPC-UA Flow in Cyber Vison Center

From the Cyber Vision Center Dashboard, verify that the OPC-UA flow is as shown in the following figures.
Figure 5-12 shows OPC-UA frame types in the Cyber Vision Center Dashboard.

Figure 5-12: OPC-UA Frame Types in CVC Dashboard
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Figure 5-13 shows a more detailed view the OPC-UA traffic flow on the Cyber Vision Center dashboard.
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Figure 5-13: OPC-UA Flow Detail in CVC Dashboard
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Chapter 6: Implementing the Onshore
Substation Network

This chapter includes the following topics:
= Onshore Substation (ONSS) Core Network Implementation
= Configuring ONSS Infrastructure Network Access

= 0SS Network DMZ with Firewall

Onshore Substation (ONSS) Core Network Implementation

This section describes the steps for configurating the OSS network of the wind farm topology.

Catalyst 9500 StackWise Virtual

Configure Catalyst 9500 StackWise Virtual (SVL) switch by following the steps in Catalyst 9500 StackWise Virtual. Also complete the SVL
mode configuration, layer 2 configuration, layer 3 configuration, and port-channel configuration by using the steps that are described in
Chapter 3: Offshore Substation Network Implementation. After completing these configurations, enter the following CLI commands to
enable ONSS and OSS network reachability to the WAN edge router:

Here is an example of a completed routing (L3) configuration for 9500 SVL switch of the ONSS:

interface Loopback0

ip address 192.168.5.1 255.255.255.255
!
vlan 2001

interface V1an2001

vrf forwarding Management VRF

ip address 10.201.201.2 255.255.255.0

!
router eigrp 2001

|

address-family ipv4 vrf Management VRF

redistribute connected

redistribute bgp 1 metric 100 1 255 1 1500

network 10.201.201.0 0.0.0.255

autonomous-system 900
exit-address-family

!

!

router ospf 1

router-id 192.168.5.1

network 172.16.1.0 0.0.0.3 area O

network 192.168.2.1 0.0.0.0 area 0
network 192.168.5.1 0.0.0.0 area O
network 192.168.7.1 0.0.0.0 area O

!
vrf definition Management VRF
rd 100:1
1
address-family ipv4
route-target export 100:1
route-target import 100:1
route-target export 100:1
stitching
route-target import 100:1
stitching
exit-address-family
!
address-family ipvé6
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route-target export 100:1
route-target import 100:1
route-target export 100:1
stitching
route-target import 100:1
stitching
exit-address-family
1
vlan configuration 11
member wvni 5000
1
interface Vlanll
vrf forwarding Management VRF
ip unnumbered Loopback0
no autostate
|
interface Vlan201
vrf forwarding Management VRF
ip address 10.10.201.1
255.255.255.0
|
interface nvel
no ip address
source-interface LoopbackO
host-reachability protocol bgp
member vni 5000 vrf Management VRF
|
router bgp 1
bgp log-neighbor-changes
bgp update-delay 1
bgp graceful-restart
no bgp default ipv4-unicast
neighbor 192.168.5.2 remote-as 1
neighbor 192.168.5.2 update-source Loopback0
]
address-family ipv4
exit-address-family
!
address-family 1l2vpn evpn
neighbor 192.168.5.2 activate
neighbor 192.168.5.2 send-community both
exit-address-family
!
address-family ipv4 vrf
Management VRF
advertise 1l2vpn evpn
redistribute static
redistribute connected
redistribute eigrp 900
exit-address-family
|
address-family ipv6 vrf
Management VRF
redistribute connected
redistribute static
advertise 12vpn evpn
exit-address-family
!

Verify EVPN VXLAN BGP Core routing between 0SS and ONSS core switches:

WE-ONSS-9500#show nve peers
'M' - MAC entry download flag 'A' - Adjacency download flag
'4' - Ipv4 flag '6' - IPve flag
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Interface
192.168.5.2 0 100 07
* i 192.168.5.2 0 100 0
Network VNIType Peer-IP RMAC/Num_RTs eVNI state flags UP time
nvel 5000 L3CP 192.168.5.2 a4b2.392a.9554 5000 UP A/M/4 3wéd

|

WEF-ONSS-9500#show bgp 1l2vpn evpn all

BGP table version is 67, local router ID is 192.168.7.1

Status codes: s suppressed, d damped, h history, * valid, > best, i - internal,
r RIB-failure, S Stale, m multipath, b backup-path, f RT-Filter,
X best-external, a additional-path, ¢ RIB-compressed,
t secondary path, L long-lived-stale,

Origin codes: i - IGP, e - EGP, ? - incomplete

RPKI validation codes: V valid, I invalid, N Not found

Network Next Hop Metric LocPrf Weight Path
Route Distinguisher: 100:1 (default for vrf Management VRF)
* 1 [5][100:1]1([0][16][172.114.0.01/17

192.168.5.2 0 100 02
*>1 192.168.5.2 0 100 02
* i 192.168.5.2 0 100 07
* i [5][100:171[0]1[24][10.10.1.01/17

192.168.5.2 0 100 0
*>1 192.168.5.2 0 100 02
* i 192.168.5.2 0 100 07
* i [5][100:1][0]1[24][10.10.100.01/17

192.168.5.2 0 100 (O
*>7 Next Hop Metric LocPrf Weight Path
*> [51[100:111[0][24]1[10.10.201.0]1/17

0.0.0.0 0 32768 2

|

WF-ONSS-9500#ping vrf Management VRF 10.10.100.1 source vlan 201
Type escape sequence to abort.

Sending 5, 100-byte ICMP Echos to 10.10.100.1, timeout is 2 seconds:
Packet sent with a source address of 10.10.201.1

Success rate is 100 percent (5/5), round-trip min/avg/max = 1/1/1 ms

WE-ONSS-9500#

Configuring ONSS Infrastructure Network Access

Configure the ONSS C9300 stack by following the steps in Configuring OSS Infrastructure Network Access.
Similarly, configure C9300 aggregation, if required, by following the steps in Configuring FAN Ring Aggregation Switch Stack.

OSS Network DMZ with Firewall

Cisco Next Generation Firewall (NGFW) Implementation
Configure Firepower by following the steps for the OSS layer in Cisco Firepower Next Generation Firewall (NGFW) Implementation.
Turbine Vendor OPC-UA client

The OPC-UA client connects to the OPC-UA server by using either Open, a username and password, or AES-128/256 security keys.
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Chapter 7: Implementing Wireless Access
Networks

This chapter includes the following topics:

= Offshore Wind Farm Wi-Fi Implementation

= QOperating the Wireless Network

= Offshore Wind Farm URWB Implementation for SOV to OSS Connectivity

Figure 7-1 shows the overall wireless deployment architecture for offshore wind farm Wi-Fi access and URWB for vessel-to-0OSS
connectivity.

Figure 7-1: Offshore Wind Farm Wireless Architecture
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Offshore Wind Farm Wi-Fi Implementation

This section provides implementation details for offshore wind farm Wi-Fi access. Wi-Fi
implementation includes the following components:
= Cisco Catalyst Center located in the control center is used to configure and manage the Wi-Fi deployment
= MSFT AD is used to manage employee user identities
= |SEis used as an AAA server for centralized policy management
= (Cisco Trustsec is used for segmentation
= |SE is used to host the guest wireless portal
= (9800 WLCs are used as wireless LAN controllers

= Cisco 9124 or Cisco IW6300 Ruggedized APs can be deployed in local mode on the 0SS, FAN, and TAN as needed

Figure 7-2: Offshore Wind Farm Wi-Fi Access Architecture
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For detailed implementation about Cisco Catalyst Center non-fabric wireless deployment, see Catalyst 9800 Non-Fabric Deployment using Cisco
Catalyst Center:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/CVD/Campus/Catalyst-9800-Non-Fabric-Deployment-using-Cisco-DNA-  Center.pdf
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Configuring C9800 WLC High Availability from Cisco Catalyst Center

Catalyst 9800 Series WLCs can be configured in an active/standby high availability (HA) stateful switch-over (SSO) pair. Cisco Catalyst Center supports
the ability to take two controllers of the same model, running the same OS version, and configure them into an HA SSO pair.

To configure the Catalyst 9800-40 WLCs (WLC-9800-1 and WLC-9800-2) as an HA SSO pair, follow these steps:

1. From the main Cisco Catalyst Center dashboard choose Provision.

The main provisioning screen appears, which displays the devices within the inventory. By default, the Focus: is set for Inventory.
2. Locate and check the check box next to the Catalyst 9800-40 WLC, which will be the primary of the HA SSO WLC pair.

3. From the drop-down menu under Actions, choose Provision > Configure WLC HA.
The High Availability side panel appears. An example is shown in the Fig. 7-3.
Figure 7-3: Configure C9800 WLC High Availability Using Cisco Catalyst Center

High Availability

~—, Please make sure the Redundancy Management IP and Peer Redundancy Management IP are not X
/ assigned to any other network entities. If used, kindly change the IP accordingly and configure.

Primary C9800 Redundancy Management IP*
WF-WLC-9800.windfarm.com 192.168.11.5

Select Secondary C9800 Peer Redundancy Management IP*
WLC.windfarm.com % 192.168.11.86|

Netmask*

24

4, Enter appropriate information in the High Availability side panel and click Configure HA.

For Catalyst 9800 Series WLCs, the redundancy management IP and peer redundancy management IP addresses that need to be configured
within Cisco Catalyst Center are actually the redundancy port and peer redundancy port IP addresses. These IP addresses are referred to
as the local IP and remote IP addresses in the web Ul of the Catalyst 9800 Series WLCs. The IP subnet for the redundancy port must be an
IP subnet that is separate from any other interface on the Catalyst 9800 Series WLC. In addition, the primary and standby Catalyst 9800
Series WLCs must use the same IP subnet for the redundancy port, so the redundancy port connection must be a layer 2 connection.

5. In the pop-up window that informs you that the WLCs will be rebooted after they are placed in high availability mode, click OK to
continue and put the two Catalyst 9800-40 WLCs in HA SSO mode.

It takes several minutes for the WLCs to reboot and come up in HA SSO mode. All configuration from the primary Catalyst 9800-40 WLC,
including the IP address of the management interface, is copied to the secondary Catalyst 9800-40 WLC. Cisco Catalyst Center then
longer shows two WLCs in inventory. Instead, a single WLC HA SSO pair with two serial numbers appears in inventory.

6. Verify that the appropriate C9800 WLC SSO HA configuration is pushed down to the WLC by choosing Administration > Device >
Redundancy.

An example is shown in Figure 7-4.
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Figure 7-4: Verifying High Availability Configuration on the C9800 WLC Ul

u """'c‘,' Cisco Catalyst 9800-L Wireless Controller

cisc 171120230108

* » Device
General Redundancy Config I‘EW\IH.U) .
FTP/SFTP/TFTP Redundancy Pairing Type @ RMI+RP RP
Redundancy RMI IP for Chassis 1* 192.168.11.5
RMI IP for Chassis 2*° 192.168.11.6
Mar t Gateway Failover ETCN |
Gateway Faiure Interval (seconds) 8
Local IP 169.254.11.6
Remote IP 169.254.11.5
Keep Alive Timer 1 x 100 (millisec
Keep Alive Retries 5
Chassis Renumber 2

Active Chassis Pri

Standby Chassis Priority® 2

7. Verify the redundancy status on the WLC by choosing Monitoring > General > System.

An example is shown in Figure 7-5. You also can monitor the status on the C9800 WLC CLI by executing the show redundancy
command as shown in Figure 7-6.

Figure 7-5: Verifying WLC High Availability Status on the WLC Monitoring Page

B vl Cisco Catalyst 9800-1L Wireless Controlier v # % ABSTROC Q

Monioding * erersl® > Systom

Chassis Dataiis

=

Crassis T Fols YT MACAddess T Priery T WWVersion T CumesaSute T SAddess T AP Addess T Mobley MAC Atdress T bmageVersion T Devico Uptime

1 Desh a54 E woz ety A ISa 115 e we2

ez 1wk, 3 hours,

OlazEdes 1 voz Feaddy 169354118 W2 iEa11 8

Switchover Details
[ T Previows Actve T Cument Active T Swich Oves Time T Switch Over Reason g

o 0.
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Figure 7-6: Verifying High Availability Status from the C9800 CLI

WF-WLC-98@@8#show redundancy
Redundant System Information :
Available system uptime
Switchovers system experienced
Standby failures
Last switchover reason

Hardware Mode

Configured Redundancy Mode
Operating Redundancy Mode
Maintenance Mode
Communications

Current Processor Information :

4 days, 2 hours, 31 minutes
2
@

active unit removed

Duplex
$50

ss0
Disabled
Up

[ e B B

Active Location

Current Software state
Uptime in current state
Image Version

= slot 1

= ACTIVE

= 12 minutes

= Cisco I0S Software [Dublin], C9888 Software (C9820_IOSXE-K9), Experimental Version 17.11.208238105:084252 [BLD

_V1711_THROTTLE_LATEST_20230105_@81642: /nobackup/mcpre/s2c-build-ws 181]
Copyright (c) 1986-2023 by Cisco Systems, Inc.
Compiled Thu 85-Jan-23 808:42 by mcpre

BOOT

CONFIG_FILE

Configuration register
Recovery mode
Fast Switchover
Initial Garp

Peer Processor Information :

Standby Location
Current Software state
Uptime in current state
Image Version

bootflash:packages.conf,12;

0x102

Not Applicable
Enabled
Enabled

= slot 2

= STANDBY HOT

= 7 minutes

= Cisco I0S Software [Dublin], C988@ Software (C9808_IOSXE-K9), Experimental Version 17.11.20230105:084252 [BLD

_V1711_THROTTLE_LATEST_202301085_@81642: /nobackup/mcpre/s2c-build-ws 181]
Copyright (c) 1986-2023 by Cisco Systems, Inc.
Compiled Thu 85-Jan-23 20:42 by mcpre

BOOT
CONFIG_FILE
Configuration register

bootflash:packages.conf,12;

Bx102

Configuring Wi-Fi APs using Cisco Catalyst Center

This section describes the workflow for configuring APs using Cisco Catalyst Center.

1.
2.

3.

From the Cisco Catalyst Center Dashboard, choose Provision > Inventory.

Check the check boxes next to each AP to be provisioned and rom the corresponding drop-down menu under Actions, choose
Provision > Provision Device.

Figure 7-7: Select APs to Provision

DEVICES (4)
Focus: Inventory

"Filter | @ Add Device Tag Actions ~ O 4 Selected As of: 1:12 PM " Export ' Refresh
] Device Name « P Inventory ¥ Reachability () EoX Status (1) Manage }
B ¢ W AP3C57.31CS.7EF4 19 Software Image > @ Reachable A Not Scanned @ Managed
Provision > Managed

B < B AP3C57.31C5.ADAB 19 Assign Device to Site ned @ g
Telemet >

@ ¢ W AP2416.9DDEDB5S 19 s Provision Device ned @ Managed
Device Replacement >

B < 1§ APADB4.3965.BEAD 19 LAN Automation ned @ Managed
Compliance >

For each of the APs listed,

Catalyst Center.

LAN Automation Status

click Choose a Site, which displays a side panel that shows the site hierarchy that is configured for Cisco
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Figure7-8: Assign Each AP to a Site

Serial Number Devices

FOC243919K1 AP3C57.31C5.7EF4
FJC25251V6Q AP3C57.31C5.ADAB
FCW2415P0ET AP2416.9DDE.DB58
FCW2350PKCW APAOB4.3965.BEAD

4. Click Save to save the site assignments for the APs, then click Next to continue to the Configuration options.

% Global/RTP/RTP=-06/Floor=1

Apply to All

[ﬁ&] Global/RTP/RTP-06/Floor-1

@f] Global/RTP/RTP-06/Floor-1

ﬂﬁ Global/RTP/RTP-06/Floor-1

5. From the drop-down menu in the RF Profile column, select the RF profile to assign to each AP.

Figure 7-9: Provisioning RF Profiles

Network Devices / Provision Devices

@ Assign Site e Configuration @ Summary

Serial Number Device Name

FOC243919K1 AP3C57.31C5.7EF4
FJC25251V6Q AP3C57.31C5.ADAB
FCW2415P0ET AP2416.9DDE.DB58
FCW2350PKCW APAOB4.3965.BEAOQ

6. Click Next to advance to the AP Provisioning Summary page, and perform the following actions for each AP.

AP Zone Name

Not Applicable

Not Applicable

Not Applicable

Not Applicable

RF Profile

Low

Apply to All ©

Low

Low

Low

S55IDs

The AP Provisioning Summary page provides a summary of the configuration to be provisioned for each AP. Click Deploy to

provision the APs.

Note: As a best practice, make configuration changes and provision new devices in your network during scheduled network

operations change windows.
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Figure 7-10: AP Provisioning Summary Page and Deploy Options

Network Devices | Provision Devices

@ Assign Site @ Configuration o Summary

I AP3C57.31C5.7EF4
AP3C57.31C5.ADAB
AP2416.9DDE.DB58

APAOB4.3965.BEAD

~ Device Details
Device Name:
Serial Number:
Mac Address.:

Device Location:

~ AP Zone Details

AP Zone Name

~ RF Profile Details
RF Profile:
Radio Type:
5GHz Channel Width:
6GHz Channel Width:

2.4GHz Data Rate(in
Mbps}):

5GHz Data Rate(ln Mbps):
6GHz Data Rate(in Mbps):

Zero Wait DFS:

AP3CS57.31C5.ADASR
FJC25251V6Q
4¢:a6:4d:23:baic0
Global/RTP/RTP-06/Floor-1

default-zone

Low

2.4GHz/5GHz/6GHz

20 MHz

Best
1,2,5.56,9,11,12,18,24,36,48,54

6,9,12,18,24,36,48,54
6,9,12,18,24,36,48 54
Disabled

Provision Device

© Now
O Later

(O Generate configuration preview
Creatas preview which can be later used to deploy on selected
devices. If Site assignment Is invoked during configuration preview,
Device controllability configuration will be pushed to cofresponding
device(s). View status in Work Items

Task Name*
Provision APs L&)

Apply

7. Click the Now radio button and then click Apply to apply the configuration.
A Warning pop-up window appears, which explains that all the APs that are part of the configured floor for the selected RF profile
and zone will be processed and rebooted with the selected APs.

Figure 7-11: Warning Pop-up Window

eﬁ@%
Warning

All the Unified AP(s), which are already
part of the configured floor(s) for the
selected RF profile and Zone will be
processed and rebooted along with

selected ones.
Do you want to continue?

8. Click Yes.

A Success pop-up screen should appear, with additional text indicating that after provisioning, the APs will reboot. Click OK to
confirm.

9. Navigate to the Cisco Catalyst Center Task Status page to monitor the status of the “Provision APs” task.
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Figure 7-12: Provision APs Task Status page

PROVISION o
Provision APs

Last updated: 1:17:26
Starts: Nov 17, 2022 1:16 PM Completed: Nov 17, 2022 1:16 PM Status: ° SuccsssPM

s Refresh
¢ Back

® Initialize business intent processing SUCCESS
@ Preprocessing of business intent SUCCESS
® Validation of business intent SUCCESS
® Validation of device intent SUCCESS
@ Converslon of business Intent to network Intent SUCCESS
® Deployment of network Intent SUCCESS

View Detalls
® Deployment of Model Conflig SUCCESS
® Deployment of network intent(templates) SUCCESS

Click on view details for the deployment details

[ ] Deployment of advanced configuration (templates) SUCCESS
[ Device Controllabliity SUCCESS

Upgrading C9800 WLC and AP Images Using Cisco Catalyst Center

This section describes the steps for upgrading the C9800 WLC and AP leveraging Cisco Catalyst Center.

1. Upload and tag the desired C9800 WLC image as the golden image in the Cisco Catalyst Center image repository by choosing
Design > Image Repository.
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Figure 7-13: Upload and Tag the Desired C9800 WLC as the Golden Image Within the Cisco Catalyst Center Image Repository

Inage hame Netzlon Cevices Advisories Golden Image () ~  Device Roles & Tags ()
C9800-L-unlversalkd_wlc.17.10.01.5PAbin  17-10.01.0.1444 0 P -

= {Latest) 0 £ Role: All

) Verifled Critl... High

Add On (N/A)

2. Choose Provision > Inventory.

Cisco Catalyst Center flags the WLC as non-compliant due to its current image not matching the Golden Image.

Figure 7-14: Cisco Catalyst Center Highlighting that the C9800 WLC is Non-Compliant

rocus: Inventory

Frer @ Acd Device Tag  Acticnn
-] Dwvice Name « ® Address Bevice Famdy Reschasairy () Lok Status Mansgeabity () Compliance Heaith Score  Site MAE Address Device Bole  image Version
0O B APICH).JICS IR 102.188.11.11  Urifled AP © Reachable & Mot Scanned @ Managed NI 10 [RTP=CH/Fioar  de:a8da: 224540 ACCESS  17.0.2.52
O B APICSTIICSADAR W02 Unifled AP & Reachable & Mot Scanned @ Managed NfA [RTP-06/Fioor-1  dc:afidd:iibaced ACCESS  17.0.252

] APZ416.500€ 0BS5S 1921681114 Urified AP & Reschatie & Mot Scanced  © Mansged NA JRTP-06/Fioor-1  Sciab:2d4-afa0 ACCESS  17.0.2.52
O B APADES 1585 BEAD 1921681113 Unifled AP © Reachable & Mot Scanned @ Managed NIA L] JRTP-06/Floor-1  aliba:1%c)82:20 ACCESS  17.9.2.52
a WIF AL~ S800 mindfanm. com 1921681100 Wireless Controtier @ Reachable @ 0 sleres 0 Mansged © Non-Compliant 10 ~IRTP/RTP-06 LELEELE ACCESS  17.9.2

You can view detailed information about non-compliance of the C9800 WLC in Cisco Catalyst Center.

As shown in Figure 7-15, the non-compliance is due to the current running version of the C9800 WLC not matching the Golden
Image version in the Cisco Catalyst Center image repository.

Figure 7-15: Details for the C9800 WLC Being Noncompliant

& Software Image

®
Non-Compliant since Dec 6th, 2022, 02:56:01 PM
Compliance last run on: Dec 6th, 2022, 02:56:01 PM

17.10.01

Golden Image Version

Running Version: 17.9.2

3. Navigate to the Cisco Catalyst Center Inventory page and check the check box for the C9800 WLC device to upgrade.
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Figure 7-16: Choose the C9800 WLC to Upgrade

DEVICES (5)
Focus: Inventory v

W Fiter |

8B 0O 000 B>
G O Q@ Q O
e

@ Add Device
Device Name »
B AP3C57.31C5.7EF4

B AP3C57.31C5.ADAB

AP2416.9DDE.DB58

Tag Actions A @ | 1 Selected
Inventory > Device Family Reachabllity ()
Software Image >
Image Update
Provision >
Image Update Status
Telemetry ?

Download Update Readiness Report

Device Replacement >

B APAOB4.3965.BEAD

Compliance

WF-WLC-9800.windfarm

More

Check Image Update Readiness

Wireless Controller @ Reachable

4. Review the current image on the C9800 WLC and the image being upgraded to, then click Next.

Figure 7-17: C9800 WLC Image Update Readiness and Analysis

Image Update

o Analyze Selection 2

Analyze Selection

Distribute 3

Activate

Before you proceed for the Update, analyze your selection.

Devices to Update: 1

Q  Search Table

1 Selected Update v ISSU v
B  Device -

WF-WLC-9800.windfarm.com
=]

(192.168.11.10)

Take a Tour

Device Family: 1

From Image

C9800-L-universalkd_wic.17.
09.02.5PA.bin

4 Schedule and Clean Up 5 Summary

Sites: 1

To Image Comment

C9800-L-universalk9_wic.17.

10.01.5PA bin Update Readiness Report

5. Configure the software distribution checks, then click Next.
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Figure 7-18: Software Distribution Checks

Image Update X

@ Analyze Selection e Distribute 3 Activate 4 Schedule and Clean Up 5 Summary

Software Distribution Checks

You can set an order on Pre and Post checks for your Seftware Distribution. If you don't see the check you can add a new custom
check.

1 Pre and Post checks

i Flasn eneck () svstew e -

Not able to see the check you would like to run? You can add a new check.

(o)

6. Configure image activation, then click Next.

Figure 7-19: Image Activation Configuration

Image Update 2

@ Analyze Selection @ Distribute e Activate 4 schedule and Clean Up 5 Summary

Software Activation Checks

You can enable and set an order on Pre and Post checks for your Software Activation. If you don't see the check you can add a new
custom check.

Skip Activation C.

2 Pre and Post checks

i Config register check (1) SYSTEM PRE [ am]
i Startup config check () SYSTEM PRE POST [ -]
Not able to see the check you would like to run? You can add a new check.

o) D

7. Configure the software distribution and activation tasks, then click Next.
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Figure 7-20: Schedule Update and Clean Up

Image Update

@ Analyze Selection @ Distribute @ Activate o Schedule and Clean Up

Schedule

Schedule when you want the software distribution and activation tasks to occur.

(i) Yourtime zone will be used as the default site time zone.

5

Summary

Software Distribution Software Activation

If the ITSM ServiceNow application is enabled, choose Later. After Distribution @l

O Now OO Later
Task Name*

Distribution of C9800-L-universalk9_wic.17.1C

Flash Cleanup
Flash cleanup will store only the running image and remove all previous images saved on the device,

& Initiate Flash Cleanup after Activation

8. Review the Image Upgrade Summary, then click Submit.
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Figure 7-21: C9800 WLC Image Upgrade Summary

Image Update

@ Analyze Selection @ Distribute @ Activate

Summary

Review your entry and make changes if you wish to do

Devices to Update: 1 Device Family: 1

Device From Image

WF-WLC-9800.windfarm.com (19
2.168.11.10)

C9800-L-universalk9_wlc.17.09.0
2.SPA.bin

@ Schedule and Clean Up

Sites: 1

To Image

C9800-L-universalk9_wic.17.10.0
1.5PA.bin

e Summary

Update Support

Software Distribution Checks

Scheduled On

MNow

Pre And Post Checks

1. Flash check SYSTEM PRE

Software Activation Checks

Scheduled On
Activation will take place right after Distribution is done
Flash Cleanup : Enabled

Pre And Post Checks

1. Config register check SYSTEM PRE

2. Startup config check SYSTEM PRE POST

| Back

9. Monitor the image upgrade process on Cisco Catalyst Center and verify that it completes successfully.

Figure 7-22: C9800 WLC Upgrade Task Status in Cisco Catalyst Center

PROVISION X

WLC-Update

Starts: Nov 16, 2022 3:49 PM Completed: Nov 16, 2022 3:51 PM Status: @@ Success Last updated: 3:51:14 PM Refresh

Hostname: WF-WLC-9800.windfarm.com
IP Address: 192.168.10.11

App Name Device Provisioning, Device Controllability and Telemetry Success @

Configured At Nov 16, 2022 3:51 PM

Description WLC-Update

d

2ee

Details

Wi-Fi Guest User Access
This section describes the steps that a guest user needs to perform to connect to the Guest SSID for internet access.

1. Connect to the Guest SSID.
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2. Inthe Guest Registration - Create Account pop-up window, which includes options for registering guest access, enter the
appropriate information and click Register.

If the pop-up window does nOt appear automatically, open a browser and navigate to the internet.

Figure 7-23: Registering for Guest Access on Guest Registration Portal
e s
. HIGH I}E( H

Provide us with scme information 50 we can creste an sccount for you.
FIRST NAME

Encla

3. Inthe Account Created pop-up window, which provides the credentials for the guest user to connect to the guest SSID, click Sign
On.

Figure 7-24: Account Created Window

. HIGH-TECH
CORPORATION

Account Created
Use the following information to sign on to the network

USERNAME:
eholmes
PASSWORD:
9854

FIRST NAME:
Enola

LAST NAME:
Holmes
EMAIL:

o~ eh@holmes.com
LOCATION:
San Jose

LTI

e

4. Review the information in the Accept Use Policy pop-up window and click Accept.
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Figure 7-25: Acceptable Use Policy Window

eholmes ;
. HIGH-TECH
CORPORATION

Acceptable Use Policy
Please read the Acceplable Use Policy

Please accepl the policy:You are responsible for maintaining the
of the p and all that occur under your

and pa: .Cisco Sy offers the Service for activities

such as the active use of e-mail, instant messaging, browsing the World
Wide Web and accessing corporate intranets. High volume data
transfers, especially sustained high volume data lransfers, are nol
permitted. Hosting a web server or any other server by use of our
Service is prohibited. Trying lo access someone else’s account,
sending unsolicited bulk e-mail, collection of other people’s personal
data without their knowledge and interference with other network users
are all prohibited.Cisco Systems reserves the right o suspend the
Service ifCisco Systems reasonably believes that your use of the
Service is unreasonably excessive of you are using the Service for
cnminal or Blegal activities. You do not have the right to resell this

Candira ta o third mark Ciern Suelame resanae tha rinhl in revies

o n -

FHTTANL

i
.
L

W

Operating the Wireless Network

This section provides an overview of how you can use Cisco DNA Assurance to monitor and troubleshoot the WLAN deployment. Cisco
DNA Assurance provides the ability to monitor the health of Cisco WLCs, APs, and wireless clients.

Cisco Catalyst Center Wireless Assurance
From Cisco Catalyst Center Dashboard, navigate to Assurance > Dashboards > Health.

The Overall Health Dashboard depicts the health of all the wired and wireless devices in the network.

Figure 7-26: Overall Health Dashboard

Metwork Devices Wired Clients
LATEST 60% taarey (1) TOTAL: & WAIEST e gy (D CONNECTED: @
Mo Devices Ho Devicos ho Devices Ko Devices W a

s .
% L

Wireless Clients

- i
. -y -y -5 e

et Core Distribution Actess Wirtess Ancess LATEST 1 00% Howwy () AGTIVE: 3
Controlier Paing
s ACYNTLAL J\"‘U’".ﬂ.l' s e 'm\m}m\\%ﬁ‘m\ﬁh\ﬂ_‘ﬁ L YW il
. o 5 B
View Nitwork Health Vi Clgek Hoaliu

You also can view Network Device Health, which shows the health of wireless devices (WLCs and APs) by clicking the Network tab under
Assurance > Dashboards > Health.
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Figure 7-27: Viewing Wireless Devices (WLC and APs) Health

Network Devices (5)
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DNA Assurance also displays the health of each wireless client. Choose the Client tab under Assurance > Dashboards > Health to view
client health status.

Figure 7-28: Viewing Wireless Client Health

Client Devices (3) # Tracked Cllonts Excludad clients
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TYoE i CVERALL b i No Dats
[ vioiess JRULE Client Health: 10 Ingeiive | o lwie
BATA  Onboarding Time >= 105 Asst sy Bl mication >= 83 RSSI <= -72dBm  SNR <= 9 dB
g
. Passed +, Export &
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(] Igentifier 1Pva Address ! x Jsage AP Name Bard RS Location Last Seen = Capability
0 ¥ jkoe 192.168.13.11 iPad Alr 3r.. 0 No 63.95 kB APADES. 3965 BEAD 5 GHz -43 dBm RTP/RTP-0E/Floor-1 Nov 23, 1:49 PM Mac
0O ¥ smee 192.168.13.12 Apple-Device 10 No 43.8 kB APADEA. 3965 BEAD 5 GHz -50 dBm  RTP/RTP-06/Floor-1 Nov 23, 1:48 PM 11ac
O ¥ enhoimes 192.168.13.14 iPad Alr 3r... 10 No 419.02 kB APICSTIIC5ADAR 5 GHz -39 dBm RTR/RTP-06/Floor-1 Nov 23, 1:48 PM 11ac
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DNA Assurance also highlights the top issues in the network at the bottom of the Overall Health Dashboard.

Figure 7-29: Top 10 Network Issues

Top 10 Issue Types

Priority = Issue Type ~ Device Role Category Issue Count - Site Count (Area) Device Count Last Occurred Time -
P3 AP Flap ACCESS POINT  Availability 1 1 1 Nov 21, 2022 3:36 PM
1 Records

View All Open Issues

DNA Assurance also helps monitor the status of the AAA server (ISE server) and DHCP server (Active Directory) on the Overall Health
Dashboard.
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Figure 7-30: Viewing the Status of the AAA and DHCP Servers

Natwork Serdces

ALK (1 SRR DHCP |1 SERVER

Defective AP Replacement (RMA) using Cisco Catalyst Center

Return material authorization (RMA) is a critical part of device lifecycle management. The manual RMA procedure is time consuming.
Cisco Catalyst Center RMA feature provides for the automated recovery of failed devices quickly, improving productivity and reducing
operational expenses.

Figure 7-31: Cisco Catalyst Center RMA Features
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Replace a Faulty Access Point

Using the Cisco Catalyst Center AP RMA feature, you can replace a faulty AP with an AP that is available in the device inventory.

This feature requires the following:

Because the AP RMA feature supports only like-to-like AP replacements, the replacement AP must have the same model number
and PID as the faulty AP.

The replacement AP must have joined the same Cisco wireless controller as the faulty AP.
The software image version of the faulty AP must be imported to the image repository before marking the device for replacement.

The faulty device must be assigned to a user-defined site if the replacement device onboards Cisco Catalyst Center through plug
and play (PnP).

The replacement AP must not be in the provisioning state while triggering the RMA workflow.

The faulty device must be in an unreachable state.

Procedure:

1.

© ® N O VoA W N

N
©

In the Cisco Catalyst Center GUI, click the Menu icon = and choose Provision > Devices > Inventory.
The Inventory page displays the device information that is gathered during the discovery process.

Check the check box of the faulty AP that you want to replace.

From the Actions drop-down list, choose Device Replacement > Mark Device for Replacement.

In the Mark for Replacement window, click the radio button next to the faulty device name.

From the Actions drop-down list, choose Replace Device.

In the Replace Device window, click Start.

In the Available Replacement Devices table, click the radio button next to the replacement device name.
Click Next.

Review the Replacement Summary, then click Next.

In the Schedule Replacement window, choose whether to replace the device now, or schedule the replacement for a later time,
then click Submit.

The RMA process begins.
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11. To monitor the replacement status, under What's Next, click Monitor Replacement Status.

The Mark For Replacement window lists the devices that are marked for replacement.

Check the status of the replacement in the Replace Status column, which initially shows In-Progress.
12. Click In-Progress in the Replace Status column.

The Replace Status tab shows the various steps that Cisco Catalyst Center performs as part of the device replacement.
13. Inthe Marked for Replacement window, click Refresh and click Replace Status to view the replacement status.

If the faulty AP replacement fails, then the Replace Status column shows an error message with the reason for the failure.

You can either replace the faulty AP with another new AP or retry the failed replacement using the AP RMA Retry feature.
14. Toretry the failed replacement, click the error message in the Replace Status column next to the device name, then click Retry.
15. Inthe Marked for Replacement window, click In-Progress against the Replace Status column.

The Replace Status tab shows Success after successful replacement of the faulty AP.

The Replace Status in the Replacement History window shows Replaced after the faulty device is replaced successfully.

16. (Optional) If you do not want to replace the device, choose the device and choose Actions > Unmark for Replacement.

Troubleshooting Wireless Client Authentication

If certain wireless clients cannot successfully authenticate with the wireless network, start troubleshooting by looking at the ISE live logs.
In these logs, check whether the client was successfully able to authenticate and complete the IEEE 802.1X authentication.

Figure 7-32: Verify in ISE Live Logs Whether Wireless Clients can Authenticate and Establish a Session
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If the authentication failed, click the error for more detailed information.
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Figure 7-33: Detailed Wireless Client Authentication Logs Within Cisco ISE
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If the ISE authentication is successful, you can next verify whether the client is present on the WLC Clients page. The client should be in
the Run state for it to be able to successfully pass traffic.

Figure 7-34: Viewing Authenticated Wireless Clients on the C9800 WLC

ng= » Wireless~ > Clioms

Clents  Sleeping Clients

s [

Solecied 0 cut of 2 Chonts
Chort MAC Address Y IPvd Address Y Pv6 Addross AP Namao Y S50 Y WIANID T ChentTypo T Ste YT Protocol ¥ UseeMame T DovikeType T Role T
Zach bob . 2a05 # 192aesan fod0: 1436881 deadTan0s  APICET NICSADAS  Comp 8 WLAN Fun tac ot Pacd Adr Jed Gen Local
322 B38.aa2 & 1921881302 HoB0: 18619351 F0d:4cad  APICS7 JICSADAE  Corp 18 WLAN Run e a0 O5_X-Workitafion  Local
1 10 - [v]

Offshore Wind Farm URWB Implementation for SOV to 0SS
Connectivity

This section provides sample configuration snippets for the offshore wind farm URWB deployment.
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Figure 7-35: Offshore Wind Farm URWB Deployment for SOV to 0SS Connectivity
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This section provides samples of configurations to apply to the OSS wired network to support a URWB wireless deployment for SOV to
0SS wireless backhaul connectivity.

=  The switch ports where URWB mesh ends are connected must be configured as trunk ports allowing both the URWB
management VLAN and the traffic VLAN.

= The native VLAN for the trunk must be the URWB Management VLAN.

= The switch ports where URWB radios are connected must be configured as access ports in the URWB management VLAN.
=  The Cisco Catalyst 9300 switches should be deployed as a stack.

=  The Cisco Catalyst 9500 switches should be deployed as a StackWise Virtual pair.

C9500 Core-Stack

!

Vlan 106

name URWB-mgmt

!

interface Vlanl06
ip address 10.10.106.1 255.255.255.0

!

interface Port-channell

description Connected to 0SS Access 9300 Stack
switchport mode trunk

!

interface Port-channel2

description Connected to FAN 9300 Stack
switchport mode trunk

!

interface TwentyFiveGigE1l/0/25
switchport mode trunk

channel-group 1 mode active
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!

interface TwentyFiveGigE1/0/26
switchport mode trunk
channel-group 1 mode active

!

interface TwentyFiveGigE1l/0/27
switchport mode trunk

channel-group 2 mode active
|

interface TwentyFiveGigE1/0/28
switchport mode trunk
channel-group 2 mode active

!

interface TwentyFiveGigE2/0/25
switchport mode trunk
channel-group 1 mode active

!

interface TwentyFiveGigE2/0/26
switchport mode trunk

channel-group 1 mode active
|

interface TwentyFiveGigE2/0/27
switchport mode trunk
channel-group 2 mode active

|

interface TwentyFiveGigE2/0/28
switchport mode trunk
channel-group 2 mode active

1

C9300 Distribution Stack

|
vlan 106

name URWB-Mgmt

|

interface Port-channell

description Connected to 0SS-Core-C9500 Stack

switchport mode trunk

|

interface GigabitEthernetl/0/1
description connected to 0SS Radio 1
switchport trunk allowed vlan 106, 217
switchport trunk native vlan 106
switchport mode trunk!

interface GigabitEthernetl/0/2

description connected to 0SS Radio 2
switchport trunk allowed vlan 106,217
switchport trunk native vlan 106
switchport mode trunk!

|
interface TenGigabitEthernetl/1/7

description Connected to 0SS-Core-C9500 Stack
switchport mode trunk

channel-group 1 mode active

|
interface TenGigabitEthernetl/1/8

description Connected to 0SS-Core-C9500 Stack
switchport mode trunk

channel-group 1 mode active

!

interface GigabitEthernet2/0/1

description connected to 0SS Radio 3
switchport trunk allowed vlan 106, 217
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switchport trunk native vlan 106
switchport mode trunk!

!

interface GigabitEthernet2/0/2
description connected to 0SS Radio 4
switchport trunk allowed vlan 106,217
switchport trunk native vlan 106
switchport mode trunk!

!

interface TenGigabitEthernet2/1/7
description Connected to 0SS-Core-C9500 Stack
switchport mode trunk
channel-group 1 mode active

|

interface TenGigabitEthernet2/1/8
description Connected to 0SS-Core-C9500 Stack
switchport mode trunk
channel-group 1 mode active

|

C9300 Access Stack

vlan 106
name URWB-Mgmt

1

interface Port-channell
description Connected to 0SS-Core-C9500 Stack
switchport mode trunk

|

interface GigabitEthernetl/0/1

description connected to Mesh-End-1
switchport trunk allowed vlan 106, 217
switchport trunk native vlan 106
switchport mode trunk

|

interface TenGigabitEthernetl/1/7

description Connected to 0SS-Core-C9500 Stack
switchport mode trunk
channel-group 1 mode active

|

interface TenGigabitEthernetl/1/8

description Connected to 0SS-Core-C9500 Stack
switchport mode trunk
channel-group 1 mode active

|

interface GigabitEthernet2/0/1

description connected to Mesh-End-2
switchport trunk allowed vlan 106, 217
switchport trunk native vlan 106
switchport mode trunk

|

interface TenGigabitEthernet2/1/7

description Connected to 0SS-Core-C9500 Stack
switchport mode trunk
channel-group 1 mode active

|

interface TenGigabitEthernet2/1/8
description Connected to 0SS-Core-C9500 Stack
switchport mode trunk
channel-group 1 mode active

|
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URWB Network Configuration
This section provides sample configurations for a URWB deployment to provide SOV to OSS connectivity.
= Apair of URWB mesh ends should be deployed for redundancy and high availability.

= The switch ports where URWB mesh ends are connected must be configured as trunk ports, allowing both URWB management
VLAN and traffic VLAN. The native VLAN on a trunk must be the URWB Management VLAN.

= Each mesh end should be connected to a different Cisco Catalyst 9300 switch within the stack.

=  The URWB infrastructure APs on the OSS, FAN, and TAN must be configured for layer 2 (flat network) fluidity in which the
infrastructure APs and the SOV APs are in the same subnet.

= AIlURWB APs and the mesh ends must be configured with the same passphrase.

0SS Infrastructure IW9167E/IEC6400 Mesh End
Figure 7-36 shows the deployment topology for a redundant pair of URWB IEC6400s or IW9167 mesh ends in the OSS network.

Figure 7-36: URWB IW9167E/IEC6400 Mesh End High Availability Deployment

The following example shows a snippet of the running configuration from a URWB mesh end

IEC 6400
w/Fast Failover
ME - MPLS Gateway 1

E IEC6400 — PRIMARY
—) Trunk Mgmt Vlan : x
‘ Server
- ME - MPLS Gateway 2
‘ i Trunk E IEC6400 — SECONDARY
Mgmt Vlan : x

Server

'
v, J
.,

. -

#HHHAFAF S H##4#F GENERAL CONFIG ########H###F4##H#
Device name: 0SS-9167ME-1

IP: 10.10.106.10

Netmask: 255.255.255.0

Gateway: 10.10.106.1

Nameservers:

Mesh End mode

HHE#H4F 444 # 444444 FLUIDITY CONFIG #########4#44#444
Fluidity enabled

Fluidity interface: none

Infrastructure mode

Backhaul-check: handoff-inhibition

Mesh-end backhaul-check: handoff-inhibition
Color: enabled, current: O

Network type: flat (layer 2)

Warmup time: 30000 ms

Wireless timeout: 800 ms

Wireless fastdrop: disabled

Frequency scan: disabled

Large network optimization: disabled
Routes: backhaul

Primary-pseudowire enforcement: disabled
Max number of clients: unlimited

DoP settings: limit 0, client 10, bias O
FMQuadro telemetry: enabled
FHFFFFHHHFHHHFHFHFHF MPLS CONFIG H###HFFFHHFFHFHFFFHHHHF
layer 2

unicast-flood: enabled (limited rate)
arp-unicast: disabled (broadcasting allowed)
reduce-broadcast: disabled

pwlist: all
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Cluster ID: disabled
Ethernet Filter allow-list: 0x8892 0x8204, ethernet-I block
MPLS fast failover: enabled
Node failover timeout: 0 ms
L2TP WAN update delay: disabled
Preemption delay: 70 s
Virtual IP: 0.0.0.0
ARP limit: rate 0 grace 30000 block 0
Multicast rules and static routes:
224.0.0.10/255.255.255.255 => 5.255.255.255 1local dynamic
MPLS tunnels:
ldp id 519374131 debug 0 auto pw 1
local gw 5.246.39.136 global gw 0.0.0.0 pwlist { }
mobility true vehicle id -2 v2v_handoff 0 v2v_pws false auto _en true static pws { 0.0.0.0 }
1sps 4##########44#444 VLAN CONFIG ########444444444444
VLAN status: enabled
Management VID: 106
Native VID: 217
#HE##4# 444 # 444444 ADVANCED CONFIG ##########4##444
Gratuitous-arp: enabled
Delay: 150 ms

QoS: enabled
CoS map:

012345%67

[ T e A N
[ 0123456 7]
gos-shaping disabled
gos-8021p disabled
Radius: disabled
blocklist size 0
L2TP is disabled
SNMP: disabled
Configured MTU: 1530
Current WIREDO MTU: 1500

0SS Infrastructure IW9167E Mesh Point

The following example shows a snippet of the running configuration from a URWB 9167E mesh point radio:

HHEHHFFHHHHHHHHE GENERAL CONFIG ######4##4FHHF4HS
Device name: 0SS-9167-1
IP: 10.10.106.11
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netmask: 255.255.255.0

Gateway: 10.10.106.1

Nameservers:

Mesh Point mode

#HHHH A4 4444 WIRELESS CONFIG ########H#4##44#
SLOT 1 Config

Interface: enabled
Mode: fluidity
Frequency: 5180 MHz
Channel: 36
Channel width: 40 MHz
Antenna number: 2

TX power level: 7

TX power: 0 dBm
Antenna gain: 7 dBi
Maximum tx mcs: 9
High-efficiency: enabled
Maximum tx nss: 2

RTS protection: disabled
guard-interval: 800 ns
ampdu max length: 255
distance: 3000 m

The ampdu T

priority O: enabled
priority 1: enabled
priority 2: enabled
priority 3: enabled
priority 4: enabled
priority 5: enabled
priority 6: disabled
priority 7: disabled

Enhanced Distributed Channel Access (EDCA) configuration
vo: aifs=1 cw min=2 cw max=3 txop=15

vi: aifs=1 cw min=3 cw max=4 txop=31

be: aifs=3 cw min=4 cw max=6 txop=31

bk: aifs=7 cw min=3 cw _max=4 txop=0

Passphrase: windfarm
AES encryption: enabled
AES key-control: disabled
Key rotation: disabled
Key rotation timeout: 0 (second)
DFS region: B

DFS radar role: auto

Radar detected: 0

Indoor deployment: disable
Rx-SOP Threshold: 0 dBm (AUTO)

SLOT 2 Config

Interface: disabled
Mode: fluidity
Frequency: 5300 MHz
Channel: 60
Channel width: 40 MHz
Antenna number: 2

TX power level: 7

TX power: 2 dBm
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Antenna gain: 7 dBi
Maximum tx mcs: 9
High-efficiency: enabled
Maximum tx nss: 2

RTS protection: disabled
guard-interval: 800 ns
ampdu max length: 255
distance: 3000 m

The ampdu T

priority O: enabled
priority 1: enabled
priority 2: enabled
priority 3: enabled
priority 4: enabled
priority 5: enabled
priority 6: disabled
priority 7: disabled

Enhanced Distributed Channel Access (EDCA) configuration
vo: aifs=1 cw min=2 cw max=3 txop=15

vi: aifs=1 cw min=3 cw max=4 txop=31

be: aifs=3 cw min=4 cw max=6 txop=31

bk: aifs=7 cw min=3 cw max=4 txop=0

Passphrase: windfarm
AES encryption: disabled
AES key-control: disabled
Key rotation: disabled
Key rotation timeout: 0 (second)
DFS region: B

DFS radar role: auto

Radar detected: 0

Indoor deployment: disable
Rx-SOP Threshold: 0 dBm (AUTO)

#HHF A AR 444 FLUIDITY CONFIG #########H#fH44#
Fluidity enabled

Fluidity interface: 1

Infrastructure mode

Backhaul-check: handoff-inhibition

Mesh-end backhaul-check: handoff-inhibition
Color: enabled, current: O

Network type: flat (layer 2)

Warmup time: 30000 ms

Wireless timeout: 800 ms

Wireless fastdrop: disabled

Frequency scan: disabled

Large network optimization: disabled

Routes: backhaul

Primary-pseudowire enforcement: disabled

Max number of clients: unlimited

DoP settings: limit 0, client 10, bias 0
FMQuadro telemetry: enabled

HHHFFFHF A EEHH MPLS CONFIG ##H###H##HFHHHFHEHFHH
layer 2

unicast-flood: enabled (limited rate)
arp-unicast: enabled (broadcasting not allowed)
reduce-broadcast: disabled

pwlist: all

Cluster ID: disabled

Ethernet Filter allow-list: 0x8892 0x8204, ethernet-I block
MPLS fast failover is disabled

ARP limit: rate 0 grace 30000 block 0

Multicast rules and static routes:
224.0.0.10/255.255.255.255 -=> 5.255.255.255 dynamic
MPLS tunnels:

ldp_id 1570886916 debug 0 auto pw 1
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local gw 5.246.39.136 global gw 0.0.0.0 pwlist { }
mobility true vehicle id -2 v2v _handoff 0 v2v _pws false auto en true
static pws { 0.0.0.0 }
lsps 4
HHHHHH A A E S S VLAN CONFIG ######44 44444444444 H
VLAN status: enabled
Management VID: 106
Native VID: 217
#HHhHHH A4 #4444 ADVANCED CONFIG ##########4##444
Gratuitous-arp: enabled
Delay: 150 ms

QoS: enabled
CoS map:

012345%67

e
[ 0123456 7]
gos-shaping disabled
gos-8021p disabled
Radius: disabled
blocklist size O
L2TP is disabled
SNMP: disabled
Configured MTU: 1530
Current WIREDO MTU: 1500

Service Operations Vessel Network

Figure 7-37 shows implementation details for the service operations vessel (SOV) network.
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Figure 7-37: SOV Network Topology
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This section provides sample configuration snippets for the SOV wired network.

IE3X00-1

!

vlan 106
name URWB-Mgmt

|

spanning-tree vlan 106 priority 4096

|

interface GigabitEthernetl/3
description V-9167E-1

switchport trunk allowed
vlian 106, 217

switchport trunk native vlan
106

switchport mode trunk!

spanning-tree portfast

|

interface GigabitEthernetl/4
description connected to IR1101-1 gig0/0/5
switchport trunk allowed vlan 106
switchport mode trunk

|

interface GigabitEthernetl1/10
description connected to IE3200-2 gigl/10
switchport trunk allowed vlan 106
switchport mode trunk

|
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IE3X00-2

!

vlan 106
name URWB-Mgmt

|

interface GigabitEthernetl/3
description V-9167E-2

switchport trunk allowed
vlian 106, 217

switchport trunk native vlan
106

switchport mode trunk!

|

interface GigabitEthernetl/4
description connected to IR1101-2 gig0/0/5
switchport trunk allowed vlan 106
switchport mode trunk

|

interface GigabitEthernetl/10
description connected to IE3200-1 gigl/10
switchport trunk allowed vlan 106
switchport mode trunk

|

|

vlan 106,200-201

!

interface GigabitEthernet0/0/0
description connected to C9300 gig2/0/1
switchport

switchport trunk allowed vlan 106,200,201
switchport mode trunk

media-type rj45

|

interface GigabitEthernet0/0/5
description connected to IE3200-1 gigl/4
switchport trunk allowed vlan 106
switchport mode trunk

|

interface V1anl00

ip address 10.10.10.101 255.255.255.0

!

interface V1an200

ip address 192.168.0.2 255.255.255.0
ip access-group deny201 in

vrrp 1 ip 192.168.0.1

vrrp 1 preempt delay minimum 10

vrrp 1 priority 101

|

interface Vl1an201

ip address 192.168.1.2 255.255.255.0
ip access-group deny200 in

vrrp 2 ip 192.168.1.1

1

router eigrp 10

network 10.10.10.0 0.0.0.255

network 192.168.0.0

network 192.168.1.0

|

ip access-list extended deny200

10 deny ip 192.168.0.0 0.0.0.255 any
20 permit ip any any
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IR1101-2

(9300

ip access-list extended deny201

10 deny ip 192.168.1.0 0.0.0.255 any
20 permit ip any any

]

!

vlan 106,200-201

!

interface GigabitEthernet0/0/0
description connected to C9300 gigl/0/1
switchport

switchport trunk allowed vlan 106,200,201
switchport mode trunk

media-type rj45

|

interface GigabitEthernet0/0/5
description connected to IE3200-2 gigl/4
switchport trunk allowed vlan 106
switchport mode trunk

interface V1anl00

ip address 10.10.10.102 255.255.255.0
|

interface V1an200

ip address 192.168.0.3 255.255.255.0
ip access—-group deny201 in

vrrp 1 ip 192.168.0.1

1

interface V1an201

ip address 192.168.1.3 255.255.255.0
ip access—-group deny200 in

vrrp 2 ip 192.168.1.1

vrrp 2 preempt delay minimum 10

vrrp 2 priority 101

!
router eigrp 10

network 10.10.10.0 0.0.0.255

network 192.168.0.0

network 192.168.1.0

|
ip access-list extended deny200

10 deny ip 192.168.0.0 0.0.0.255 any
20 permit ip any any
ip access-list extended deny201

10 deny ip 192.168.1.0 0.0.0.255 any
20 permit ip any any

|

!

vlan 106,200-201

|

interface GigabitEthernetl/0/1

description connected to IR1101-2 gig0/0/0
switchport trunk allowed vlan 106,200,201
switchport mode trunk

!

interface GigabitEthernet2/0/1

description connected to IR1101-1 gig0/0/0
switchport trunk allowed vlan 106,200,201
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switchport mode trunk
end

!
interface V1an200

ip address 192.168.0.5 255.255.255.0
|

interface V1an201

ip address 192.168.1.5 255.255.255.0
|

URWSB Configuration

This section provides sample configuration snippets for the SOV wireless (URWB) network.

Service Operations Vessel IW9167E-1 (Mobile)

###F A AR A4 44 # GENERAL CONFIG ###############4#H#
Device name: V-9167E-1

IP: 10.10.106.21

netmask: 255.255.255.0

Gateway: 10.10.106.1

Nameservers:

Mesh Point mode

#HHHFFHF A H4H4HF WIRELESS CONFIG #######FH#FHFH4HH#
SLOT 1 Config

Interface: enabled
Mode: fluidity
Frequency: 5180 MHz
Channel: 36
Channel width: 40 MHz
Antenna number: 2

TX power level: 6

TX power: 3 dBm
Antenna gain: 7 dBi
Maximum tx mcs: 9
High-efficiency: enabled
Maximum tx nss: 2

RTS protection: 512
guard-interval: 800 ns
ampdu max length: 255
distance: 3000 m

The ampdu T

priority O: enabled
priority 1: enabled
priority 2: enabled
priority 3: enabled
priority 4: enabled
priority 5: enabled
priority 6: disabled
priority 7: disabled

Enhanced Distributed Channel Access (EDCA) configuration
vo: aifs=1 cw min=2 cw_max=3 txop=15

vi: aifs=1 cw min=3 cw max=4 txop=31

be: aifs=3 cw min=4 cw_max=6 txop=31

bk: aifs=7 cw min=3 cw max=4 txop=0

Passphrase: windfarm
AES encryption: enabled

AES key-control: disabled
Key rotation: disabled
Key rotation timeout: 0 (second)
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DFS region: B

DFS radar role: auto

Radar detected: 0

Indoor deployment: disable
Rx-SOP Threshold: 0 dBm (AUTO)

#HHHHAHHHH 444 FLUIDITY CONFIG ########4#444 4444
Fluidity enabled
Fluidity interface: 1, 2
Vehicle ID: automatic, current ID: 100017752 current role: mobile primary unit
Handoff logic: standard
Handoff hysteresis high threshold: 6
Handoff hysteresis low threshold: 3
Rssi low/high zones threshold: 35
Color: enabled, current: O
Color min RSSI threshold: 20
Network type: flat (layer 2)
Warmup time: 30000 ms
Wireless timeout: 800 ms
Wireless fastdrop: disabled
Frequency scan: disabled
Large network optimization: disabled
Routes: backhaul
Primary-pseudowire enforcement: disabled
Max number of clients: unlimited
DoP settings: limit 0, client 10, bias O
FMQuadro telemetry: enabled
FHA#HHHHHHH #4445 H#F MPLS CONFIG ########H###FH4#4#444#
layer 2
unicast-flood: enabled (limited rate)
arp-unicast: enabled (broadcasting not allowed)
reduce-broadcast: enabled
pwlist: all
Cluster ID: disabled
Ethernet Filter allow-list: 0x8892 0x8204, ethernet-I block
MPLS fast failover is enabled
Node failover timeout: O ms
L2TP WAN update delay: disabled
Preemption delay: 100 s
Virtual IP: 10.10.10.10
ARP limit: rate 0 grace 30000 block 0
Multicast rules and static routes:
224.0.0.10/255.255.255.255 -=> 5.255.255.255 dynamic
MPLS tunnels:
ldp id 312290134 debug 0 auto _pw 1
local gw 5.246.39.136 global gw 0.0.0.0 pwlist { }
mobility true vehicle id 100017752 v2v_handoff 0 v2v _pws false auto en
true static pws { 0.0.0.0 }
1sps A###### 444444444 VLAN CONFIG ##H#### 444 #44 44444444
HHE##4#d#4# 444444 VLAN CONFIG #H###f#d4#f44#f44#444
VLAN status: enabled
Management VID: 106
Native VID: 217
#H#H4HH 44 H 44444 ADVANCED CONFIG ##t#####4###4##444
Gratuitous-arp: enabled
Delay: 150 ms

QoS: enabled
CoS map:

012345%67

e
[ 0123456 7]
gos-shaping disabled
gos-8021p enabled
Radius: disabled
blocklist size 0
L2TP is disabled
SNMP: disabled
Configured MTU: 1530
Current WIREDO MTU: 1500 LICENSED
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Service Operations Vessel IW9167E -2(Mobile)
FHEFEHEFEHEH S GENERAL CONFIG ########4## 4444444

Device name: V-9167E-2
IP: 10.10.106.22

netmask: 255.255.255.0
Gateway: 10.10.106.1
Nameservers:

Mesh Point mode

HHFFH A A FER AR AS WIRELESS CONFIG ########44444444

SLOT 1 Config

Interface: enabled
Mode: fluidity
Frequency: 5180 MHz
Channel: 36
Channel width: 40 MHz
Antenna number: 2

TX power level: 6

TX power: 3 dBm
Antenna gain: 7 dBi
Maximum tx mcs: 9
High-efficiency: enabled
Maximum tx nss: 2

RTS protection: 512
guard-interval: 800 ns
ampdu max length: 255
distance: 3000 m
The ampdu T

priority O: enabled
priority 1: enabled
priority 2: enabled
priority 3: enabled
priority 4: enabled
priority 5: enabled
priority 6: disabled
priority 7: disabled
Enhanced Distributed Channel Access (EDCA) configuration

vo: aifs=1 cw min=2 cw max=3 txop=15
vi: aifs=1 cw min=3 cw max=4 txop=31
be: aifs=3 cw min=4 cw max=6 txop=31

bk: aifs=7 cw min=3 cw _max=4 txop=0
Passphrase: windfarm
AES encryption: enabled

AES key-control: disabled
Key rotation: disabled

Key rotation timeout:

0 (second)

DFS region: B

DFS radar role: auto
Radar detected: 0
Indoor deployment: disable

Rx-SOP Threshold: 0 dBm (AUTO)
#HH4fH 4 H #4444 FLUIDITY CONFIG ######## 4444444
Fluidity enabled

Fluidity interface: 1, 2

Vehicle ID: automatic, current ID:
Handoff logic: standard

Handoff hysteresis high threshold: 6
Handoff hysteresis low threshold: 3
Rssi low/high zones threshold: 35
Color: enabled, current: O
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Color min RSSI threshold: 20

Network type: flat (layer 2)

Warmup time: 30000 ms

Wireless timeout: 800 ms

Wireless fastdrop: disabled

Frequency scan: disabled

Large network optimization: disabled

Routes: backhaul

Primary-pseudowire enforcement: disabled

Max number of clients: unlimited

DoP settings: limit 0, client 10, bias 0

FMQuadro telemetry: enabled

H#HHHFFHFF A S 44 MPLS CONFIG ###H#####FH##HFH4H##HH
layer 2

unicast-flood: enabled (limited rate)

arp-unicast: enabled (broadcasting not allowed)
reduce-broadcast: enabled

pwlist: all

Cluster ID: disabled

Ethernet Filter allow-1list: 0x8892 0x8204, ethernet-I block
MPLS fast failover is enabled

Node failover timeout: 0 ms

L2TP WAN update delay: disabled

Preemption delay: 100 s

Virtual IP: 10.10.10.10

ARP limit: rate 0 grace 30000 block 0

Multicast rules and static routes:
224.0.0.10/255.255.255.255 => 5.255.255.255 dynamic
MPLS tunnels:

ldp id 312290134 debug 0 auto pw 1

local gw 5.246.39.136 global gw 0.0.0.0 pwlist { }
mobility true vehicle id 100017752 v2v_handoff 0 v2v_pws false auto_en true static pws { 0.0.0.0

}
lsps A###########4#4444 VLAN CONFIG ########H4H4H4#4H##4
#HHHHHHHHH A A HHE VLAN CONFIG ######## #4444 4H4444
VLAN status: enabled
Management VID: 106
Native VID: 217
#H4 4 H 44 #4444 ADVANCED CONFIG ######4## 4444444
Gratuitous-arp: enabled
Delay: 150 ms

QoS: enabled
CoS map:

01234567

[ T A O I
[ 0123456 7]
gos-shaping disabled
gos-8021p enabled
Radius: disabled
blocklist size O
L2TP is disabled
SNMP: disabled
Configured MTU: 1530
Current WIREDO MTU: 1500

IW Monitor

IW Monitor is a network-wide, on-premises monitoring dashboard that allows any URWB customer to proactively maintain and monitor
one or more wireless OT networks. IW-Monitor displays data and situational alerts from every URWB device in a network in real time. One
of the biggest advantages of IW Monitor is the ability to configure alerts for a group of radios based on certain KPIs. Imagine needing to
support an application mix of automation and CCTV. The set of radios supporting the automation application can be grouped and alarms
configured for KPIs such as latency, jitter, RSSI, and so on. And the group of radios that support the CCTV network can have alarms
configured using different KPIs such as Link Error Rate (LER), MCS rate, and so on.
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IW Monitor Dashboard
Figure 7-38 IW Monitor Dashboard
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Figure 7-39 IW Monitor Topology View
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For complete IW Monitor Installation steps please see the IW Monitor User guide.
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IW Service on OPERATIONS DASHBOARD

Operations Dashboard is a centralized cloud-hosted server that can be used for provisioning of an entire URWB system,
including configuration, firmware upgrade, and plug-in activation. It allows all the radio configuration to be done in a single
pane and uploaded to radios in real time or offline. IW service supports almost all URWB configuration options (basic and
advanced). IW Service can be used to create configuration templates and apply them to multiple URWB devices of the same
type. Templates can be applied in either online mode (if the URWB devices have internet access) or offline mode (if the
URWSB devices have no internet access). We recommend IW services for configuring URWB devices in deployments of any
size.

URWSB device provisioning can be done using one of two methods:
e  Online Configuration method:

e Automated template provisioning using the Operations Dashboard to push pre built configuration
templates to IP reachable URWB devices.

e  Offline Configuration method:

e Operations dashboard generated configuration files, to upload locally to URWB devices.
e Local manual configuration via the local URWB device gui.

Figure 7-40 IW Services on OD Cloud-Hosted URWB Configuration Tool
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Industrial Wireless
Q v
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B Group name = Group description Product ID Device count
Temg
O Fixed IW9167EH-B 0
= Fixed-Fluldity IW9167EH-B 0
] FixedMP IW3167EH-B 0
O Fluidity- FluldmaxP IW3167EH-B 0
O L3Fluidity-ME IW9167EH-B 0
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Note: For in depth IW service configuration guidance please see Operations Dashboard.
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Chapter 8: Implementing WAN Backhaul and
Control Center

This chapter includes the following topics:
=  Implementing WAN Backhaul

= Implementing Network Control Center and Application Services

Implementing WAN Backhaul

The utility WAN is often a dedicated WAN infrastructure that connects the transmission service operator (TSO) control center with
various substations and other field networks and assets. Utility WAN connections can include a variety of technologies, such as cellular
LTE and 5G options for public backhaul, fiber ports to connect utility owned private networks, leased lines or MPLS PE connectivity
options, and legacy multilink PPP backhaul aggregating multiple T1 and E1 circuits.

The Cisco IR8340 is used as a substation router in this solution. The router is configured as customer edge device. This implementation
uses BGP protocol for the MPLS connectivity. Services such as management, SCADA, and so on are provisioned with different VRFs. The
Cisco IR8340 acts as the layer 3 gateway for these services. These services and their related subnets are exchanged over the MPLS
network using BGP, as the node is being configured as a customer edge router.

Detailed end-to-end configuration of all aggregation devices is out of the scope of this section. This section shows the limited
configuration on the customer edge device that necessary to understand the MPLS VPN and layer 3 VPN setup. This section also
describes the configurations that are required on Ethernet interfaces for them to act as MPLS WAN backhaul interfaces.

In the wind farm solution, all services from the wind farm network are aggregated in the onshore substation core switch and a
redundant link is configured between the core switch and substation router to provide the layer 3 redundant gateway.

The following configurations are required in the substation router for the wind farm network to reach the control center for services.

VRF Services in the Substation Router
The following example shows the configuration for one service. Other services, such as SCADA, are configured in a similar way.

vrf definition Management VRF
rd 100:1
route-target export 100:1
route-target import 100:201
|
address-family ipv4
exit-address-family

WAN configuration
interface GigabitEthernet0/0/0
description connected PE

ip address 192.168.82.2 255.255.255.0
load-interval 30

negotiation auto

mpls propagate-cos

mpls ip

mpls label protocol ldp

mpls ldp discovery transport-address interface

mpls traffic-eng tunnels

bfd interval 50 min rx 50 multiplier 3

MPLS Global Configuration
|

mpls label protocol 1ldp
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mpls 1ldp graceful-restart
mpls 1ldp router-id LoopbackO

BGP Configuration

interface Loopback0
ip address 192.168.198.1 255.255.255.255

router bgp 198

bgp router-id interface Loopback0

bgp log-neighbor-changes

neighbor 100.100.100.1 remote-as 200

neighbor 100.100.100.1 ebgp-multihop 2
neighbor 100.100.100.1 update-source Loopback0
]

address-family ipv4
neighbor 100.100.100.1 activate
neighbor 100.100.100.1 next-hop-self
neighbor 100.100.100.1 send-label
exit-address-family

!

address-family vpnv4
neighbor 100.100.100.
neighbor 100.100.100.
neighbor 100.100.100.
exit-address-family

|

address-family ipv4 vrf Management VRF
redistribute connected
redistribute eigrp 900
neighbor 20.11.0.1 remote-as 200
neighbor 20.11.0.1 activate
neighbor 20.11.0.1 next-hop-self
exit-address-family

activate
send-community extended
next-hop-self

T

Configuring WAN Substation using Cisco SD-WAN

The Cisco SD-WAN substation deployment is based on Cisco SD-WAN End-to-End Deployment Guide and expands its scope to using Cisco
IR8340 as the Cisco SD-WAN edge router. This implementation supports controllers running on the Cisco cloud-managed service.

Deploying WAN Edge Routers (IR8340) using Cisco SD-WAN

For complete information about configuring WAN edge routers using Cisco SD-WAN, see Substation Automation—The New Digital
Substatation Implementation Guide:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/SA/3-0/1G/SA 3-0 |G v06.pdf

Configuring WAN Edge Routing for High Availability

HSRP is the Cisco standard method for providing high network availability by providing first hop redundancy for IP hosts on an IEEE 802
LAN that is configured with a default gateway IP address. HSRP routes IP traffic without relying on the availability of any single router. It
enables a set of router interfaces to work together to present the appearance of a single virtual router or default gateway to the hosts
on a LAN. When HSRP is configured on a network or segment, it provides a virtual media access control (MAC) address and an IP address
that is shared among a group of configured routers.

HSRP allows two or more HSRP-configured routers to use the MAC address and IP network address of a virtual router. The virtual router
does not exist; it represents the common target for routers that are configured to provide backups for each other. One of the routers is
selected to be the active router and another to be the standby router. The standby router assumes control of the group MAC address
and IP address if the active router fails. Routers in an HSRP group can be any router interface that supports HSRP, including routed ports
and switch virtual interfaces (SVIs).

For detailed information about HSRP configuration, see Understand the Hot Standby Router Protocol Features and Functionality:

https://www.cisco.com/c/en/us/support/docs/ip/hot-standby-router-protocol-hsrp/9234-hsrpguidetoc.html
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The wind farm solution uses a redundant link from the onshore core switch to substation routers and between substation routers.
To configure this link:
1. Configure the active router as shown in the following example.

This example assumes that VLAN 2001 is enabled for the management_VRF.

Interface Vlan 2001

ip address 10.201.201.2 255.255.255.0
standby 1 ip 10.201.201.100

standby 1 priority 10

standby 1 preempt

standby 1 track 100 decrement 10

2. Configure the standby router as shown in the following example:

Interface Vlan 2001

ip address 10.201.201.3 255.255.255.0
standby 1 ip 10.201.201.100

standby 1 preempt

standby 1 track 100 decrement 10

3. Enterthe following CLI command to track the status of the WAN interface.

If the WAN interface on the active router goes down, the standby router becomes active. When the recovery happens, both routers
go back to the states they had before the failure.

Configure the track command cli on the global configuration on router.
“track 100 interface GigabitEthernet 0/0/0 line-protocol”

Note: For all traffic in the core switch, the HSRP IP address that is configured on the VLAN 2001 is the gateway for the wind farm
network so that when a failure occurs in the active router, the standby router uses the HSRP IP address to become the active router, and
traffic automatically switches to the current active router.

Implementing Network Control Center and Application Services

This section covers the implementation of services, called shared services, that are common to all sites in a wind farm network. Shared
services such as Cisco Catalyst Center, ISE, DHCP, and DNS, along with other vertical market-specific applications such as Cisco Cyber Vision
Center, must be reachable from each site via VRF.

Configuring a DHCP Server

A dynamic host configuration protocol (DHCP) server is a network server that automatically provides and assigns IP addresses, default
gateways, and other network parameters to client devices. It relies on the standard DHCP to respond to broadcast queries by clients.

A DHCP server can be configured in the network in many ways. In a wind farm implementation, a centralized DHCP server in the control
center is installed and configured on a Microsoft Windows 2016 server.

This section covers the DHCP scope and IP pools definition and discusses scope for implementing non-fabric sites in wind farm networks.
For detailed information about DHCP configuration, see Microsoft Windows Server 2016: DHCP Server Installation & Configuration.

After the DHCP server is successfully configured on a Microsoft Windows 2016 server, create scopes for all the devices for Cisco Catalyst
Center as PnP server with options in the DHCP server.

Domain Name Server

The wind farm implementation that this document describes uses domain name servers (DNSs) that run on a Microsoft Windows 2016
server (and that are collocated on a DHCP server in wind farm control center network).

For detailed information about configuring DNS on a Microsoft Windows 2016 server, see “Implement Domain Name System” in Exam
Ref 70-741 Networking with Windows Server 2016, which is available from the Microsoft Press Store.

Cisco Catalyst Center Installation and Configuration

Cisco Catalyst Center offers centralized, intuitive management that makes it fast and easy to design, provision, and apply policies across
your network environment. Cisco Catalyst Center provides a centralized management dashboard for complete control of wind farm
networks.
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Cisco Catalyst Center is a dedicated hardware appliance powered through a software collection of applications, processes, services,
packages, and tools, and is the centerpiece for Cisco Digital Network Architecture (Cisco DNA). This software provides full automation
capabilities for provisioning and change management, reducing operations by minimizing the touch time required to maintain the
network.

For information about installation and network configuration of Cisco Catalyst Center, see Cisco Catalyst Center Second-Generation
Appliance Installation Guide, Release 2.3.5:

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-
5/install guide/2ndgen/b cisco dna center install guide 2 3 5 2ndGen.html

Cisco ISE Installation and Configuration and Integration with Cisco Catalyst Center

Cisco Identity Services Engine (ISE) is a policy-based access control system that enables and enforces compliance and infrastructure
security. ISE is an integral part of networks, acting as the authentication, authorization, and accounting (AAA) server for device identity
management, access control, and enforcement of access policies.

In the wind farm solution, ISE is coupled with Cisco Catalyst Center for dynamic mapping of users and devices to scalable groups, which
simplifies end-to-end security policy management and enforcement at a greater scale than traditional network policy implementations
that rely on IP address access lists.

ISE Installation and Initial Configuration

A centralized standalone deployment of ISE is configured with Cisco Catalyst Center in the shared services network as shown in the network
topology in Figure 2.1. ISE can be installed in various ways. OVA deployment of ISE as a virtual machine is used in this implementation.

For ISE installation instructions, see Cisco Identity Services Engine Installation Guide, Release 3.2:

https://www.cisco.com/c/en/us/td/docs/security/ise/3-2/install _guide/b ise installationGuide32.html

After ISE installation and basic configuration is complete, ISE must be integrated with Cisco Catalyst Center. For instructions, see “Cisco
Catalyst Center and Cisco ISE Integration” in Cisco Catalyst Center Administrator Guide, Release 2.3.3.

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-
3/admin_guide/b cisco_dna_center_admin guide 2 3 3/b cisco dna center admin guide 2 3 3 chapter 010.html#id 54524

Note: Before integrating ISE with Cisco Catalyst Center, ensure that PxGrid services are online on the ISE and that the cluster node is up
in Cisco Catalyst Center.

After integrating ISE with Cisco Catalyst Center using PxGrid, information sharing between ISE and Cisco Catalyst Center is enabled,
including sharing of device information and group information. This sharing allows Cisco Catalyst Center to define policies that are
pushed to ISE and then rendered into the network infrastructure by the ISE policy service nodes (PSNs). When integrating ISE and Cisco
Catalyst Center, a trust is established through mutual certificate authentication. This authentication is completed seamlessly in the
background during integration and requires both platforms to have accurate NTP time synchronization.

Cisco Firepower Management Center installation and Configuration

Firepower Management Center (FMC) is a fault-tolerant, purpose-built network appliance that provides a centralized management

console and database repository for a Firepower System deployment. FMC controls the network management features on your devices,
including switching, routing, NAT, VPN, and so on.

In the wind farm solution, FMC is deployed as a virtual machine. For more information, including detailed FMC configuration steps, see
Firepower Management Center Configuration Guide, Version 7.0:

https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-
v70/introduction to the cisco firepower system.html

Cisco Cyber Vision Center Global Center

The Cisco Cyber Vision (CVC) Global Center feature allows the synchronization of several centers within a single repository. The Global
Center aggregates centers into a single application and presents a summary of several center activities.

After the setup of a local Cyber Vision Center and a Global Center is complete, the local center synchronization can be initialized from
the Global Center. This process consists of the enroliment of a local Cyber Vision center with a Global Cyber Vision Center. When the
local center is enrolled, its data is synchronized incrementally. If needed, the local Cyber Vision Center can be unenrolled later, and
Global Center then removes all data form that local center. The unenrolled center becomes available for another enroliment.

For information about installing and configuring CVC Global Center, see “Configuring the Center” in Cisco Cyber Vision Center VM
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Installation Guide, Release 4.1.2:

https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/Center-VM/Release-4-1-
2/b Cisco Cyber Vision Center VM Installation Guide/m Configure the Center CENTER VM v3 4 0 0.html#topic 5722

Cisco Stealthwatch Management Console installation and Configuration

Cisco Stealthwatch Management Console (SMC) is an enterprise-level security management system that allows network administrators
to define, configure, and monitor multiple distributed Stealthwatch Flow Collectors from a single location. This system provides flow-
based security, network, and application performance monitoring across physical and virtual environments. With Stealthwatch, network
operations and security teams can see who is using the network, what applications and services are in use, and related performance
information. The SMC client software allows you to access the SMC'’s graphical user interface (GUI) from a local computer that has
access to a web browser.

Through the client GUI, you can easily access real-time security and network information about critical segments throughout your
network.

For more detailed information about Stealthwatch design, see “Cisco Secure Network Analytics (Stealthwatch)”in Cisco Solution for
Renewable Energy Offshore Wind Farm1.0 Design Guide:

https://www.cisco.com/c/dam/en/us/solutions/collateral/enterprise/design-zone-industry-solutions/wind-farm-design-guide.pdf

For information about installing Stealthwatch Manager (also known as SMC) Virtual Edition without a datastore, see Cisco Secure
Network Analytics Virtual Edition Appliance Installation Guide 7.4.2:

https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system installation configuration/7 4 2 VE Appliance Installati
on Guide DV 1 3.pdf

For information about configuring Stealthwatch Manager (also known as SMC) Virtual Edition without a datastore, see Cisco Secure
Network Analytics System Configuration Guide 7.4.2:

https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system installation configuration/7 4 2 System Configuration
Guide DV 1 2.pdf

Note: Make sure to activate Cisco Smart Software Licensing for the SNA appliances (SMC and SFC) after the installation and
configuration. For information about SNA licensing, see Cisco Secure Network Analytics Smart Software Licensing Guide 7.4.2:

https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/license/7 4 2 Smart Software Licensing Guide DV 1 0.pdf

81


https://www.cisco.com/c/en/us/td/docs/routers/access/1101/b_IR1101HIG/b_IR1101HIG_chapter_01.html
https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/Center-VM/Release-4-1-2/b_Cisco_Cyber_Vision_Center_VM_Installation_Guide/m_Configure_the_Center_CENTER_VM_v3_4_0_0.html#topic_5722
https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/Center-VM/Release-4-1-2/b_Cisco_Cyber_Vision_Center_VM_Installation_Guide/m_Configure_the_Center_CENTER_VM_v3_4_0_0.html#topic_5722
https://www.cisco.com/c/dam/en/us/solutions/collateral/enterprise/design-zone-industry-solutions/wind-farm-design-guide.pdf
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system_installation_configuration/7_4_2_VE_Appliance_Installation_Guide_DV_1_3.pdf
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system_installation_configuration/7_4_2_VE_Appliance_Installation_Guide_DV_1_3.pdf
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system_installation_configuration/7_4_2_System_Configuration_Guide_DV_1_2.pdf
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system_installation_configuration/7_4_2_System_Configuration_Guide_DV_1_2.pdf
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/license/7_4_2_Smart_Software_Licensing_Guide_DV_1_0.pdf

Cisco Offshore Wind Farm Solution 1.2 Implementation Guide

Implementing Network Management and Automation

Chapter 9: Implementing Network
Management and Automation

This chapter includes the following topics:

=  Preparing Cisco Catalyst Center and Switches for Device Onboarding
=  FAN and TAN Ring Devices Onboarding (Day-0 Provisioning)

=  Configure the FAN REP Ring Using the REP Workflow

=  Day N Configurations using Cisco Catalyst Center Templates

=  Adding a New Switch to a FAN REP Ring

= Network Assurance

Preparing Cisco Catalyst Center and Switches for Device Onboarding

This section provides information about discovering and onboarding wind farm devices to Cisco Catalyst Center. Cisco Catalyst Center
helps make management of devices easier.

For more detailed information about Cisco Catalyst Center and related configurations, see Cisco Catalyst Center User Guide, Release 2.3.5:

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-
5/user guide/b cisco dna center ug 2 3 5.html

For managing devices in a wind farm network with Cisco Catalyst Center, begin by discovering the core switches of each layer (0SS and
ONSS). This section describes the discovery and onboarding of devices in the OSS network. Similar steps can be followed to discover and
manage devices in the ONSS network.

Figure 9-1 shows the workflow for discovering and onboarding devices to Cisco Catalyst Center.

Figure 9-1: Workflow for Onboarding Devices to Cisco Catalyst Center
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After devices are all onboarded, the 3400 FAN and TAN rings can be formed into REP rings by using a Cisco Catalyst Center workflow or
templates.

To onboard devices to Cisco Catalyst Center, follow these steps:

1. Choose Design > Network Hierarchy to create the site hierarchy in Cisco Catalyst Center to which Cisco 9000 and 3400 devices
are to be added.

For detailed steps and an explanation of network hierarchy, see Cisco Catalyst Center User Guide, Release 2.3.5:

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-
5/user guide/b cisco dna center ug 2 3 5/m design-the-network-hierarchy.html

The devices are segregated into different sites for easier provisioning of the devices.

Figure 9-2 shows an example of a site hierarchy for the wind farm solution. Note that, alternatively, all devices can be added under
a single site.
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Figure 9-2: Site Hierarchy in Cisco Catalyst Center
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2. Configure Cisco 9000 switches, as shown in the following examples:

Cisco 9500 SVL configuration:

hostname WEF-0SS-C9500

username dna privilege 15 password 0 Cisco@123
enable secret 0 Cl!scol23

ip domain name wf.com

|

crypto key generate rsa modulus 2048

ip ssh version 2

line vty 0 15

login local

transport input ssh

transport preferred none

!

snmp-server group default v3 priv

snmp-server group ciscogrp v3 priv read SNMPv3All write SNMPv3None
snmp-server view SNMPv3All iso included
snmp-server view SNMPv3None iso excluded
snmp-server community ciscol23 RW

snmp-server user cisco default v3 auth sha ciscol23 priv aes 128 ciscol23
!

Cisco 9300 aggregation configuration:

hostname WE-0SS-C9300Agg

ip domain name wf.com

username dna privilege 15 password 0 Cisco@123

enable secret 0 Cl!scol23

pnp startup-vlan 101

crypto key generate rsa modulus 2048

ip ssh version 2

line vty 0 15

login local

transport input ssh

transport preferred none

|

snmp-server group default v3 priv

snmp-server group ciscogrp v3 priv read SNMPv3All write SNMPv3None
snmp-server view SNMPv3All iso included

snmp-server view SNMPv3None iso excluded

snmp-server community ciscol23 RW

snmp-server user cisco default v3 auth sha ciscol23 priv aes 128 ciscol23
1

netconf-yang

Cisco 9300 access:
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hostname WE-0SS-C9300Access

ip domain name wf.com

username dna privilege 15 password 0 Cisco@123
enable secret 0 C!scol23

crypto key generate rsa modulus 2048

ip ssh version 2

line vty 0 15

login local

transport input ssh

transport preferred none

!

snmp-server group default v3 priv

snmp-server group ciscogrp v3 priv read SNMPv3All write SNMPv3None
snmp-server view SNMPv3All iso included
snmp-server view SNMPv3None iso excluded
snmp-server community ciscol23 RW

snmp-server user cisco default v3 auth sha ciscol23 priv aes 128 ciscol23
!
netconf-yang

3. Verify that all three devices can reach Cisco Catalyst Center by initiating a ping to Cisco Catalyst Center from each of the three devices.
4. Perform the following actions to initiate the discovery of core switches in the OSS network.

Similar steps can be performed to discover switches in the ONSS network.

a. From the Dashboard menu, choose Tools > Discovery

b. Click Add Discovery and choose the discovery type as IP Address Range.

c. Enterthe IP range in the management network for the devices, then click Next.

d. Complete the subsequent steps by choosing the CLI credentials, SNMPv3, and Netconf port, then click Next.

e. Choose ssh protocol, then click Next.

f.  Choose the site to which the devices are to be added, then click Next.

g. Verify the summary, then click Start Discovery.

After the discovery process completes, the discovered core switches appear in the Provision> Inventory > Topology page.

Figure 9-3: Discovered Core Switches
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FAN and TAN Ring Devices Onboarding (Day-0 Provisioning)

FAN and TAN rings consist of 3400 switches that are onboarded to Cisco Catalyst Center as separate daisy chains that are later closed to
form a ring.

As a prerequisite for onboarding the FAN and TAN rings, the intended final ring must be broken into two daisy chains to ensure that
there is only one upstream switch via which the switch is being reached by Cisco Catalyst Center for PnP. The switches are sequentially
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onboarded to Cisco Catalyst Center one by one until the entire topology onboard is complete. For selecting the linear daisy chain for
the intended final ring topology, the ring can be broken at any desired point, resulting in two daisy chains. For optimization, we
recommend that the ring be broken in the middle.

Figure 9-4 shows the workflow for onboarding FAN and TAN rings to Cisco Catalyst Center:

Figure 9-4: Workflow for Onboarding FAN and TAN Rings
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Create Day 0 Templates for 3400 Onboarding

Create a day 0 template that includes trunk and allowed VLAN configurations for interfaces of the 3400 switches that connect to
the next 3400 of the daisy chain.

Forinformation about creating templates in Cisco Catalyst Center, see Cisco Catalyst Center User Guide, Release 2.3.5:

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-
5/user guide/b cisco dna center ug 2 3 5/b cisco dna center ug 2 3 5 chapter 01000.html

The day 0 template should include the following content:

pnp startup-vlan 101
interface $interface
switchport mode trunk
switchport trunk allowed vlan 1-2507,2509-4094

Onboard the FAN Ring

1.

Connect the first 3400 switches of both daisy chains (obtained by breaking the FAN ring in the middle) to be onboarded to the 9300
aggregation per the wind farm topology.

(The two daisy chains must be connected on separate stack members of the 9300 aggregation stack to achieve full redundancy.)
Reload the 3400 switch to trigger the PnP if it has no previous configuration.

If the 3400 switch has any existing configuration, enter the following commands on the switch to remove all configurations before
starting the onboarding process:

delete /force sdflash:vlan.dat

delete /force sdflash:*.cer

delete /force sdflash:pnp*

delete /force /recursive sdflash:.installer
delete /f flash:vlan.dat

delete /f flash:config.text

delete /f flash:private config.text
delete /f /r flash:dc profile dir
delete /f flash:pnp-tech-time

delete /f flash:pnp-tech-discovery-summary
#Delete all the certificates in NVRAM
delete /f nvram:*.cer

conf t

crypto key zeroize

Yes

!

no crypto pki certificate pool

Yes

vtp mode transparent

End

write erase

Reload
no
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3. Afterthe switch reboots, PNP is triggered and the device appears under Provision > Plug and Play with a state of Unclaimed, check
the checkbox for the device and choose Actions > Claim.

4. Enterthe hostname and site to which the switch is to provisioned in the Hostname and Site fields.
5. Attach a day 0 template by clicking the attach symbol and choosing the template from the list of available templates.

The State field for the device changes from Planned to Onboarding and then to Provisioned . After the device is onboarded, the
device appears in the topology under Main menu > Provision > Inventory > Topology, as shown in figure 9-2. Nodes can be added
to this chain by connecting the new 3400 to the last onboarded 3400 switch of the daisy chain and repeating the steps 1 through 4.

Figure 9-5: Onboarding the First 3400 Switch
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After completing the previous steps, onboard the second daisy chain that was obtained from breaking the ring. To achieve redundancy,
the second daisy chain starting at 9300 aggregation must be connected to the second stack member of the 9300 aggregation switch
stack.

After onboarding the 3400 switches of both daisy chains of the ring is complete, verify the topology by choosing Provision > Inventory >
Topology. The display should resemble the example shown in Figure 9-6.
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Figure 9-6: Linear Daisy Chain Containing Five Nodes
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Connect the interfaces of the end nodes of the two daisy chains, which transforms the two daisy chains into the FAN ring. The FAN ring
topology should be as shown in Figure 9-7. You can verify the topology by choosing Provision > Inventory >Topology.

Figure 9-7: FAN Ring Obtained from Connecting the End Nodes of the two Daisy Chains
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Configure the FAN REP Ring Using the REP Workflow

The FAN ring that is configured by the previous steps runs STP by default for loop avoidance. Configure REP on this ring by using the
Cisco Catalyst Center REP workflow.

To create the FAN REP ring, follow these steps:

1.
2.

4.

From the Main Menu, choose Workflows > Configure REP Ring (Non-Fabric), then click Let’s Do it.

Choose the root device 9300-Aggregation Stack and the two adjacent 3400s (shown as BS1 and BS5 in figure 9-4) in the next tab,
then click Next.

In the Review your REP Ring discovery selections window, assign a name for the REP ring by entering it in the Ring Name field,
then click Provision.

Click Next.

When the creation process completes, the REP Ring Configuration is Successful message appears.

Note: The Cisco Catalyst Center REP workflow requires that there are no subrings within the ring to be configured with REP when you
begin the workflow. Therefore, we recommend onboarding TAN rings only after creating the FAN REP ring with this workflow.

Onboard TAN Switches

There are two TAN types used in the wind farm solution:

TAN without HA, which has a 3400 switch linearly connected to a FAN switch (identified as TAN1 in the wind farm topology in
Figure 2-1)

TAN with HA, which has 3400 switches connected in two types of rings:
o  Closed REP ring (identified as TAN2 in Figure 2-1)
o  Open REP ring (identified as TAN3 in Figure 2-1)

For more information about TANs, see Configuring TAN with High Availability and REP Subtended Ring.

To onboard a TAN without HA (TAN1), connect the 3400 switch linearly to one of the FAN ring members (represented as BS1 in Figure 2-
1) then follow Steps 2 to 4 in Onboard the FAN Ring.

To onboard TAN with HA:

TAN2 ring onboarding: Connect two 3400 switches to a FAN ring member (represented as BS4 in wind farm topology), which acts as
the edge switch for the REP closed segment. These two TAN switches are then onboarded to Cisco Catalyst Center as two separate
daisy chains in the FAN ring onboarding steps. After all member switches are onboarded as a daisy chain, the interfaces of end
switches are connected to close the ring.

TAN3 ring onboarding: First connect two TAN3 ring members to two different switches of the FAN ring (identified as BS2 and BS3 in
the wind farm topology), then follow the FAN ring onboarding steps. BS2 and BS3 act as edge switches for the REP open segment.

After all TAN switches are onboarded and rings are closed, verify the topology in Cisco Catalyst Center by choosing Provision > Inventory >
Topology. Figure 9-8 shows an example topology display.
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Figure 9-8: Cisco Catalyst Center Topology with all Devices Onboarded
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TAN REP Ring Configuration

TAN REP rings run STP for loop avoidance by default. You can configure the TAN rings with REP by using Cisco Catalyst Center templates.
Figure 9-9 shows the workflow for configuring TAN open and closed REP rings using Cisco Catalyst Center templates.

Figure 9-9: Workflow for Configuring TAN Open and Closed REP Rings

Provision the
template on
TAN3
members one

Assocnatg Shubians ik Provision the
template with in the TAN2 template on
Network Profile g ; TAN2
: . d associate MHEL Vel members one
associate it ar?t it intermittent b d
with 3400 i sie loops during Vol
which contains REP then open

TAN ring the previously

members shut link

Shut one
of the links
in the TAN3

ring to
avoid loops

Create
Template and

by one and
then open
the previously
shut link

switches
configuration

388449

1. Perform the following actions to create a template in Cisco Catalyst Center to configure REP in the TAN rings.

Cisco Catalyst Center templates can be used to configure REP in the TAN rings. This section covers only the configuration to be
written inside the Template for configuring REP on the TAN rings. For more detailed information about creating templates in Cisco
Catalyst Center see “Create Templates to Automate Device Configuration Changes” in Cisco Catalyst Center User Guide, Release
2.3.5:

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-
5/user guide/b cisco dna center ug 2 3 5/b cisco dna center ug 2 3 5 chapter 01000.html

a. Fromthe Main menu, choose Tools > Template Hub > + > Add -> New Template.
b. Enterthe Template name as RepRingCreation and associate it with a project.

c.  Configure additional fields as shown in Figure 9-10, then click Continue.
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Figure 9-10: Creating Template for Configuring REP on TAN Ring
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d. Enterthe contents of the template as follows:

#if (Sapply rep == 1)

vlan Srep admin vlan

exit

rep admin vlan $rep admin vlan

#if (Sisedge == 1)

interface $int first

rep segment $segment edge

rep stcn segment $mainRingSegId
no shut

interface $int second

rep segment $segment edge

rep stcn segment $mainRingSegId
no shut

#else

interface range $int first , $int second
rep segment S$segment

no shut

#end

#else

interface $int first

no rep segment $segment

interface $int second
no rep segment $segment

#end
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2. Associate the template to a network profile by clicking Attach to Network Profile in the Template window.
3. Choose the network profile, click Save, then click commit.

4.  Associate this network profile with the Cisco Catalyst IE3400 Rugged Series device type by choosing Design > Network Profiles >
Edit.

5. Choose the site for the TAN ring in Design> Network Profiles> Site.
The template is ready to be provisioned.

Before applying REP templates on TAN switches, shut one of the links in the TAN ring to avoid any intermittent loop formation
during REP configuration.

The link can be shut either by creating a Cisco Catalyst Center template or by issuing a shutdown command for the interface on the
switches cli. For TAN2, shut the link between BS4 and NS2 in the wind farm topology.

The following Cisco Catalyst Center template can be created for shutting or unshutting an interface:

#if (Sshut == 1)
finterface $int first
shutdown

#else

interface $int first
no shut

6. Apply the REP configuration template on TAN2 switches one by one, starting with the farthest switch that is reachable from Cisco
Catalyst Center.

Provision the REP template on the TAN2 switches in the following sequence:

NS2 - NS1 - BS4

To provision the REP configuration template:

a. From the Main menu, choose Provision > Inventory.

b. Checkthe checkbox next to TAN2 switch under the configuration (NS2/NS1/BS4).

c.  Fromthe Actions drop down menu, choose Provision > Provision Device, then click Next.
d. Ub the Devices window, choose the device to be provisioned.

e. Enterthe values for templates variables as shown in Table 9-1, click Next, then click Next in the next page that appears.

Table 9-1: TAN2 REP Configuration Template Variables

Variable Name (VL) Value

apply_rep To apply or remove rep configuration 1/0

rep_admin_vlan REP admin VLAN VLAN ID to be used as REP admin VLAN

isedge Edge port or non edge port (1 for edge port Enter 1 for BS4 (because the edge port
and 0O for non edge ports) is configured on BS4) and 0 for NS2

/NS1 (because the non-edge ports are
configured on NS2/NS1 of the TAN2

ring)
int_first Firstinterface ID of device that is a part of the Interface ID used in TAN ring formation
TAN ring
segment TAN REP ring segment ID Segment ID of choice (segmentID 2 is
used in the wind farm topology for
TAN2 as an example)
mainRingSegld FAN REP ring segment 1 Segment ID used in REP configuration

of FAN ring (segment ID 1 is used in the
wind farm topology for FAN ring as an
example)
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int_second

Second interface ID of the device that is a part
of the TAN ring.

Second interface of the device used in
TAN ring formation

f.  Inthe Provision Device window, click Apply.

g. Inthe Preview Configuration-Provision Device window, verify the configuration preview that is generated by Cisco

Catalyst Center, then click Deploy.

7. Repeat Step 3 to 6 for TAN3 REP ring creation by first shutting the link between BS3 and NS2 of the TAN3 ring of the wind farm
topology and then provisioning the REP template in the sequence NS2 - NS1 - BS2 - BS3.

See Table 9-2 for values of the template variables for TAN3 to be entered.

Table 9-2: TAN3 REP Configuration Template Variables

Variable Name

apply_rep

Use

To apply or remove rep configuration.

Value

1/0 (1 to apply REP, 0 to remove REP
configuration).

rep_admin_vlan

REP admin VLAN.

VLAN ID to be used as REP admin VLAN.

isedge Edge port or non edge port. (1 for edge Enter 1 for BS2 and BS3 and 0 for NS1 and
port and O for non edge port.) NS2.

int_first Firstinterface ID of the device that is a part Interface ID used in TAN ring formation.
of the TAN ring.

segment TAN REP ring segment ID. Segment ID of choice (segment ID 2 is

used in the wind farm topology for TAN2
as an example).

mainRingSegld

FAN REP ring segment ID.

Segment ID used in REP configuration of
FAN ring (segment IS 1 is used in the wind
farm topology for FAN ring as an
example).

int_second

Second interface ID of the device thatisa
part of the TAN ring.

Second interface of the device used in
TAN ring formation. Leave this field blank
for switches BS2 and BS3 because only
one interface of these switches is a
member of the TAN3 ring.

Day N Configurations using Cisco Catalyst Center Templates

Configuration updates can be made on wind farm devices by using Cisco Catalyst Center templates. Templates can be created on Cisco
Catalyst Center with configurations to add VRFs, add VLANSs, create port-channels, and so on.

For more information about content to add for various configurations, see Appendix B: Cisco Catalyst Center Day N Templates.

Adding a New Switch to a FAN REP Ring

A new switch can be added to an existing FAN REP ring that has been created in Cisco Catalyst Center. To do so, follow these steps:

1. Verify that the interfaces to which the new switch is going to be connected has a REP segment ID configured and ZTP enabled by
entering the command show run interface interface-id on the switch console.

2. Connect the new switch between the two existing 3400 switches using the same physical connection that was used between the

existing 3400 switches.
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3. Onboard the new switch by triggering PnP and ensuring that no previous configuration exists on the newly added switch.
See the onboarding steps in FAN and TAN Ring Devices Onboarding (Day-0 Provisioning).
Ensure that you add this new switch in the same Cisco Catalyst Center site as the FAN switches.

4. Click the REP rings tab and verify that the switch has been added to the REP ring automatically.

Network Assurance

Cisco Catalyst Center Assurance is used in the wind farm solution to provide a detailed view of the network. It monitors power
consumption and the status of connected clients and provides network related insights.

For more information about Cisco Catalyst Center Assurance and information about enabling it, see Cisco DNA Assurance User
Guide, Release 2.3.5:

https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center-assurance/2-
3-5/b cisco dna assurance 2 3 5 ug.html
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Chapter 10 Implementing Network Security
and QoS

This chapter includes the following topics:
= Implementing Network Security
=  Implementing QoS

=  Implementing Multicast Traffic Support in an Offshore Substation

Implementing Network Security

Configuring Firepower Zones and Policies for OPC-UA

For information about configuring zones and policies on Firepower, see Configuring Firepower for Wind Farm Solution Use Cases.

Configuring Cisco Cyber Vision Sensors on TAN and FAN Ring

There are two types of Cyber Vision sensors: hardware and network. The hardware sensor is the Cyber Vision 10x application that is installed
on a Cisco Industrial Compute Gateway 3000 (IC3000). The network sensor is the Cyber Vision I10x application that is installed on supported
switches and routers. In the wind farm solution, only network sensors on |E switches are used, as described in the design.

There are three ways to install network sensors: using the switch CLI, using the switch web interface, and using Cyber Vision Center Extension.
This document discusses the network sensor installation using Cyber Vision Center Extension. For additional information, see Cisco Cyber
Vision Network Sensor Installation Guide for Cisco I1E3300 10G, Cisco IE3400 and Cisco Catalyst 9300, Release 4.1.0:

https://www.cisco.com/c/en/us/td/docs/security/cyber vision/publications/IE3400/b Cisco Cyber Vision Network Sensor Installation Gui
de for Cisco IE3300 10G Cisco IE3400 and Cisco Catalyst 9300.html

Before installing sensors, perform the following actions on the IE switches in the FAN and TAN:
1. Ensure network reachability between the Cyber Vision Center and the IE switches in the FAN and TAN.

A separate collection network VLAN is configured in the Management_VRF for sensors on IE switches by using switch CLLs or Cisco
Catalyst Center day N templates.

2.  Ensurethat IE switches in the FAN and TAN are configured with the collection network VLAN.
On a FAN ring IE3400 switch, VLAN 102 is configured for Cyber Vision sensors as shown in the following example:
FAN-IE3400-BS1# show vlan

VLAN Name Status Ports
1 default active Gil/3, Gil/4, Gil/5, Gil/e, Gil/7, Gil/s8,
Gil1l/9

Gil/10, Apl/1l, Gi2/1, Gi2/2, Gi2/3,
Gi2/4, Gi2/5
Giz2/e6, Gi2/7, Gi2/8

101 VLANO0101 active

102 CV_Sensor active
1002 fddi-default act/unsup
<snipped>

3. Configure an SVl in the collection network VLAN on the IE switch where the sensor is to be installed.
An example SVI configuration on the collection VLAN in IE3400 switch is:
FAN-IE3400-BS1# show run interface Vlan 102
!

interface Vl1anl02
ip address 10.10.102.114 255.255.255.0
end
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4.  Verify that the IE switch can reach the CVC collection interface IP address at the OSS Infrastructure network in the CCl headquarters
site.

To do so, on the IE switch in FAN, ping the CVC collection network interface. For example:
FAN-IE3400-BS1# ping 10.10.100.30 source vlan 102

Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 10.10.100.30, timeout is 2 seconds:
Packet sent with a source address of 10.10.102.100

Success rate is 100 percent (5/5), round-trip min/avg/max = 1/1/4 ms

Note: The IP address 10.10.100.30 in this example is the IP address of the Cyber Vision Center collection network interface that is
configured during the installation of CVC local in the OSS infrastructure. Also note that the CVC needs the appropriate network
route and gateway configurations to ensure network connectivity to the sensor network on IE switches.

A successful ping ensures network connectivity between the CVC (for example, the 10.10. 100.x subnet in the OSS infrastructure
network) and IE switches (10.10.102.x collection network for sensors).

The following items must be configured on a switch before a Cyber Vision sensor is installed on it:
= SSH
=  |Oxand storage formatting
= Data export using encapsulated remote switched port analyzer (ERSPAN)
. Ports
Use the following IP address schema to bring up the CVS application on an IE3400 or IE3300 10G and integrate it to the CVC.
CVC:
Admin interface (eth0): 10.104.206.225
Collection interface (eth1): 10.10.100.30
Collection network gateway: 10.10.100.1
NTP: 10.10.100.1
FAN IE3400 base switch:
Admin IP address: 10.10.102.100
Subnet mask: 255.255.255.0
Management port: 443
Admin username: admin
Admin password: sentryo69!
CVS:
Capture IP address: 169.254.1.2
Capture subnet mask: 30
Capture VLAN number: 2508
Collection IP address: 10.10.112.101
Collection subnet mask: 24
Collection gateway: 10.10.112.100
Collection VLAN number: 102

Prerequisite for the sensor application installation on the IE3400 are the following. Configure these items by using an SSH client or
the console port.

= Configure access to SSH
=  Configure basic parameters

The following steps show the configuration that is needed on IE3400 switches for the sensor installation to then register it with the
CVC:
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1. Formatsdflash and enable 10x on the IE switch by using the following CLI commands:
FAN-IE3400-BS1# format sdflash: ext4
FAN-IE3400-BS1# show sdflash: filesys
Filesystem: sdflash
Filesystem Path: /flash11
Filesystem Type: ext4
Mounted: Read/Write
FAN-IE3400-BS1# configure terminal
FAN-IE3400-BS1#(config)# iox
FAN-IE3400-BS1#(config)# end
FAN-IE3400-BS1# show iox

IOx Infrastructure Summary:

I0x service (CAF) : Running
I0Ox service (HA) : Not Supported
IOx service (IOxman) : Running
IOx service (Sec storage) :  Running
Libvirtd 5.5.0 : Running
Dockerd v19.03.13-ce : Running

2. Usethe following commands to configure a VLAN for traffic mirroring.

This configuration ensures that the AppGigabitEthernet port for communications can reach the I0x virtual application so that traffic
can be received inside an 10x application.

configure terminal
vtp mode off
vlan 2508
remote-span
end
|
interface AppGigabitEthernet 1/1
switchport mode trunk
exit
|
3. Exclude Capture VLAN 2508 on all trunk interfaces in the IE3400 switch, except the AppGigabitEthernet 1/1 interface:
interface GigabitEthernet1/1
switchport trunk allowed vlan 1-2507,2509-4094
switchport mode trunk
end
4. Configure the SPAN session and add to the session the interfaces to monitor:
monitor session 1 source interface Gil/3 - 5, Gi1/7 - 10
monitor session 1 destination remote vlian 2508
monitor session 1 destination format-erspan 169.254.1.2
Note: The source of the monitor session in this configuration is a range of access ports for endpoints to be monitored.
5.  Save the configuration:

wr mem
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For more information, see “Initial Configuration” section in Cisco Cyber Vision Network Sensor Installation Guide for Cisco IE3300
10G, Cisco IE3400 and Cisco Catalyst 9300:

https://www.cisco.com/c/en/us/td/docs/security/cyber_vision/publications/IE3400/b Cisco Cyber Vision Network Sensor_Instal
lation Guide for Cisco 1E3300 10G Cisco 1E3400 and Cisco Catalyst 9300/m Installation procedures IE3400 Catalyst 9300 v
3 4 0 0.html#topic 5146

6. Perform the steps in the “Procedure with the Cyber Vision sensor management extension” section in Cisco Cyber Vision Network
Sensor Installation Guide for Cisco IE3300 10G, Cisco I1E3400 and Cisco Catalyst 9300, Release 4.1.0:

https://www.cisco.com/c/en/us/td/docs/security/cyber vision/publications/IE3400/b Cisco Cyber Vision Network Sensor Instal
lation Guide for Cisco 1E3300 10G Cisco 1E3400 and Cisco Catalyst 9300/m Installation procedures IE3400 Catalyst 9300 v
3 4 0 0.html#topic 5701

OT Flow detection using Cyber Vision Sensors

After the Cyber Vision sensor is running on the FAN IE switch, you can view the data that is collected from the sensor on the CVC
Dashboard. For example, a SCADA IED device that is connected to a FAN ring base switch sends MODBUS IP traffic to a SCADA FEP server
in the OSS infrastructure. This OT flow can be detected by a sensor monitoring the IED port traffic on the IE switch.

To see sensor data, follow these steps:

1. Onthe CVC Dashboard, choose Explore - All data.
2.  Click Activity List.

3. Click a flow in the list to see more about the flow.

Figure 10-1 shows an OT flow device in the CVC Dashboard.

Figure 10-1: CVC Dashboard View of Activities
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Activities in CVC Dashboard are the communication flows between components. From the Activities button on the Preset Dashboard,
you can view these communications based on the time reference selected.
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Figure 10-2: CVC Dashboard view of OT Flow Details
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The traffic flows that are detected by Cyber Vision sensors are displayed in CVC Dashboard, which you access by choosing Explore > All
data > Activity list.

For more information about MODBUS and DNP3 OT assets visibility, see “OT Asset Visibility” in Grid Security Implementation Guide:

https://www.cisco.com/c/en/us/td/docs/solutions/Verticals/Distributed-Automation/Grid _Security/IG/DA-GS-IG/DA-GS-IG.html#pgfld-
482904

Configuring Stealthwatch (SNA) NetFlow

In a wind farm network, NetFlow is enabled on Cisco IE switches (IE3400) in the TAN and FAN to monitor network traffic flows. NetFlow
can also be enabled on the nacelle and base switches by using the Cisco Catalyst Center day N template feature.

The Cisco IE 3400 switch supports full Flexible NetFlow. The NetFlow feature is an embedded instrumentation within the Cisco 10S-XE
software stack to help characterize network flows. It provides visibility into the traffic that flows through a switch or router. Enabling
NetFlow provides a trace of every traffic flow in the network without the need for SPAN ports.

All packets with the same source and destination IP addresses, source and destination ports, protocol interface, and class of service are
grouped into a flow, and packets and bytes are then tallied and stored in the NetFlow cache. The cache can be exported to a system
such as Cisco Stealthwatch, where deeper analysis of the data can be performed to identify threats or malware.

NeFlow Configuration on an IE3400

ip flow-export destination fc_ip fc_port

##Configure the Flow Record##
flow record fnf-rec

match ipv4 tosmatch ipv4 protocol
match ipv4 source address

match ipv4 destination address
match transport source-port

match transport destination-port
collect counter bytes long
collect counter packets long
##collect timestamp absolute first
##collect timestamp absolute last
exit

##Configure the Exporter##
flow exporter fnf-exp
destination fc ip
transport udp fc port
template data timeout 30
option interface-table
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option application-table timeout 10
exit
##Configure the Flow Monitor##
flow monitor fnf-mon
exporter fnf-exp
cache timeout active 60
record fnf-rec
exit
##Apply to an interface##
interface Swired interface
ip flow monitor fnf-mon input

Verification of Traffic Flow Monitoring

You can verify the traffic flow monitoring on the SMC dashboard. Figure 10-3 shows an example host report for traffic.

Figure 10-3: Stealthwatch Management Console Dashboard Host Report
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Integrating Stealthwatch with Identity Services Engine

The Cisco Stealthwatch Management Center (SMC) can be integrated with the Cisco Identity Services Engine (ISE) using pxGrid. When
integrated with ISE, the SMC learns user session information (IP address, username bindings), static Trustsec mappings, and adaptive
network control (ANC) mitigation actions for quarantining endpoints.

To integrate Cisco Stealthwatch with ISE, see Cisco Secure Network Analytics ISE and ISE-PIC Configuration Guide 7.4.2:
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/ISE/7 4 2 ISE Configuration Guide DV 1 0.pdf

Implementing QoS
OSS QoS Configuration for OSS C9300 and C9500 Switches

To configure QoS for C9300 and C9500 switches in the 0SS, perform the following steps. Operational technology traffic is matched
based on access lists. Other incoming traffic is matched based on DSCP markings.

1. Create an access list to match incoming OT traffic.

2. Create an input class map to match OT traffic based on an ACL and to match other traffic types based on DSCP values.
3. Create an input policy map to set the DSCP values.

4. Allocate bandwidth to different traffic types in the output policy map so that voice traffic is sent in a priority queue.

5

Assign the input and output policy map to the switch.
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0SS QoS Configuration for the OSS C3400 Switches

1.

2
3
4.
5

Create an access list to match incoming OT traffic.

Create an input class map to match OT traffic based on an ACL and to match other traffic types based on DSCP values.
Create an input policy map to set the DSCP values.

Allocate bandwidth to different traffic types in the output policy map so that voice traffic is sent in a priority queue.

Assign the input and output policy map to the switch.

Implementing Multicast Traffic Support in an Offshore Substation

This section describes how to enable support for multicast traffic in an OSS. To enable multicast communication in the wind farm
topology between devices across Firepower, configure the 9500-SVL as a rendezvous point for multicast and enable IGMP on Firepower.

Figure 10-4 shows the workflow for enabling multicast.

Figure 10-4: Workflow for Enabling Multicast
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To configure devices in the OSS network to enable multicast:

1.

Configure the 9500-SVL for multicast.
Enter the following commands on the 9500 SVL switch CLI to enable multicast on the switch:

ip multicast-routing vrf Management VRF

ip pim rp-address 10.10.100.1

ip pim vrf Management VRF rp-address 10.10.100.1

ip route vrf Management VRF 10.10.106.0 255.255.255.0 10.10.100.3

interface V1anl00
ip pim sparse-mode
Allow multicast through Firepower.

Because Firepower does not allow multicast traffic through it, configure an access policy to allow it. For more information about
multicast configuration in Firepower, see “Multicast Routing for Firepower Threat Defense” in Firepower Management Center
Configuration Guide, Version 6.1:

https://www.cisco.com/c/en/us/td/docs/security/firepower/610/configuration/guide/fpmc-config-guide-
v61/multicast routing for firepower threat defense.html

Configure an access control or prefilter rule on the inbound security zone to allow traffic to the multicast host.

Note: You cannot specify a destination security zone for the rule.
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Figure 10-5: Permitting Multicast in an Access Policy
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Figure 10-6 shows how an added policy appears.

Figure 10-6: Access Policy with Multicast Traffic Allowed
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4. Click Save.

5. Perform the following actions to enable IGMP on Firepower:
a. From the Main menu, choose Routing > Multicast Routing > IGMP.

b. Checkthe checkbox for enabling multicast routing as shown in figure 10-7.
Figure 10-7: Enabling Multicast

Enable Multicast Routing (Enabling Multicast Routing checkbox will enable both IGMP and PIM on all Interfaces.)

Protocol Access Group Static Group Join Group

+ Add

c.  Configure IGMP protocol by clicking + Add at the top right of the page and add the IGMP parameters as shown in figure 10-5,
then click OK.
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Figure 10-8: Configuring IGMP

Edit IGMP parameters (7]

Interface:*
| OPC_UA_Serverintf v

Enable IGMP:

Forward Interface:

| OPC_Client_Int v |
Version:

2 a
Qlﬁry Interval:

Response Time:
Group Limit;

Query Timeout:

| )

d. Click Save, then click Deploy in the Main menu.
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Turbine Operator Network Implementation

Chapter 11 Turbine Operator Network
Implementation

Turbine operator Scada network is parallel network built and operated by Turbine manufacturer. For more
details on Turbine operator network refer to the design guide Design Guide Cisco Solution for Renewable
Energy: Offshore Wind Farm 1.1 at the following link:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/WF _1-1_DG.pdf

This network implementation is broken into flow as shown in the diagram below:

Figure 11-1 Network implementation flow for Turbine operator Scada

Core network WAN Edge FSN ring TSN rings

implementation configuration configuration configuration

388995

Turbine Operator Core Network Implementation

Cisco Catalyst 9300 switches are used as core switches along with Cisco Industrial Ethernet 9300 in a ring topology.
For redundancy, HSRP is configured between the 9300s. These switches are Active-Standby pair and in the event of
failure of the Active Catalyst 9300, the standby takes over and provides connectivity to the WAN. Refer to the

section Turbine Operator Network Design in the design guide for more details.

The configuration steps of core switches are shown in Figure 11-2 below:

103


https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/WF_1-1_DG.pdf

Cisco Offshore Wind Farm Solution 1.2 Implementation Guide

Figure 11-2 Configuration sequence for Core network devices
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1.  Complete physical cabling of the devices as per the topology in Figure 11.3 and connect C9300s in stacking
configuration:
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Figure 11-3 substation core network topology
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Verify switch stacks on the C9300s
C9300-L5G8#sh switch

Switch/Stack Mac Address : 9c09.8b7d.3b00 - Local Mac Address
————————— some output has been omitted----

Switch# Role Mac Address Priority Version State
*1 Active 9c09.8b7d.3b00 1 V09 Ready
2 Standby dc77.4c9%a.2a00 1 V03 Ready

2.  Complete hostname, NTP and domain configuration on all core switches. Following is an example configuration for the same :
hostname <device hostname>
ntp server <server-ip>

ip domain name <domain name>

3.  Configure VTP on C9300s

C9300-1:

vtp domain WF1l.2.cisco.com
Vtp version 3

Vtp mode server

Exit

Vtp primary vlan
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C9300-2:

vtp domain WF1l.2.cisco.com
Vtp version 3

Vtp mode server

4. Configuring SVIs on C9300s

C9300-1

vlan 5
!
interface Vlan5

ip address 10.5.1.2 255.255.0.0

vlan 10
!
interface V1anlO
ip address 10.10.1.2 255.255.255.0
!
Vlan 20
interface Vl1an20

ip address 10.20.1.2 255.255.0.0

|
Vlan 111

interface Vlanlll

ip address 10.111.1.2 255.255.255.0

C9300-2:

vlan 5
!
interface Vlanb
ip address 10.5.1.3 255.255.0.0
|

vlan 10

interface V1anlO
ip address 10.10.1.3 255.255.255.0
!
Vlan 20
interface Vl1an20
ip address 10.20.1.3 255.255.0.0
!
Vlan 111

interface Vlanlll
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ip address 10.111.1.3 255.255.255.0

5.  Configuring HSRP

Configure HSRP under the SVIs created in the preceding step as shown in the configs below:

C9300-1:

interface Vlanb

standby 5 ip 10.5.1.1

|
interface Vlanl0

standby 1 ip 10.10.1.1

1
interface Vl1an20

standby 20 ip 10.20.1.1

1
interface Vlanlll

standby 111 ip 10.111.1.1

|

Repeat the same on C9300-2

Verify the HSRP config by issuing the following command on either or both the switches:
SCADA-C9300-1 #show standby brief

P indicates configured to preempt.

Interface Grp Pri P State Active Standby Virtual IP
V15 5 100 Standby 10.5.1.3 local 10.5.1.1
V110 1 105 Active local 10.10.1.3 10.10.1.1
V120 20 100 Standby 10.20.1.3 local 10.20.1.1
V1111 111 100 Active local 10.111.1.3 10.111.1.1

The HSRP Virtual IP will be used default gateway for the respective vlans

6. Configuring IE9Ks
IE9K-1:

vtp domain WF1l.2.cisco.com

Vtp version 3

Vtp mode client

interface Vlanlll

ip address 10.111.1.4 255.255.255.0
ip route 0.0.0.0 0.0.0.0 10.111.1.1

IE 9K-2:
vtp domain WF1l.2.cisco.com
Vtp version 3

Vtp mode client
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interface Vlanlll

ip address 10.111.1.5 255.255.255.0
ip route 0.0.0.0 0.0.0.0 10.111.1.1

7. Configuring MACsec

To configure MACsec refer to the section Configuring MACSec in this document.
8. Bringing up port-channel between the two core C9300 and configuring it as trunk port

Configure the two links between the C9300 switches as port-channels as shown below:
C9300-1:

interface TenGigabitEthernetl/0/22

channel-group 1 mode active

interface TenGigabitEthernetl/0/24
channel-group 1 mode active
interface Port-channell

switchport mode trunk
Repeat the same on C9300-2

Verify the port-channel using the command: show etherchannel summary

9. Configuring REP ring

REP ring configuration can be started from either of the C9300s and completing it in a clockwise or counter-
clockwise direction.

C9300-1:
interface TenGigabitEthernet1/1/1 switchport mode trunk

rep segment 1 edge
IE9k-1:

interface TenGigabitEthernet1/0/27 switchport mode trunk
rep segment 1

!

interface TenGigabitEthernet1/0/28 switchport mode trunk

rep segment 1

IE9k-2:
interface TenGigabitEthernet1/0/27 switchport mode trunk
rep segment 1
!
interface TenGigabitEthernet1/0/28 switchport mode trunk

rep segment 1

C9300-2:

interface TenGigabitEthernet1/1/1 switchport mode trunk
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rep segment 1 edge

This will bring up REP ring which can be verified by issuing show rep topology in any of the four switches.

show rep topology

REP Segment 1

BridgeName PortName Edge Role
SCADA-C9300-1-Y819 Tel/1/1 Pri Open
WF-SCADA-IE9320-1 Tel/0/27 Open
WF-SCADA-IE9320-1 Tel/0/28 Open
WF-SCADA-IE9320-2 Tel/0/28 Open
WF-SCADA-IE9320-2 Tel/0/27 Open
WE-SCADA-C9300-2-Y2WQ Tel/1/1 Sec Alt

Configuring WAN Edge Routing

For configuring WAN Edge routing , OSPF is configured on the Firewall facing interface of C9300s and on the
Firepower .The workflow in Figure 11-4 is the sequence of configuration :
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Figure 11-4 WAN Edge routing configuration
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1. Configuring routing on C9300s

Apply the following configuration on both C9300s to enable routing:

router ospf 1

network 10.0.0.0 0.0.255.255 area 0
2. Configuring routing on the Firepower

For configuring Firepower with routing refer to section “Configure the OSPFv2 Process and Areas "of the Firepower
configuration guide at the following link:

https://www.cisco.com/c/en/us/td/docs/security/firepower/70/fdm/fptd-fdm-config-guide-700/fptd-fdm-ospf.html

3.  Allowing ports in the Firepower to enable communication
The ports to be allowed for OPC-UA communication are: 4840, 5020

Add these ports by following the steps listed in the section Configuring Firepower for Wind Farm Solution Use Cases in this
guide and deploy the changes.

This completes WAN edge routing.

Configuring FSN Ring

In the turbine operator network, the IE3400 and/or IE3100 Series switches as the base SCADA switch from each wind turbine
is connected in a ring topology using a 1G fiber cable with Cisco Industrial Ethernet 9300 switches to form a farm area SCADA
network (FSN) ring. A REP is configured in the FSN ring to provide FAN resiliency for faster network convergence if a REP

segment fails. For understanding more on FSN design refer to Cisco Solution for Renewable Energy: Offshore Wind Farm 1.1 Design
Guide:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind _Farm/WF 1-1 DG.pdf?dtid=odicdc000509

section Farm Area SCADA Network (FSN) Design.
Figure 11-5 is the sequence of steps to bring up the FSN ring :

Figure 11-5 Workflow for FSN ring configuration
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all devices

gateway
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1. Complete physical cabling
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Connect the devices to the IE9K of the core REP ring as shown in Figure 11-6.

Figure 11-6 FSN ring connection
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2. Complete hostname, NTP, and domain configuration on all switches .Following is an example configuration for the same :
hostname <device_hostname> ntp server <server-ip>

ip domain name <domain_name>
3. Configure vlan, IP, and default gateway

Configure the vlans, management vlan interface and gateway on all switches of the FSN ring using the config below:

vtp domain WF1.2.cisco.com
Vtp version 3

Vtp mode client

Interface vlan 111

Ip address <ip_address>

4. Configure MACsec

To configure MACsec refer to the section Configuring MACSec in this document.
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5. Configuring REP on FSN ring

FSN ring is configured with open REP segment configuration. The edge port for this REP segment will be configured on the two
IE9Ks.We will begin configuring REP from the left IE9K (referred to as IE9K-1 in the config) and proceed with device configuration
in an anti clockwise direction.

Following is the configuration on each of the devices of the FSN ring:

[E9K-1:

interface TenGigabitEthernetl1/0/25
switchport mode trunk

rep segment 100 edge
Base Scada Switchl:

Int range gi 1/1-2
switchport mode trunk

rep segment 100

[E9K-2:

interface TenGigabitEthernetl/0/25
switchport mode trunk

rep segment 100 edge

This completes the REP configuration on the FSN ring. Verify the REP topology by issuing show rep on any of the switches above:

WEF-SCADA-FSN-3400-Y1FB#sh rep topo
REP Segment 100

BridgeName PortName Edge Role
WF-SCADA-IE9320-1 Tel/0/25 Pri Open
WEF-SCADA-FSN-3400-Y1FB Gil/2 Open
WF-SCADA-FSN-3400-Y1FB Gil/1 Open
3400-P48G Gil/1 Open
3400-P48G Gil/2 Open
WEF-SCADA-FSNO03-VONS Gil/2 Open
WF-SCADA-FSN03-VONS Gil/1 Open
WF-SCADA-FSN04-Y2BT Gil/2 Open
WF-SCADA-FSN04-Y2BT Gil/1 Open
WF-SCADA-FSN05-V0SZ Gil/2 Open
WEF-SCADA-FSN05-V0SZ Gil/1 Open
WEF-SCADA-IE9320-2 Tel/0/25 Sec Alt

Configuring TSN Rings

In offshore wind farms, each wind turbine has a Cisco IE3400 switch deployed at the turbine nacelle for turbine operator network
connectivity to various SCADA endpoints in the turbine operator network. For details on it, refer to the section Turbine SCADA
Network (TSN) Design of the design guide Cisco Solution for Renewable Energy: Offshore Wind Farm 1.1 Design Guide.

There are two types of TSN rings in the turbine operator network, and both is described below.
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TSN non-HA

The following diagram shows the sequence to configure TSN non-HA

Figure 11-7 Workflow for TSN non-HA configuration
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1 Complete physical cabling.

Physical cabling of switch to a Base Scada Switch is done with two links for redundancy as shown in diagram below.

Figure 11-8 TSN non HA topology connection
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2 Complete hostname, NTP, and domain configuration on all switches. Following is an example configuration for the same.
hostname<device_hostname> ntp server <server-ip>

ip domain name <domain_name>

3  Configure MACsec.

To configure MACsec refer to the section Configuring MACSec in this document.
4  Configure port-channel.
The two links going to Base Scada Switch are configured as port-channel shown in config below.

SCADA Switch:

interface range GigabitEthernetl/1-2
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channel-group 1 mode active

Base SCADA Switch:

interface range GigabitEthernetl/3-4
channel-group 1 mode active
end

5 Complete vlan, interface, and layer 2 configs:

Configure the switches as follows:

SCADA swtich:

vtp domain WF1l.2.cisco.com
Vtp version 3

Vtp mode client

interface vlan 111

ip address <ip_ address> int port-channel 1 switchport mode trunk

Base SCADA Switch:

int port-channel 1

switchport mode trunk

This completes the configuration of TSN non-HA.

Configuring TSN HA:

Figure 11-9 describes the sequence for TSN HA configuration:

Figure 11-9 Workflow for configuring TSN HA
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Completing physical cabling

Physical cabling of switches to a Base Scada Switch forms a closed ring as shown in Figure 11-10.
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Turbine Operator Network Implementation

Figure 11-10 TSN HA topology connection
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Complete hostname, NTP and domain configuration on all switches. Following is an example configuration for the same:
hostname <device hostname>
ntp server <server-ip>

ip domain name <domain name>

Configure vlan and interface

vtp domain WF1l.2.cisco.com
Vtp version 3

Vtp mode client

interface vlan 111

ip address <ip address>

Configure MACsec

To configure MACsec refer to the section Configuring MACSec in this document.
Configure REP segment.

A closed REP segment is configured with edge ports on Base Scada switch. Following are configurations for the devices of the TSN HA
ring.
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Base SCADA Switch:

interface GigabitEthernetl/3
switchport mode trunk

rep segment 101 edge
!

interface GigabitEthernetl/4
switchport mode trunk

rep segment 101 edge
Nacelle Switch1:

interface GigabitEthernetl/4
switchport mode trunk

rep segment 101

!

interface GigabitEthernetl/1
switchport mode trunk

rep segment 101
Nacelle Switch2:

interface GigabitEthernetl/2
switchport mode trunk

rep segment 101

interface GigabitEthernetl/3
switchport mode trunk

rep segment 101

Verify the REP topology by issuing show rep topologyin any of the above switches of TSN HA ring.

Sh rep topology
REP Segment 101

BridgeName PortName Edge Role
3400-P48G Gil/4 Pri Open
SCADA-TSN-Y0ZJNAcelleSwl Gil/4 Open
SCADA-TSN-Y0ZJNAcelleSwl Gil/1 Open
WF-SCADA-TSN-Y1SL Gil/2 Open
WEF-SCADA-TSN-Y1SL Gil/3 Open
3400-P48G Gil/3 Sec Alt

This completes TSN HA ring configuration.

Implementing Multi-level advanced REP rings configuration across Cabinets
Turbine operator network with core REP rings and FSN REP rings across cabinets of different OSS locations along with TSN REP rings in
turbine forms a multi-level REP ring (Ring of rings) from core network to the turbine nacelle SCADA network. Each C9300 stack becomes
a part of two core REP segment from which further REP segments consisting of 3400 switches is configured as shown in figure below.
For details regarding the ring design refer to the section “Multi-level advanced REP rings design across Cabinets " of the Design guide at
the following link:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind _Farm/Wind-Farm 1-2 Design Guide.pdf

Complete the cabling as in Figure 11-11 and repeat the configuration for core, FSN, and TSN ring configurations for each set.
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Figure 11-11 Turbine Operator Network Multi-level REP rings design across cabinets
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Implementing co-located MRP ring in FSN

389133

FSN can have MRP ring co-located with REP aggregated at IE9320. IE9320 serves as MRM while the two 3400s are MRC which acts the
client nodes of the MRP ring.

For details regarding the ring design refer to the section “Media Redundancy Protocol (MRP) Ring design for FSN"

of the Design guide at the following link:

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind _Farm/Wind-Farm 1-2 Design Guide.pdf
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Figure 11-12 Co-located MRP ring in the Turbine Operator Network
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Figure 11-13 shows the configuration of MRP ring in FSN.

Figure 11-13 TSN MRP ring configuration

Complete Configure
physical IE9320 as

Configure
both 3400 as Verify MRP ring

MRP clients

cabling MRP manager

For details on MRP configuration refer to the link below:

https://www.cisco.com/c/en/us/td/docs/switches/lan/cisco_ie3X00/software/17_4/b_redundancy_17-
4_jot_switch_cg/m_mrp_iosxe_iotswitch_17_4.html_

1. Complete the cabling of 3400 switches as shown in figure 11-11
2. Configuring IE9320 as MRP manager
Following is the set of cli to configure IE9320 as the MRM for the MRP ring:

no profinet mrp
mrp ring 1

mode auto-manager

domain-id FFFFFFFF-FFFF-FFFF-
FFFF-FFFFFFFFFFFE
118
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vlan-id 100

Configure MRP on member
interfaces:

interface range
GigabitEthernetl/0/23-24

switchport mode trunk

mrp ring 1

3. Configuring 3400s as MRP client
Following is the set of cli to enable MRM globally on 3400s:

no profinet mrp
mrp ring 1

mode auto-manager

domain-id FFFFFFFF-FFFF-FFFF-
FFFF-FFFFFFFFFEFFE
vlan-id 100
Configure MRP on member
interfaces:
interface range
GigabitEthernetl/1-2
switchport mode trunk

mrp ring 1

4. Verifying MRP configuration:
Issue the following on IE9320 to verify the MRP ring:

IE9320-J8HS#sh mrp ring 1

MRP ring 1

Profile : 200 ms
Mode : Auto-Manager
Priority : 40960

Operational Mode: Manager

From : CLI
License : Not Applicable
Gateway

Status : Disabled

Best Manager
MAC Address
B0:8D:57:9C:88:97
Priority : 40960

Network Topology: Ring
Network Status : CLOSED
Portl:

Port2:

MAC Address

:B0:8D:57:9C:88:97 MAC
Address :B0:8D:57:9C:88:98
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Interface :G11/0/23

Interface :Gi1/0/24

Status :Forwarding

Status :Blocked
VLAN ID : 100

Domain Name : Cisco MRP Ring 1

Domain ID : FFFFFFFF-FFFF-

FFFF-FFFF-FFFFFFFFEFEFFE

###Some output has been
omitted##

TE3400-Y8E4-MRP1_1#sh mrp ring 1

MRP ring 1

Profile : 200 ms

Mode : Auto-Manager
Priority : 40960

Operational Mode: Client

From : CLI
License : Not Applicable
Gateway

Status : Disabled

Best Manager

MAC Address
B0:8D:57:9C:88:97
Priority : 40960

Network Topology: Ring
Network Status : CLOSED
Portl:

Port2:

MAC Address

:D4:7F:35:1C:EB:01 MAC
Address :D4:7F:35:1C:EB:02
Interface :Gil/1

Interface :Gil/2

Status :Forwarding
Status :Forwarding
VLAN ID : 100

Domain Name : Cisco MRP Ring 1

##Some output has been
omitted###
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Configuring Private VLANs

PVLANSs provide Layer 2 isolation between ports within the same VLAN . In offshore wind farms, turbine operator SCADA network is
micro-segmented using Private VLANSs. For details on this refer to the section : Network micro-segmentation using Private VLAN in the
Design Guide Cisco Solution for Renewable Energy: Offshore Wind Farm 1.1.

A PVLAN uses VLANSs in the following three ways:

e Asa primary VLAN—Carries traffic from promiscuous ports to isolated, community, and other promiscuous ports in the same
primary VLAN.

e Asanisolated VLAN—Carries traffic from isolated ports to a promiscuous port.

e Asacommunity VLAN—Carries traffic between community ports and to promiscuous ports. You can configure multiple
community VLANs in a PVLAN

To learn more about PVLANS refer to the link that follows:
https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst4500/12-2/25ew/configuration/guide/conf/pvlans.pdf

To configure PVLAN in Turbine Operator SCADA network follow the sequence shown in Figure 11-14.

Figure 11-14 Workflow for configuring Private-VLAN
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1. Setting VTP mode

Before PVLAN configuration, the VTP mode on the device must be set. Configuring private-vlan on a VTP server will
propagate the vlans to clients.

vtp mode server
|

2. Creating primary and secondary vlans

vlan 10
name PrivateVLANvlan

private-vlan primary

vlan 101

private-vlan isolated

Repeat the above on all switches in the Core, FSN, and TSN ring of the Turbine Operator SCADA network.
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3. Creating association between primary and secondary vlan

vlan 10

private-vlan association 101

4, Creating mapping on the SVI of primary vlan

The following cli must be entered on the two C9300s which are configured with vlan 10 SViIs:

interface Vl1anlO

private-vlan mapping 101

5. Configuring an interface in a secondary vlan

To configure an interface in an isolated or community port, configure it as private vlan host followed by
primary vlan id and isolated or community vlan id. The following is an example:

interface GigabitEthernetl/3

switchport private-vlan host-association 10 101

Alternatively, the port can also be configured as promiscuous.
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The private vlan configuration can be verified by issuing show vlan private-vlan

Show vlan private-vlan
Primary Secondary Type Ports
10 100 isolated Gil/3

Note: The primary and the secondary vlans must be allowed on all trunk ports in the network.

This completes the PVLAN configuration.

Configuring MACSec

MACsec is the IEEE 802.1AE standard for authenticating and encrypting packets between two MACsec-capable devices. MACsec was
developed to allow authorized systems to connect and then encrypt data that is transmitted across the wire and to keep a man-in-the-
middle from being able to insert frames on to the wire. MACsec does not authorize the systems connecting to the network, it enables
those systems to encrypt traffic destined for the network. MACsec, provides MAC-layer encryption over wired networks by using out-
of-band methods for encryption keying. The MACsec Key Agreement (MKA) Protocol provides the required session keys and manages
the required encryption keys.

For details on MACsec and its use refer to the section MACsec Encryption in Turbine Operator Network in the Design Guide.

MACsec can be configured with either key based encryption or certificate based encryption. To learn details about these
methods refer to the link below:

https://www.cisco.com/c/en/us/td/docs/switches/lan/cisco_ie3X00/software/17_3/b_security 17-
3_iot_switch cg/m-macsec-protocol.html

Note: MACSec is not supported on IE3100 Series switches. IE3100 switches should not be mixed with IE3400 to form the rings if
MACsec is to enabled in the ring.

Configuring Pre-shared key-based Macsec

In this method a key-chain is configured that is used by MACsec for encryption. Following is the workflow to configure pre-
shared key based MACsec:

Figure 11-15 Workflow for configuring pre-shared key based MACsec
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The following configurations are to be completed on all switches in the Turbine operator network:
1. Configure a key-chain as shown in example below

key chain MAC-SEC macsec

key 4000000000000000000000000000000000000000000000000000000000000000
cryptographic-algorithm aes-128-cmac
key-string 7 106D283F2034332D29270B0D010B1213074324372524067A7975715E2039307C08
lifetime local 00:00:00 Jan 1 1993 infinite
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2. Configure an mka policy as shown below:
mka policy MKA-POLICY
key-server priority 150

sak-rekey interval 65535
3. Enable macsec on the link using the keychain and mka policy as shown below:

For C9300 &IE9320 :

Macsec network-link
mka policy MKA-POLICY

mka pre-shared-key key-chain MAC-SEC

For 3400:

Macsec

mka policy MKA-POLICY

mka pre-shared-key key-chain MAC-SEC

Note: To enable macsec on C9300 and IE9320 use the cli command: macsec network-linkand for platforms 3400 use the
command: macsec

4. Verify the macsec session using the command: show mka session

Configuring certificate-based MACsec

This section covers the configuration of certificate based MACsec in brief. To learn details about the same refer to the link
below:
https://www.cisco.com/c/en/us/td/docs/ios-xml/ios/macsec/configuration/xe-16-6/macsec-xe-16-6-book/macsec-xe-16-
6-book chapter 010.pdf

For configuring certificate based MACsec, a CA server must be first setup. Certificate can be obtained from the CA, in the
following two ways :

1. Manual installation of certificates from a CA

2. Certificate installation via SCEP

We have used a windows server for manual certificate generation and a Cisco router for automatic certificate generation
via SCEP .

To learn how to install a windows CA server refer to the link below:

https://learn.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-certs/install-the-
certification-authority

To learn how to configure a Cisco router as a CA server refer to the link below:

https://www.cisco.com/c/en/us/support/docs/security-vpn/ipsec-negotiation-ike-protocols/50282-ios-ca-ios.html

Prerequisites for configuring certificate based MACsec:

i All devices must be synchronized to the same NTP

ii. A CA server should be in ready state .For details on CA server configuration refer to the link below:
https://www.cisco.com/c/en/us/support/docs/security-vpn/public-key-infrastructure-pki/211322-10S-PKI-
Deployment-Guide-Certificate-Ro.html

124


https://www.cisco.com/c/en/us/td/docs/ios-xml/ios/macsec/configuration/xe-16-6/macsec-xe-16-6-book/macsec-xe-16-6-book_chapter_010.pdf
https://www.cisco.com/c/en/us/td/docs/ios-xml/ios/macsec/configuration/xe-16-6/macsec-xe-16-6-book/macsec-xe-16-6-book_chapter_010.pdf
https://learn.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-certs/install-the-certification-authority
https://learn.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-certs/install-the-certification-authority
https://www.cisco.com/c/en/us/support/docs/security-vpn/ipsec-negotiation-ike-protocols/50282-ios-ca-ios.html
https://www.cisco.com/c/en/us/support/docs/security-vpn/public-key-infrastructure-pki/211322-IOS-PKI-Deployment-Guide-Certificate-Ro.html
https://www.cisco.com/c/en/us/support/docs/security-vpn/public-key-infrastructure-pki/211322-IOS-PKI-Deployment-Guide-Certificate-Ro.html

Cisco Offshore Wind Farm Solution 1.2 Implementation Guide

iii. Certificates on each I0S XE device must be issued by the same CA
iv. Certificates can be obtained using SCEP or manual enrollment
a. Certificates must contain the following X509 Usages
Digital Signature
b. Key Encipherment

V. Certificates must contain the following Extended Key Usages

a. Server Auth

b. Client Auth
Vi. Device must be configured with a hostname, Domain Name, DNS IP Addresses & NTP
vii. the access-session is configured as closed or in multiple-host mode

Manual installation of certificates from a CA

Manual certificate generation involves the following steps shown in Figure 11-16:

Figure 11-16 Workflow for generating certificate on a switch
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For detailed steps refer to the link below :
https://community.cisco.com/t5/networking-knowledge-base/creating-a-csr-authenticating-a-ca-and-enrolling-
certificates-on/ta-p/4436090

1. Generating a key-pair

Generate a key pair for use in trustpoint as shown in the example below:
crypto key generate rsa modulus 4096 label my-4096rsa-key
1

2. Creating Trustpoint

Following commands show an example for creation of trustpoint
crypto pki trustpoint my-trustpoint

enrollment terminal pem

C=IN, ST=KAR, L=BLR, O=cisco, OU=IOT, CN= WF-SCADA-IE9320-1.wf.com
subject-alt-name WF-SCADA-IE9320-1.wf.com

serial-number none
ip-address none
revocation-check none

rsakeypair my-4096rsa-key

3. Generating CSR

A Certificate Signing Request will be created and the same will be displayed on the screen. This CSR needs to be
copied to a file and saved it with file_name.cer . Following is the command to generate CSR and display it
on the screen:

crypto pki enroll my-trustpoint

4. Obtaining CA root certificate

For authenticating the CA, the CA certificate must be installed on the device using the following command:
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crypto pki authenticate my-trustpoint
5. Importing device certificate
In this step the file that was given by the CA on submission of CSR is going to be imported on the device using the
command below:

crypto pki import my-trustpoint certificate

The device is now ready to use the certificate for MACsec configuration.

Certificate installation via SCEP

Figure 11-17 Workflow for configuring SCEP
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For detailed step refer to the link below:
https://www.cisco.com/c/en/us/td/docs/ios-xml/ios/sec_conn pki/configuration/15-mt/sec-pki-15-mt-book/sec-cert-
enroll-pki.html

1. Generate key-pair
Generate a key pair as covered in the Manual certificate install section.

crypto key generate rsa modulus 4096 label my-4096rsa-key
!

2. Create a trustpoint with enrolment URL pointing to the reachable CA as shown in example below:
crypto pki trustpoint CA
enrollment url http://10.20.200.1:80
serial-number
ip-address none
subject-name CN=Y819
revocation-check none
rsakeypair my-4096rsa-key

hash sha512
3. Downloading the CA root certificate

,,,,, sl o~ e

o atfr_ o ot ot _al [T
Dowilload the CA root ceitificate DY I55Ulng e cornirndinu snowi

1
1 veIvw.

crypto pki authenticate <TRUSTPOINT NAME>

example: crypto pki authenticate my-trustpoint>

4.  Enrolling the cericate
Issue the below command to enroll the device cer @icate

crypto pki enroll <TRUSTPOINT NAME>

example : crypto pki enroll my-trustpoint
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The certificate should be successfully obtained. Verify it using the following cli:

show crypto pki certificates verbose my-trustpoint

Certificate based MACsec configuration

After certificates have been installed on the devices, MACsec can be configured as shown in the diagram below:

Figure 11-18 Workflow for configuring certificate based MACSec
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1. Configuring AAA

Following is the example configuration to configure AAA: conf t
aaa new-model
aaa local authentication MACSEC-UPLINK authorization MACSEC-UPLINK
aaa authorization credential-download MACSEC-UPLINK local
aaa authentication dotlx MACSEC-UPLINK local
aaa authorization network MACSEC-UPLINK local
1
end

2. Creating Local Username for 802.1x Authentication

This username will be referenced in the dotlx Cred Set section below.

aaa attribute list MUST-SECURE
attribute type linksec-policy must-secure
|

username usr-macsec aaa attribute list MUST-SECURE
1

3. Creating a policy map for MACsec Uplink

Configure the policy-map that will be applied to interfaces that connect the switches

policy-map type control subscriber DOT1X-MUST-SECURE-UPLINK
event session-started match-all
10 class always do-until-failure
10 authenticate using dotlx aaa authc-1list MACSEC-UPLINK authz-1list MACSEC-UPLINK both
event authentication-failure match-all
10 class always do-until-failure
10 terminate dotlx
20 authentication-restart 10
event authentication-success match-all
10 class always do-until-failure
10 activate service-template DEFAULT LINKSEC POLICY MUST SECURE

4. Configuring EAPTLS AuthC Profile and 802.1x Credential Set

Enable dotlx in this section and create authentication profiles:
dotlx system-auth-control
|

eap profile EAP-PROFILE
method tls
pki-trustpoint my-trustpoint
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|

!

dotlx credentials DOT1X-CREDS
username usr-macsec

pki-trustpoint my-trustpoint
|

5. Configuring the Switchport for VLAN Trunking, dotlx & MACsec Network Link

interface gl/1
switchport mode trunk
macsec network-link
authentication periodic
authentication timer reauthenticate 1800
access-session host-mode multi-host
access-session closed
access-session port-control auto
dotlx pae both
dotlx credentials DOT1X-CREDS
dotlx supplicant eap profile EAP-PROFILE
dotlx authenticator eap profile EAP-PROFILE
service-policy type control subscriber DOT1X-MUST-SECURE-UPLINK

6. Verification

Verify that the macsec session is established by issuinga show mka session

Implementing Quality of Service

The WindFarm turbine operator network uses the QoS model described in the section TSN Quality-of-Service Design of the Windfarm
Design Guide to guarantee network performance and operation by streamlining traffic flow, differentiating network services, and
reducing packet loss, jitter, and latency.

The following diagram shows the QoS model implemented on FSN and TSN rings:

Figure 11-19 QoS design for IE switches in TSN and FSN
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For configuring QoS in the Turbine Operator Network use the following workflow:

Figure 11-20 QoS configuration sequence
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1. Classifying the traffic
Traffic can be classified using the source marked DSCP value or by configuring an access-list to segregate traffic based on
source ip and matching against this access-list. Following is configuration required this step.

ip access-list standard 1
10 permit 10.1.10.0 0.0.0.255

class-map match-any MCD

match dscp cs5 ef c¢s6 cs7
class-map match-any LPD

match dscp default csl
class-map match-any MPD

match dscp cs2 af2l af22 af23
class-map match-any HPD

match dscp cs3 af3l af32 af33 cs4 afdl afd42 af43
match access-group 1

class-map HPD Output

match dscp CS4

2. Creatingingress policy-map for remarking

An input policy-map is to be created to use the above created class-maps and setting the dscp value as per the QoS
design. Following is an example configuration:

policy-map WE_SCADA Ingress_Policy
class MCD
set ip dscp EF

class HPD
set ip dscp CS4

class MPD
set ip dscp CS2
class LPD
set ip dscp CS1

3. Creating Egress policy-map
An output policy-map is to be created as per the QoS design. Following is an example configuration:

policy-map WF SCADA Egress Policy

class MCD

priority

queue-limit 48 packets

class HPD Output

bandwidth remaining percent 40
queue-limit 48 packets

class MPD

bandwidth remaining percent 30
queue-limit 48 packets

class LPD

bandwidth remaining percent 30
queue-limit 272 packets

4. Applying the Ingress and Egress policies on interface

The following is the example configuration to apply the policies on the interfaces

129



Cisco Offshore Wind Farm Solution 1.2 Implementation Guide

int range gi 1/1-10
service-policy input WEF_SCADA Ingress_Policy
service-policy output WF_SCADA Egress_Policy

This completes QoS configuration on the devices.
Implementing Multicast in Offshore Substation

This section describes how to enable support for multicast traffic in an turbine operator network. To enable multicast between
devices configure the C9300s in the core network as a rendezvous point for multicast . For details on how to configure multicast
refer to the link below:

https://www.cisco.com/c/en/us/td/docs/switches/metro/me3600x 3800x/software/release/12-

2 52 ey/configuration/guide/swmcast.html

Figure 11-21 Workflow for Enabling Multicast
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1. Enable multicast on C9300s
Enter the following commands on the 9300s to enable mul €ast:

ip multicast-routing

2. Enabling PIM under SVIs of C9300
Enter the following commands under interface vlan on both C9300s:

interface Vlan5
ip pim sparse-mode

3. Configuring RP
RP Address has to be configured on the C9300s. Following is the example config:

ip pim rp-address 10.5.1.1

The source can be connected on the core ring and destination in FSN/TSN ring to send/receive the multicast.

This completes the multicast implementation for the Turbine operator network.

130


https://www.cisco.com/c/en/us/td/docs/switches/metro/me3600x_3800x/software/release/12-2_52_ey/configuration/guide/swmcast.html
https://www.cisco.com/c/en/us/td/docs/switches/metro/me3600x_3800x/software/release/12-2_52_ey/configuration/guide/swmcast.html

Cisco Offshore Wind Farm Solution 1.2 Implementation Guide

Chapter 12: Compact onshore substation:

In a wind farm network, an onshore substation (ONSS) is a renewable energy site that is normally in remote areas where communication
network is not readily available. Generally, offshore substations connect to ONSSs in rural locations where access to backhaul technologies
is limited. While offshore to onshore connectivity is served by fiber optic cable, the backhaul from the onshore location is more challenging
and often relies on service provider network availability for services such as fiber, MPLS, metro Ethernet, and so on.

In this solution architecture, Cisco Catalyst IE-3400 switch is used as ONSS core network switch.

Figure 12-1 Compact ONSS Topology
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Compact Onshore substation Implementation:

This chapter describes how to manually bring up a Farm area SCADA network (FSN) ring and Turbine area SCADA network ring in a wind
farm by using switch CLI commands.
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This chapter includes the following topics:
e  Configuring a Farm Area SCADA Network
e  Configuring a Turbine Area SCADA Network

Configuring a Farm Area SCADA Network Ring:
After completing physical connections for bringing up FSN ring, configure the Core IE-3400 switch as REP edge and neighbor IE-3400
switches with REP:

1. Configure the L2 and L3 Initial configurations on the Core IE-3400 Switch.
!
vlan 30
!
interface V1an30
ip address 10.10.30.254 255.255.0.0
!
interface GigabitEthernet2/1
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switchport mode trunk

I
interface GigabitEthernet2/2

switchport mode trunk

2. REP configuration for the FSN ring is done with the IE-3400 aggregation switch interface as the edge port.

|

interface GigabitEthernet2/1
switchport mode trunk

rep segment 10 edge

!

interface GigabitEthernet2/2
switchport mode trunk

rep segment 10 edge

3. Configure the neighboring IE-3400 switches in either a clockwise or counterclockwise direction by entering the following commands
on each switch:
I
interface GigabitEthernetl/2
switchport mode trunk
rep segment 10
!
interface GigabitEthernetl/1
switchport mode trunk
rep segment 10
!
4. Replicate these IE-3400 configurations on all IE-3400 switches of the FSN ring sequentially.

5. After all switches in the FSN ring are configured, verify REP by entering the show rep topology CLI command in any of the member
switches.

WF-IE3400-CORE#sh rep topology
REP Segment 10

BridgeName PortName Edge Role
WF-TE3400-CORE Gi2/2 Pri Alt

IE3400-T4-BS5 Gil/1 Open
IE3400-T4-BS5 Gil/2 Open
IE3400-T4-BS4 Gil/1 Open
IE3400-T4-BS4 Gil/2 Open
IE3400-T3-BS3 Gil/2 Open
IE3400-T3-BS3 Gil/1 Open
IE3400-T2-BS2 Gil/2 Open
IE3400-T2-BS2 Gil/1 Open
IE3400-T1-BS1 Gil/2 Open
IE3400-T1-BS1 Gil/1 Open
WF-IE3400-CORE Gi2/1 Sec Open
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For more detailed information about REP configuration, see REP Command Reference:
https://www.cisco.com/c/en/us/td/docs/optical/cpt/r9 3/command/reference/cpt93 cr/cpt93 cr chapter 0111.pdf

Configuring a Turbine Area SCADA Network Ring:

In Onshore wind farms, each wind turbine has a Cisco IE3400 switch deployed at the turbine nacelle for turbine operator network
connectivity to various SCADA endpoints in the turbine operator network. For details on it, refer to the section Turbine SCADA Network
(TSN) Design of the design guide Cisco Solution for Renewable Energy: Offshore Wind Farm 1.2 Design Guide.

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/Wind-Farm_1-2_Design_Guide.pdf

1. Complete the physical cabling:
2. Physical cabling of switches to a Base Scada Switch forms an Open ring.
3. Configure Open REP segment on IE-3400 base switches
Here is a sample configuration on a base switch that forms part of the TSN:
!
interface GigabitEthernetl/3
switchport mode trunk

rep segment 6 edge

4. Configure the neighboring IE-3400 Nacelle switches in either a clockwise or counterclockwise direction by entering the following
commands on each switch:
!
interface GigabitEthernetl1/10
switchport mode trunk
rep segment 6

5. After all switches in the TSN ring are configured, verify REP by entering the show rep topology CLI command in any of the member
switches.

IE3400-T4-NS2#sh rep topology
REP Segment 6

BridgeName PortName Edge Role
IE3400-T4-BS4 Gil/3 Pri Open
IE3400-T4-NS2 Gil/10 Open
IE3400-T4-NS2 Gil/1 Open
IE3400-T4-NS1 Gil/2 Open
IE3400-T4-NS1 Gil/10 Open
IE3400-T4-BS5 Gil/3 Sec Alt

Configuring PVLAN

PVLANs provide Layer 2 isolation between ports within the same VLAN. In offshore wind farms, turbine operator SCADA network is micro-
segmented using Private VLANs. For details on this refer to the section: Network micro-segmentation using Private VLAN in the Design
Guide Cisco Solution for Renewable Energy: Offshore Wind Farm 1.2

https://www.cisco.com/c/dam/en/us/td/docs/solutions/Verticals/Utilities/Wind_Farm/Wind-Farm_1-2_Design_Guide.pdf
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A PVLAN uses VLANSs in the following three ways:

As a primary VLAN—Carries traffic from promiscuous ports to isolated, community, and other promiscuous ports in the same
primary VLAN.

e Asanisolated VLAN—Carries traffic from isolated ports to a promiscuous port.

As a community VLAN—Carries traffic between community ports and to promiscuous ports. You can configure multiple

community VLANs in a PVLAN

To learn more about PVLANS refer to the link that follows:
https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst4500/12-2/25ew/configuration/guide/conf/pvlans.pdf

To configure the PVLAN in Turbine Operator SCADA network follow the sequence shown in Figure 12-2.

Figure 12-2 Workflow for configuring Private VLAN
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1. Setting VTP mode before PVLAN configuration, the VTP mode on Core switch must be Server and all the other switches in the ring

as Client.
!
vtp domain wf.com
vtp version 3
vtp mode server
!
2. Creating primary and secondary vlans
!
vlan 101
name Privatevlan
private-vlan primary
!
vlan 301

private-vlan isolated

3. Repeat the above on all switches in the Core, FSN and TSN ring of the Turbine Operator SCADA network.

4. Creating the association between Primary and secondary.

vlan 101

private-vlan association 301

5. Creating mapping on the SVI of primary vlan.
!

interface VlanlO1l

description primary vlan

private-vlan mapping 301

6. Configuring an interface in a secondary Vlan
To configure an interface in an isolated or community port configure it as private vlan host followed by primary vlan id and isolated or

community vlan id. Following is an example:
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|
interface GigabitEthernetl/3
switchport private-vlan host-association 101 301

switchport mode private-vlan host

Alternatively, the port can also be configured as promiscuous.

The private-vlan configuration can be verified by issuing “show vlan private-vlan”

WEF-IE3400-CORE#sh vlan private-vlan

Primary Secondary Type Ports
101 301 isolated Gil/3
201 401 isolated

This completes the PVLAN configuration.

Zone based firewall Implementation:
This chapter explains how to manually configure:
. FlexVPN, WAN Edge router, HER.
e  Zone based Firewall.

A wind farm asset operator’ s control center hosts multiple IT and OT applications with other network infrastructure servers. All
communications to the control center are secured by using a pair of firewalls in non-HA deployment and a Cisco C8500 series routers acting
as headend or hub routers. Cisco C8500 Series router terminate all IPSec tunnels from remote substations WAN edge routers.
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Figure 12-3 Zoning details in Compact ONSS
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Configure the Underlay L2 and L3 on WAN edge router and HER before proceeding to Flex VPN configuration:

Underlay Ethernet backhaul and initial configuration
HER:

I
interface Loopbackl

ip address 10.18.1.254 255.255.255.0

!

interface TenGigabitEthernet0/0/0

description Connected to WF-IR1101-WAN1 Port Gi0/0/0
ip address 172.18.1.1 255.255.255.0

no negotiation auto

!
interface TenGigabitEthernet0/0/1

description Connected to WF-DC-C3850 switch

no ip address

negotiation auto

cdp enable
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interface TenGigabitEthernet0/0/1.47

encapsulation dotlQ 47

ip address 192.168.47.1 255.255.255.0
!
WAN Edge router:
!
interface Vlan9
description OSPF to WEF-IE3400-CORE
ip address 10.56.1.1 255.255.255.252
no ip redirects
no ip proxy-arp
zone-member security INSIDE
ip ospf message-digest-key 1 md5 7 113E2916004A595C54
ip ospf network point-to-point
ip ospf 1 area O
load-interval 30
!
interface Loopbackl
description NAT
ip address 10.56.0.254 255.255.255.255
!
interface FastEthernet0/0/1
description Connected to IE3400-ONSS-CORE switche
switchport trunk allowed vlan 9
switchport mode trunk

load-interval 30

interface GigabitEthernet0/0/0

description Connected to WF-C8500-HER Ethernet WAN backhaul
ip address 172.18.1.2 255.255.255.252

ip nat outside

Wind farm WAN backhaul connectivity in an onshore substation. The wind farm WAN often is a dedicated WAN
infrastructure that connects the transmission service operator (TSO) control center with various substations and other field
networks and assets. Wind farm WAN connections can include a variety of technologies, such as cellular LTE or 5G options for
public backhaul, Fiber ports connect wind farm operator or utility owned private networks, leased lines or MPLS PE
connectivity options, and legacy multilink PPP backhaul aggregating multiple T1/E1 circuits.

A Cisco IR1101 Series Router deployed as an ONSS WAN edge router serves as an interface between the onshore substation
and the control center.

Configure BGP between HER and WAN Edge router

Sample configuration on HER
!
router bgp 64512
bgp log-neighbor-changes
neighbor WAN-IR1101 peer-group

neighbor WAN-IR1101 remote-as 64512
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neighbor WAN-IR1101 timers 10 60
neighbor 10.18.1.1 peer-group WAN-IR1101
!
address-family ipv4
bgp redistribute-internal
redistribute connected route-map CONNtoBGP
neighbor WAN-IR1101 send-community
neighbor WAN-IR1101 prefix-list PFX BGP IR OUT out
neighbor 10.18.1.1 activate
neighbor 10.18.1.1 soft-reconfiguration inbound
exit-address-family
!
Sample configuration on WAN Edge router:
router bgp 64512
bgp log-neighbor-changes
neighbor HUB peer-group
neighbor HUB remote-as 64512
neighbor HUB timers 10 60
neighbor 10.18.1.254 peer-group HUB
!
address-family ipv4
bgp redistribute-internal
redistribute connected route-map CONNtoBGP
redistribute ospf 1 match internal external 1 external 2
neighbor HUB send-community standard
neighbor HUB prefix-list PFX BGP_ HUB_OUT out
neighbor 10.18.1.254 activate
neighbor 10.18.1.254 soft-reconfiguration inbound

exit-address-family

In the wind farm solution architecture, Cisco IE-3400 switches are used as ONSS core network switches. The ONSS core connects to multiple
components. The connections should be resilient and provide higher bandwidth (10Gbps) and layer 3 links for scalable L3 routing like OSPF.

Configure L3 boundary on IE3400 Core switch with OSPF routing to WAN Edge router

Sample configuration on WAN Edge router
!
ip ospf message-digest-key 1 md5 7 113E2916004A595C54
ip ospf network point-to-point
ip ospf 1 area O
router ospf 1
router-id 10.56.0.254
auto-cost reference-bandwidth 10000
max-1lsa 10000
area 0 authentication message-digest
redistribute connected
redistribute bgp 64512 route-map iBGPtoOSPF

redistribute ospf 1 match internal external 1 external 2
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Sample configuration on Core switch:
!
ip ospf message-digest-key 1 md5 7 097B7E1AQOES5D45425B
ip ospf network point-to-point
ip ospf 1 area O

router ospf 1

Flex VPN implementation

FlexVPN is Cisco’s solution to simplify VPN deployments and covers all VPN types. For example: Hub and spoke (including spoke-to-spoke
traffic). FlexVPN uses IKEv2 for all VPN types.

Please refer documentation for FlexVPN configuration: FlexVPN Site-to-Site Configuration Example

Bring up the tunnel between HER and WAN Edge router, Configure HER as Flex VPN hub, Sample configuration on HER:

!

ip access-list standard FLEXVPN ROUTES

10 permit 10.18.1.0 0.0.0.255

!

crypto ikev2 authorization policy IKEV2 AUTHORIZATION
route set interface

route set access-list FLEXVPN ROUTES

!
crypto ikev2 proposal FlexVPN IKEv2 Proposal
encryption aes-cbc-256

integrity sha256

group 19

!
crypto ikev2 policy FlexVPN IKEv2 Policy

proposal FlexVPN IKEvZ2 Proposal

|

crypto ikev2 keyring FLEXVPN KEYRING

peer IR1101 ROUTERS
address 0.0.0.0 0.0.0.0
pre-shared-key local Ciscol23
pre-shared-key remote Ciscol23
|
|
!
crypto ikev2 profile IKEV2 PSK PROFILE
match identity remote fgdn domain wf.com
identity local fgdn WF-C8500-HER.wf.com
authentication remote pre-share
authentication local pre-share
keyring local FLEXVPN KEYRING
aaa authorization group psk list FlexVPN Local IKEVZ2 AUTHORIZATION
virtual-template 1
!
interface Virtual-Templatel type tunnel
ip unnumbered Loopbackl
tunnel source TenGigabitEthernet0/0/0

tunnel protection ipsec profile IPSEC_PSK PROFILE
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|

interface Loopbackl
ip address 10.18.1.254 255.255.255.0
!
Configuration on WAN Edge router:
!
crypto ikev2 keyring FLEXVPN KEYRING
peer WF-C8500-HER
address 172.18.1.1
pre-shared-key local Ciscol23
pre-shared-key remote Ciscol23
1
|
1
!
crypto ikev2 profile IKEV2_PSK_PROFILE
match identity remote fgdn WF-C8500-HER.wf.com
identity local fgdn WF-IR1101-WANI1.wf.com
authentication remote pre-share
authentication local pre-share
keyring local FLEXVPN KEYRING
aaa authorization group psk list FLEXVPN LOCAL IKEV2 AUTHORIZATION
!
interface Tunnel0
ip address 10.18.1.1 255.255.255.0
no ip redirects
no ip proxy-arp
zone-member security FLEXVPN
load-interval 30
tunnel source GigabitEthernet0/0/0
tunnel destination 172.18.1.1
tunnel protection ipsec profile IPSEC PSK PROFILE

Once routing configurations are completed, configure the zones:

Zone based Firewall configuration

Figure 12-4 Workflow of configuring Zone based firewall

Configure Apply Policy-maps
Define Zones Configure Policy-maps to to the Zone-pairs.

and Class-maps that z e
e -Dalrs dascriBe Hafic apply action to the Assign interfaces
Class-map’s traffic to Zones.

Zone based firewall enabled on IR1101 WAN Edge router to secure communication across zones:

Zone and Zone pair configuration example:
!
zone security FLEXVPN
description FLEXVPN Zone
zone security INSIDE
description INSIDE Zone
zone security CUSTOMER DMZ
description Customer network zone
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zone-pair security ZP_CUSTOMER DMZ INSIDE source CUSTOMER DMZ destination INSIDE

service-policy type inspect PM_CUSTOMER DMZ INSIDE

zone-pair security ZP FLEXVPN INSIDE source FLEXVPN destination INSIDE
service-policy type inspect PM_FLEXVPN INSIDE

zone-pair security ZP INSIDE CUSTOMER DMZ source INSIDE destination CUSTOMER DMZ
service-policy type inspect PM_INSIDE CUSTOMER DMZ

zone-pair security ZP INSIDE FLEXVPN source INSIDE destination FLEXVPN

service-policy type inspect PM_INSIDE FLEXVPN

|

Class-map creation sample configuration:
!
class-map type inspect match-all CM_CUSTOMER_ DMZ_TO_LOCAL_SRV
match access-group name ACL CUSTOMER DMZ TO_ LOCAL SRV
!
Policy-map creation sample configuration:
!
policy-map type inspect PM INSIDE CUSTOMER DMZ
class type inspect CM_LOCAL_SRV_TO_ CUSTOMER_DMZ
inspect
class class-default

drop log

Implementing QoS

To configure QoS for IE-3400 and IE-3400 switches in the ONSS, perform the following steps. Operational technology traffic is matched
based on access lists. Other incoming traffic is matched based on DSCP markings.

1. Create an input class map to match traffic types based on DSCP values.

2. Create an input policy map to set the DSCP values.

3. Allocate bandwidth to different traffic types in the output policy map so that voice traffic is sent in a priority queue.
4

Assign the input and output policy map to the switch.

Configuration on Core switch:
!
class-map match-any MCD
match dscp cs5 ef cs6 cs7
class-map match-any LPD
match dscp default csl
class-map match-any MPD
match dscp cs2 af2l af22 af23
class-map match-any HPD
match dscp cs3 af3l af32 af33 csd4 afd4l afd42 af43
match access-group 1
class-map HPD Output
match dscp CS4
exit
conf t
policy-map WF_SCADA Ingress_Policy
class MCD

set ip dscp EF
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class HPD

set ip dscp CS4
class MPD
set ip dscp CS2
class LPD
set ip dscp CS1
exit
config term
policy-map WF SCADA Egress Policy
class MCD
priority level 1
queue-limit 48 packets
class HPD Output
bandwidth remaining percent 40
queue-limit 48 packets
class MPD
bandwidth remaining percent 30
queue-limit 48 packets
class LPD
bandwidth remaining percent 30

queue-limit 272 packets

On IE-3400 Switch:

1
policy-map WF_SCADA Egress_Policy
class MCD

priority

queue-limit 48 packets

class HPD_Output

bandwidth remaining percent 40

queue-limit 48 packets

class MPD

bandwidth remaining percent 30
queue-limit 48 packets

class LPD

bandwidth remaining percent 30
queue-limit 272 packets

end
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Configuration Examples

Appendix A: Configuration Examples

This appendix includes the following topics:

WAN PE Configuration

WAN HER Configuration

FAN Ring Switch Configuration (Non Edge Switch that is Not a Part of TAN Rings)
QoS on IE-3400

QoS on FAN Aggregation and on the OSS and ONSS (C-9300/C-9500)

WAN PE Configuration

hostname PE

boot-start-marker
boot system bootflash:asr900rsp2-universalk9 npe.17.05.01.SPA.bin
boot-end-marker

vrf definition Management VRF
rd 100:1
route-target export 100:1
route-target import 100:201

address-family ipv4
exit-address-family

vrf definition Mgmt-intf

address-family ipv4
exit-address-family

address-family ipv6
exit-address-family

vrf definition VRF PLANTLINK
rd 199:105
route-target export 199:105
route-target import 199:105

address-family ipv4
exit-address-family

card type el 0 1
no logging console
enable password ivsg@1l23

no aaa new-model
ethernet evc Czech 3

clock timezone IST 5 30

no ip domain lookup
ip domain name asr903-Auto-PE.cisco.com

login on-success log

mpls ldp explicit-null

mpls ldp graceful-restart

mpls 1ldp session protection

mpls traffic-eng tunnels

multilink bundle-name authenticated
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Configuration Examples

xconnect logging pseudowire status
!
license udi pid ASR-903U sn FOX1749P8CB
license boot level metroaggrservices
no license smart enable
memory free low-watermark processor 5603
!
spanning-tree extend system-id
sdm prefer default
diagnostic bootup level minimal
!
username admin privilege 15 password 0 ivsg@l23
|
redundancy
mode sso
main-cpu
standby console enable
!
bfd-template single-hop ISIS-BFD
interval min-tx 4 min-rx 4 multiplier 3
!
bfd-template single-hop bfd-tunnell
interval min-tx 100 min-rx 100 multiplier 3
!
bfd-template single-hop bfd-tunnel?2
interval min-tx 4 min-rx 4 multiplier 3
!
bfd-template single-hop bfd-tunnel3
interval min-tx 4 min-rx 4 multiplier 3
|
controller wanphy 0/0/0
!
controller E1 0/1/0
framing no-crc4
clock source internal
linecode ami
channel-group 1 timeslots 1-31
no snmp trap link-status
]
controller El
no snmp trap
|

0/1/1
link-status

controller E1
no snmp trap
!

controller E1
no snmp trap
!

controller E1
no snmp trap
!

controller E1
no snmp trap
!

controller E1
no snmp trap
!

controller E1
no snmp trap
|

0/1/2
link-status

0/1/3
link-status

0/1/4
link-status

0/1/5
link-status

0/1/6
link-status

0/1/7
link-status

controller wanphy 0/2/8

controller voice-port 0/3/0

controller voice-port 0/3/1
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Configuration Examples

i
controller voice-port 0/3/2
I

controller voice-port 0/3/3
i

controller voice-port 0/3/4
I

controller voice-port 0/3/5
|
transceiver type all
monitoring
cdp run
|
11dp run
|
class-map match-any vlanl04
match vlan 104
class-map match-any vlanl05
match vlan 105
class-map match-any vlanl06
match vlan 106
class-map match-any vlanl07
match vlan 107
class-map match-any vlanlOl
match vlan 101
class-map match-any vlanl02
match vlan 102
class-map match-any v1anl03
match vlan 103
class-map match-any v1anl08
match vlan 108
|
policy-map Access_ingress
class vlanlO1l
police cir 128000 bc 8000
conform-action transmit
exceed-action drop
class vlanl02
police cir 128000 bc 8000
conform-action transmit
exceed-action drop
class v1anl03
police cir 256000 bc 8000
conform-action transmit
exceed-action drop
class vlanl04
police cir 512000 bc 16000
conform-action transmit
exceed-action drop
class vlanl05
police cir 1024000 bc 32000
conform-action transmit
exceed-action drop
class vlanlO6
police cir 20000000 bc 625000
conform-action transmit
exceed-action drop
class vlanl07
police cir 100000000 bc 3125000
conform-action transmit
exceed-action drop
class vlanl08
police cir 200000000 bc 6250000
conform-action transmit
exceed-action drop
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Configuration Examples

class class-default
!
pseudowire-class TE3
encapsulation mpls
!
pseudowire-class PW64
encapsulation mpls
!
interface Loopback0
ip address 192.168.201.10 255.255.255.255
!
interface Loopbackl
ip address 192.168.199.3 255.255.255.255
!
interface Loopbackl00
ip address 100.100.100.1 255.255.255.255
!
interface Port-channell
ip address 192.168.119.1 255.255.255.0
no negotiation auto
bfd interval 50 min rx 50 multiplier 3
lacp max-bundle 2
|
interface Multilinkl
ip address 11.11.11.1 255.255.255.0
ppp multilink
ppp multilink group 1
|
interface pseudowirel
encapsulation mpls
neighbor 3.3.3.3 3
mtu 1508

control-word include
|

interface pseudowire?2
encapsulation mpls
neighbor 17.17.17.17 28
bandwidth 2144 persistent
!
interface pseudowire3
encapsulation mpls
neighbor 2.2.2.2 4
bandwidth 64 persistent
!
interface TenGigabitEthernet0/0/0
no ip address
shutdown
!
interface Serial0/1/0:1
no ip address
encapsulation ppp
ppp multilink
ppp multilink group 1
1
interface GigabitEthernet0/2/0
ip address 192.168.81.2 255.255.255.0
ip ospf network point-to-point
ip ospf 1 area O
load-interval 30
negotiation auto
cdp enable
mpls ip
mpls label protocol 1dp
mpls ldp discovery transport-address 192.168.201.10
mpls traffic-eng tunnels
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!
interface GigabitEthernet0/2/1
no ip address
negotiation auto
!
interface GigabitEthernet0/2/2
no ip address
negotiation auto
cdp enable
bfd interval 50 min rx 50 multiplier 3
channel-group 1
!
interface GigabitEthernet0/2/3
no ip address
negotiation auto
cdp enable
bfd interval 50 min rx 50 multiplier 3
channel-group 1 B
!
interface GigabitEthernet0/2/4
description connected to gig0/0/1 Sumatra-PP-1l-pravm
no ip address
negotiation auto
service instance 2011 ethernet
encapsulation dotlg 2011
rewrite ingress tag pop 1 symmetric
bridge-domain 2011
|
interface GigabitEthernet0/2/5
description connected to sumatra-PP-1-Pravm gig0/0/0
ip address 192.168.82.1 255.255.255.0
load-interval 30
negotiation auto
cdp enable
mpls ip
mpls label protocol 1ldp
mpls ldp discovery transport-address interface
bfd interval 50 min rx 50 multiplier 3
!
interface GigabitEthernet0/2/6
no ip address
negotiation auto
!
interface GigabitEthernet0/2/7
no ip address
negotiation auto
cdp enable
!
interface TenGigabitEthernet0/2/8
no ip address
shutdown
|
interface GigabitEthernetO
vrf forwarding Mgmt-intf
ip address 10.104.56.179 255.255.255.192
negotiation auto
!
interface BDI2011
vrf forwarding Management VRF
ip address 20.11.0.1 255.255.255.0
|
router eigrp 1
bfd interface GigabitEthernet0/2/2
bfd interface GigabitEthernet0/2/3
bfd interface Port-channell
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network 11.11.11.1 0.0.0.0

network 192.168.119.1 0.0.0.0

network 192.168.201.10 0.0.0.0

!

router eigrp 100

bfd all-interfaces

network 100.100.100.1 0.0.0.0

network 192.168.82.0

network 192.168.83.0

!

router ospf 1

router-id 192.168.201.10

network 11.11.11.0 0.0.0.255 area O

network 192.168.119.0 0.0.0.255 area O

network 192.168.201.10 0.0.0.0 area O

!

router bgp 200

bgp log-neighbor-changes

no bgp default route-target filter

neighbor 192.168.198.1 remote-as 198

neighbor 192.168.198.1 ebgp-multihop 2

neighbor 192.168.198.1 update-source Loopbackl00
neighbor 192.168.201.6 remote-as 200

neighbor 192.168.201.6 update-source Loopback0

|

address-family ipvé
bgp redistribute-internal
network 192.168.199.3 mask 255.255.255.255
redistribute eigrp 1
neighbor 192.168.198.
neighbor 192.168.198.
neighbor 192.168.198.

activate
next-hop-self
soft-reconfiguration inbound

AN e B

neighbor 192.168.198 send-label
neighbor 192.168.201.6 activate
neighbor 192.168.201.6 next-hop-self
neighbor 192.168.201.6 send-label

exit-address-family
|
address-family vpnv4
bgp redistribute-internal
neighbor 192.168.198.1 activate
neighbor 192.168.198.1 send-community extended
neighbor 192.168.198.1 next-hop-self
neighbor 192.168.201.6 activate
neighbor 192.168.201.6 send-community extended
neighbor 192.168.201.6 next-hop-self
exit-address-family
]
address-family ipv4 vrf Management VRF
redistribute connected
neighbor 20.11.0.2 remote-as 198
neighbor 20.11.0.2 activate
exit-address-family
!
ip forward-protocol nd
no ip http server
no ip http secure-server
|
ip tftp source-interface GigabitEthernetO
ip ssh source-interface Loopbackl
ip ssh version 2
ip route 8.18.2.1 255.255.255.255 8.8.8.8
ip route 8.18.3.1 255.255.255.255 18.18.18.18
ip route vrf Mgmt-intf 0.0.0.0 0.0.0.0 10.104.56.129
!
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ip explicit-path name R356 working enable
index 1 next-address 192.168.6.1
index 2 next-address 192.168.3.2

|

ip explicit-path name R324176

nable
index 1 next-address 192.168.7.2
index next-address 192.168.
index

index next-address 192.168.

index next-address 192.168.
|

e
7
2 5
3 next-address 192.168.5.
index 4 next-address 192.168.2
5 2
6 1

ip explicit-path name R654 enable
index 1 next-address 192.168.6.1
index 2 next-address 192.168.4.1
index 3 next-address 4.4.4.4

|

ip explicit-path name R6174 enable
index 1 next-address 192.168.7.2
index 2 next-address 192.168.5.1
index 3 next-address 4.4.4.4

|

ip explicit-path name R4176 enable
index 1 next-address 192.168.7.2
index 2 next-address 192.168.5.2

!

logging alarm informational

logging host 10.64.66.32 vrf Mgmt-intf

|

snmp-server community private RW
snmp-server community public RO
snmp-server host 10.64.66.31 vrf Mgmt-intf version 2c public
|

12vpn xconnect context 3 6 6 6 6

member pseudowirel

!

12vpn xconnect context XCon 28 17.17.17.17
member pseudowire?

!

12vpn xconnect context XCon 4 2.2.2.2
member pseudowire3

!

control-plane

|

line con O

exec-timeout 0 0

stopbits 1

line vty 0 4

password ivsg@l1l23

login

transport input ssh

line vty 5 149

login

transport input ssh

!
network-clock synchronization automatic
network-clock synchronization ssm option 2 GEN1
network-clock synchronization mode QL-enabled
network-clock wait-to-restore 5 global
network-clock log gl-changes
esmc process
ntp server 192.168.119.2

!
End
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WAN HER Configuration

hostname Substation-HER

|

boot-start-marker

boot system bootflash:asrl000-universalk9.17.03.04a.SPA.bin

boot-end-marker

!

vrf definition Management VRF
rd 100:1

route-target export 100:201
route-target import 100:1

!

address-family ipv4
import ipv4 unicast map GRT-VREF-INTERNET
export ipv4 unicast map VRF-GLOBAL
exit-address-family

!

vrf definition Mgmt-intf
!

address-family ipv4
exit-address-family
|

address-family ipv6
exit-address-family

|

vrf definition VRF BUSINESS
rd 199:104
route-target export 199:104
route-target import 199:104
!

address-family ipv4
exit-address-family

!

vrf definition VRF GRIDMON
rd 199:102
route-target export 199:102
route-target import 199:102
!
address-family ipv4
exit-address-family

!

vrf definition VRF MGMT
rd 199:101
route-target export 199:101
route-target import 199:101
!
address-family ipv4
exit-address-family

!

vrf definition VRF PLANTLINK
rd 199:105
route-target export 199:105
route-target import 199:105
!
address-family ipv4

import ipv4 unicast map GLOBAL-TO-VRF PLANTLINK

exit-address-family

|

vrf definition VRF SCADA
rd 199:111
route-target export 199:111
route-target import 199:111
route-target import 101:111
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|
address-family ipv4
route-target export 199:111
route-target import 199:111
route-target import 101:111
exit-address-family
|
vrf definition VRF TSCADA
rd 199:103
route-target export 199:103
route-target import 199:103
|
address-family ipv4
exit-address-family
|
aaa new-model
|
aaa authentication login default local
aaa authorization exec default local
aaa authorization network FlexVPN Author local
|
aaa session-id common
clock timezone IST 5 30
clock calendar-valid
|
ip name-server 64.104.128.236 72.163.128.140
ip domain name isg.cisco.com
|
ip dhcp pool ASR1002-HX-DHCP
network 192.168.60.0 255.255.255.0
default-router 192.168.60.1
dns-server 64.104.128.236 72.163.128.140
|
ip dhcp pool ASR1002-HX-MPLS-POOL
network 192.168.6.0 255.255.255.0
dns-server 64.104.128.236 72.163.128.140
|
ip dhcp pool SUMATRA-VEDGE-001-MPLS
network 192.168.7.0 255.255.255.0
default-router 192.168.7.1
dns-server 64.104.128.236 72.163.128.140
|
ip dhcp pool CSR1000vEdge-001
network 192.168.85.0 255.255.255.0
dns-server 64.104.128.236 72.163.128.140
default-router 192.168.85.1
|
ip dhcp pool IR1101-cEDGE
network 192.168.8.0 255.255.255.0
dns-server 64.104.128.236 72.163.128.140
default-router 192.168.8.1
|
login on-success log
ipv6 unicast-routing
12tp-class L2TP_TUNNEL TEST
hidden
authentication
digest secret 0 cisco@123 hash SHAL
hello 100
hostname Substation-HER
password cisco@123
receive-window 50
retransmit retries 10
timeout setup 400
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subscriber templating
!
mpls label protocol 1ldp
mpls ldp igp sync holddown 1
mpls traffic-eng tunnels
multilink bundle-name authenticated
!
key chain DMVPN
key 1
key-string dmvpn
!
crypto pki trustpoint TP-self-signed-1965877644
enrollment selfsigned
subject-name cn=I0S-Self-Signed-Certificate-1965877644
revocation-check none
rsakeypair TP-self-signed-1965877644
|
crypto pki trustpoint SLA-TrustPoint
enrollment pkcsl2
revocation-check crl
|
crypto pki certificate chain TP-self-signed-1965877644
certificate self-signed 01
30820330 30820218 A0030201 02020101 300D0609 2A864886 F70D0101 05050030
31312F30 2D060355 04031326 494F532D 53656C66 2D536967 6E65642D 43657274
69666963 6174652D 31393635 38373736 3434301E 170D3139 30313033 32333337
31305A17 0D333030 31303130 30303030 305A3031 312F302D 06035504 03132649
4F532D53 656C662D 5369676E 65642D43 65727469 66696361 74652D31 39363538
37373634 34308201 22300D06 092A8648 86F70D01 01010500 0382010F 00308201
0A028201 0100C714 B6672F20 6FCACB2D B50D37FD ACC82BB6 48FA3370 596AA888
CE960E65 D29D7COA 73576B28 B1F4DABA D1D95B46 E8050E39 405D92AF 5AA18ACE
949BB18F 71750675 1727640A 332D8936 816B8DAC 7D8AA1ID8 1CB2A298 694ABF7D
16041846 50D8CE7F O0DA680C4 FE36COE7 4E5AE910 36A6861F 2BF1CCAO0 DOBO875F
96AF3DED 6E523CCl 00BCA192 E76C8A22 5D65FAED 821586A3 337D7A2C 4B85179B
957CF4BE 2F3A3F24 914FAAF3 C9BC548D 7ACA7978 F22A1D04 5C3E463A E7E05DE2
84D74AAF OE67216A 34259D3C DD49ABED 8C8ASDD1 EDF8A994 16CO056E2 88FE2C39
2F193213 C2C710D1 ADB65FF7 Al0269F0 95FC1OEF C188AD79 5F81A51E CD1F431E
0420B145 9C750203 010001A3 53305130 0F060355 1D130101 FF040530 030101FF
301F0603 551D2304 18301680 14F597FF AFE97D33 10450784 DES1AE65 AFCI9EOD3
98301D06 03551DOE 04160414 F597FFAF E97D3310 450784DE 51AE65AF C9E0D398
300D0609 2A864886 F70D0101 05050003 82010100 02020A8F AFC4E554 4A3CB2CS8
BACABCAE 7E35E8EF DD6674B7 064D1B78 15C134BA 03F64CBE 92052784 DO7BF4C7
2C58E4DE 52ADSCE1 24803B1lF 2FDF695A 9FD5C1D1 6A7B8DOF 5B5B4309 123DE3EF
CC864675 1DDCD32A 648D5F12 1DA10E63 3CD7F9C8 E1A400E6 A66AESEO FEO015FAC
4856AAB1 257EFEB7 E72D9E35 25BB7COA 85210008 10A44487 121FB976 Al925CF9
254F2A85 D13BE0S5 91BBDBED DB7C597F B26E2F81 2145E044 Al12FF215 5EA46005
OD9F948F 5D934357 AO3FCB29 0B6722CF E1B3FA28 69D5BOB5 7CE738B2 9C422EF9
42ECB5F1 F6A0646E 4689A9F0 09C8BASC E5925BB9 C025C73E ES5BEE(0S57 DC089907
FE81C2D2 1CB8AC61 87BA438D 94E3E8C4 DECYEIBA
quit
crypto pki certificate chain SLA-TrustPoint
certificate ca 01
30820321 30820209 A0030201 02020101 300D0609 2A864886 F70D0101 0BO50030
32310E30 0C060355 040A1305 43697363 6F312030 1E060355 04031317 43697363
6F204C69 63656E73 696E6720 526F6F74 20434130 1E170D31 33303533 30313934
3834375A 170D3338 30353330 31393438 34375A30 32310E30 0C060355 040A1305
43697363 6F312030 1E060355 04031317 43697363 6F204C69 63656E73 696E6720
526F6F74 20434130 82012230 0D06092A 864886F7 0D010101 05000382 010F0030
82010A02 82010100 A6BCBD96 131EO05F7 145EA72C 2CD686E6 17222EAl F1lEFF64D
CBB4C798 212AA147 C655D8D7 9471380D 8711441E 1AAFO071A 9CAE6388 8A38E520
1C394D78 462EF239 C659F715 B98COA59 5BBBSCBD OCFEBEA3 700A8BF7 D8F256EE
4AA4E80D DB6FDICY9 60B1FD18 FFC69C96 6FA68957 A2617DE7 104FDCS5F EA2956AC
7390A3EB 2B5436AD C847A2C5 DABS553EB 69A9A535 58E9F3E3 COBD23CF 58BD7188
68E69491 20F320E7 948E71D7 AE3BCC84 F10684C7 4BC8EOOF 539BA42B 42C68BB7
C7479096 BACB2D62 EA2F505D C7B062A4 6811D95B E8250FC4 5D5D5S5FB8 8F27D191
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C55F0D76 61F9A4CD
DFC7C6CF 04DD7FD1
06300F06 03551D13
4B3D31E5 1B3E6Al7
03820101 00507F24
604EDCDE FF4FED2B
D98987BF E40CBDIE
467A3DF4 4D565700
7CATBTE6 ClAF74F6
S5FBODAO6 B92AFETF
80DDCD16 D6BACECA
418616A9 4093E049
D697DF7F 28
quit
I

3D992327
02030100
0101FF04
606AF333
D3932A66
7TTFC460E
1AECAQOC2
6ADFOFOD
152E99B7
494E8A9E
EEBC7CFE9
4D10AB75

A8BBO3BD
01A34230
05300301
3D3B4C73
86025D9F
CD636FDB
2189BB5C
CF835015
B1FCFI9BB
07B85737
8428787B
27E86F73

4E6D7069
40300E06
01FF301D
E8300D06
E838AESC
DD44681E
8FA85686
3CO04FF7C
EQ73DETF
F3A58BEL
35202CDC
932E35B5

license udi pid ASR1002-HX sn JAE225206PR
license accept end user agreement
license boot suite FoundationSuiteK9
license boot suite AdvUCSuiteK9
license boot level adventerprise

license solution level appxk9

license solution level securityk9
memory free low-watermark processor 991004

spanning-tree extend system-id
diagnostic bootup level minimal

7CBADF8B
03551DO0OF
0603551D
092A8648
6D4DF6B0O
3A5673AB
CD98B646
21E878AC
5BDDEB86
1A48A229
60E4616A
8862FDAE

username cisco privilege 15 password 0 Cisco@123
username admin privilege 15 password 0 sentryo69!

!

redundancy

mode none

!

bridge-domain 1
member vni 6001

member GigabitEthernet0/2/15 service-instance 1

!

bridge-domain 601
no mac learning

!

bridge-domain 1000

crypto ikev2 authorization policy default No cert

route set interface

route set access-list FLEX ACL

no crypto ikev2 authorization policy default

crypto ikev2 redirect gateway init
' (IKEv2 Cluster load-balancer is not enabled)
crypto ikev2 proposal FlexVPN IKEv2 Proposal No cert
encryption aes-cbc-256

integrity sha256
group 14
!

crypto ikev2 policy FlexVPN IKEv2 Policy No cert

proposal FlexVPN IKEv2 Proposal No cert

crypto ikev2 keyring ANY

peer ANY

address 0.0.0.0 0.0.0.0
pre-shared-key sentryo

crypto ikev2 profile FLEX SERVER PROF No cert 1
match identity remote address 0.0.0.0

match identity remote fgdn domain isg.cisco.com
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identity local address 89.89.89.1
authentication remote pre-share
authentication local pre-share
keyring local ANY
aaa authorization group psk list FlexVPN Author default No cert
virtual-template 4
!
crypto ikev2 fragmentation
!
cdp run
|
1ldp run
pseudowire-class L2TP PW TEST
encapsulation 12tpv3
sequencing both
protocol 12tpv3 L2TP_TUNNEL TEST
ip local interface Loopbackl
ip pmtu
ip dfbit set
ip tos reflect
ip ttl 100
!
class-map match-any TRANSACTIONAL
match ip dscp cs2 af2l af22 af23 csd4 afdl afd4?2
class-map match-all VOICE
match ip dscp ef
class-map match-any MISSION-CRITICAL-DATA
match access—-group name MISSION-CRITICAL-DATA
class-map match-any MISSION-CRITICAL
match ip dscp cs3 af3l af32 af33 cs6
class-map match-all CALL-SIGNALING
match ip dscp cs3
!
policy-map HOST-INPUT-MARKING
class VOICE
set dscp ef
class CALL-SIGNALING
set dscp cs3
class MISSION-CRITICAL-DATA
set dscp af3l
class class-default
policy-map HOST-QUEUE-PACKETS
class VOICE
priority
class MISSION-CRITICAL
bandwidth remaining percent 30
queue-limit 96 packets
class TRANSACTIONAL
bandwidth remaining percent 20
queue-limit 96 packets
class class-default
bandwidth remaining percent 25
queue-limit 272 packets
policy-map UPLINK-QUEUE-PACKETS
class VOICE
priority
class MISSION-CRITICAL
bandwidth remaining percent 30
queue-limit 96 packets
class TRANSACTIONAL
bandwidth remaining percent 20
queue-limit 96 packets
class class-default
bandwidth remaining percent 25
queue-limit 272 packets
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!
crypto isakmp invalid-spi-recovery

!
crypto ipsec security-association replay disable
crypto ipsec security-association replay window-size 512
!
crypto ipsec transform-set FlexVPN IPsec Transform Set No cert esp-aes esp-sha256-hmac
mode transport
crypto ipsec fragmentation after-encryption
crypto ipsec df-bit clear

!
crypto ipsec profile default No cert 1

set transform-set FlexVPN IPsec Transform Set No cert
set pfs groupl4

set ikev2-profile FLEX SERVER PROF No cert 1

!
interface Loopback0

ip address 192.168.201.6 255.255.255.255

!
interface Loopbackl

ip address 192.168.200.1 255.255.255.255

!
interface Loopback2

description Segment Routing Loop

ip address 3.3.3.3 255.255.255.255

!
interface Loopbackl?2

ip address 12.12.12.1 255.255.255.255

ip ospf network point-to-point

ip ospf 12 area O

|
interface Loopback99

ip address 192.168.13.1 255.255.255.255
|

interface Loopbackl00
ip address 10.60.60.1 255.255.255.255
bfd interval 50 min rx 50 multiplier 3
!
interface LoopbacklOl
ip address 10.70.70.1 255.255.255.255
1
interface Loopbacklll
ip address 192.168.220.4 255.255.255.255
!
interface Loopback200
ip address 192.168.117.1 255.255.255.255
!
interface TunnellOO0
no ip address
!
interface GigabitEthernet0/0/0
description connected to DMZ switch in RR06 on port G1/0/3
ip address 173.39.13.85 255.255.255.192
ip nat outside
negotiation auto
!
interface GigabitEthernet0/0/1
description connected to asr920-001
ip dhcp relay information trusted
ip dhcp relay information option-insert
ip dhcp relay information check-reply
ip address 192.168.69.1 255.255.255.0
ip nat inside
ip ospf network point-to-point
ip ospf 1 area O
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load-interval 30
negotiation auto
cdp enable
mpls ip
mpls ldp discovery transport-address 192.168.201.6
mpls traffic-eng tunnels
bfd interval 200 min rx 200 multiplier 3
service-policy output UPLINK-QUEUE-PACKETS
|
interface GigabitEthernet0/0/2
description connected to ixia card 2 por 1
mtu 9216
no ip address
load-interval 30
negotiation auto
|
interface GigabitEthernet0/0/2.1201
encapsulation dotlQ 1201
vrf forwarding VRF SCADA
ip address 12.0.1.1 255.255.255.0
|
interface GigabitEthernet0/0/2.1202
encapsulation dotlQ 1202
vrf forwarding VRF TSCADA
ip address 12.0.2.1 255.255.255.0
|
interface GigabitEthernet0/0/2.1203
encapsulation dotlQ 1203
vrf forwarding VRF PLANTLINK
ip address 12.0.3.1 255.255.255.0
!
interface GigabitEthernet0/0/2.1204
encapsulation dotlQ 1204
vrf forwarding VREF MGMT
ip address 12.0.4.1 255.255.255.0
!
interface GigabitEthernet0/0/2.1205
encapsulation dotlQ 1205
vrf forwarding VRF GRIDMON
ip address 12.0.5.1 255.255.255.0
!
interface GigabitEthernet0/0/2.1206
encapsulation dotlQ 1206
vrf forwarding VRF BUSINESS
ip address 12.0.6.1 255.255.255.0
|
interface GigabitEthernet0/0/2.3001
encapsulation dotlQ 3001
ip address 30.1.0.1 255.255.255.0
!
interface GigabitEthernet0/0/2.3002
encapsulation dotlQ 3002
ip address 30.2.0.1 255.255.255.0
!
interface GigabitEthernet0/0/3
description connected to ixia card 2 port 2
mtu 9216
no ip address
load-interval 30
negotiation auto
service instance 990 ethernet
encapsulation dotlg 990
rewrite ingress tag pop 1 symmetric
bridge-domain 601
|
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service instance 997 ethernet
encapsulation dotlg 997
rewrite ingress tag pop 1 symmetric
bridge-domain 1000
!
interface GigabitEthernet0/0/3.140
encapsulation dotlQ 140

ip address 140.140.140.1 255.255.255.0
|

interface GigabitEthernet0/0/3.799
encapsulation dotlQ 799

xconnect 192.168.199.1 799 encapsulation mpls
!

interface GigabitEthernet0/0/3.2001
description For Windfarm Testbed
encapsulation dotlQ 2001

vrf forwarding Management VRF

ip address 201.201.201.1 255.255.255.0
!
interface GigabitEthernet0/0/4

ip address 99.99.99.100 255.255.255.0
negotiation auto

bfd interval 50 min rx 50 multiplier 3
!

interface GigabitEthernet0/0/5

description connected to 10.104.56.148 PC ethernet - asr G5

ip address 192.168.228.1 255.255.255.252
negotiation auto
|
interface GigabitEthernet0/0/6
description Phy Loop
no ip address
negotiation auto
service instance 990 ethernet
encapsulation dotlg 990
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 601 split-horizon group 0O
|
service instance 997 ethernet
encapsulation dotlqg 997
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 998 ethernet
encapsulation dotlg 998
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1001 ethernet
encapsulation dotlg 1001
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1002 ethernet
encapsulation dotlqg 1002
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
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R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1052 ethernet
encapsulation dotlqg 1052
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1053 ethernet
encapsulation dotlg 1053
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1054 ethernet
encapsulation dotlqg 1054
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1055 ethernet
encapsulation dotlg 1055
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1056 ethernet
encapsulation dotlg 1056
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1056
|
service instance 1057 ethernet
encapsulation dotlg 1057
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 1058 ethernet
encapsulation dotlqg 1058
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 1000
|
service instance 2502 ethernet
encapsulation dotlqg 2502
rewrite ingress tag pop 1 symmetric
12protocol forward cdp stp vtp dtp pagp dotlx
R9 RA RB RC RD RF
bridge-domain 601 split-horizon group 1
|
interface GigabitEthernet0/0/7
description Phy Loop
no ip address
load-interval 30

negotiation auto
!
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interface GigabitEthernet0/0/7.989

encapsulation dotlQ 989

xconnect 192.168.205.2 989 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.990

encapsulation dotlQ 990

xconnect 192.168.220.3 990 encapsulation 12tpv3 pw-class L2TP _PW TEST
!

interface GigabitEthernet0/0/7.991

encapsulation dotlQ 991

xconnect 192.168.205.2 991 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.992

encapsulation dotlQ 992

xconnect 192.168.205.2 992 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.993

encapsulation dotlQ 993

xconnect 192.168.223.1 993 encapsulation 12tpv3 pw-class L2TP PW TEST
|

interface GigabitEthernet0/0/7.994

encapsulation dotlQ 994

xconnect 192.168.223.1 994 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.995

encapsulation dotlQ 995

xconnect 192.168.223.1 995 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.996

encapsulation dotlQ 996

xconnect 192.168.223.1 996 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.997

encapsulation dotlQ 997

xconnect 192.168.223.1 997 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.998

encapsulation dotlQ 998

xconnect 192.168.202.2 998 encapsulation 12tpv3 pw-class L2TP PW TEST
|

interface GigabitEthernet0/0/7.1001

encapsulation dotlQ 1001

xconnect 192.168.199.2 1001 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.2502

encapsulation dotlQ 2502

xconnect 192.168.199.2 2502 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.2503

encapsulation dotlQ 2503

xconnect 192.168.199.2 2503 encapsulation 12tpv3 pw-class L2TP PW TEST
|

interface GigabitEthernet0/0/7.2504

encapsulation dotlQ 2504

xconnect 192.168.199.2 2504 encapsulation 12tpv3 pw-class L2TP PW TEST
!

interface GigabitEthernet0/0/7.2505

encapsulation dotlQ 2505

xconnect 192.168.199.2 2505 encapsulation 12tpv3 pw-class L2TP PW TEST
|

interface GigabitEthernet0/0/7.2506

encapsulation dotlQ 2506

xconnect 192.168.199.2 2506 encapsulation 12tpv3 pw-class L2TP PW TEST
|

interface GigabitEthernet0/0/7.2507
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encapsulation dotlQ 2507

xconnect 192.168.199.2 2507 encapsulation 12tpv3 pw-class L2TP PW TEST
!
interface GigabitEthernet0/0/7.2508
encapsulation dotlQ 2508

xconnect 192.168.199.2 2508 encapsulation 12tpv3 pw-class L2TP PW TEST
!
interface GigabitEthernet0/0/7.2509
encapsulation dotlQ 2509

xconnect 192.168.199.2 2509 encapsulation 12tpv3 pw-class L2TP PW TEST
!
interface GigabitEthernet0/0/7.2560
encapsulation dotlQ 2560

xconnect 192.168.199.2 2560 encapsulation 12tpv3 pw-class L2TP PW TEST
!
interface TenGigabitEthernet0/1/0
description connected to FPR4010 port 8
ip address 192.168.70.2 255.255.255.0
service-policy input HOST-INPUT-MARKING
]
interface TenGigabitEthernet0/1/0.106
encapsulation dotlQ 106

vrf forwarding Management VRF

ip address 106.106.0.2 255.255.255.0

ip nat inside

ip ospf network point-to-point

!
interface TenGigabitEthernet0/1/1

no ip address

!
interface TenGigabitEthernet0/1/2

ip address 192.168.84.1 255.255.255.0
ip ospf network point-to-point

ip ospf 1 area O

!

interface TenGigabitEthernet0/1/2.2
description connected to NCS-002-TenGigE0/0/0/6.2
encapsulation dotlQ 2

ip address 192.168.75.2 255.255.255.0

!

interface TenGigabitEthernet0/1/3

no ip address

shutdown

!

interface TenGigabitEthernet0/1/4

no ip address

!

interface TenGigabitEthernet0/1/5

no ip address

|

interface TenGigabitEthernet0/1/6

no ip address

!

interface TenGigabitEthernet0/1/7

no ip address

!

interface GigabitEthernet0/2/0
description connected to ixia 10.64.66.36 card 1 port 14
no ip address

negotiation auto

|

interface GigabitEthernet0/2/0.143
encapsulation dotlQ 143

ip address 143.143.143.1 255.255.255.0
!

160



Cisco Solution for Renewable Energy — Wind Farm 1.2 Implementation Guide

Configuration Examples

interface GigabitEthernet0/2/1
description connected to Laptop SCADA FEP
ip address 192.168.189.1 255.255.255.0
negotiation auto

I

interface GigabitEthernet0/2/2
description connected to ixia card 1 port 10
no ip address

negotiation auto

I

interface GigabitEthernet0/2/2.501
encapsulation dotlQ 501

ip address 171.171.171.1 255.255.255.0
I

interface GigabitEthernet0/2/3

no ip address

negotiation auto

I

interface GigabitEthernet0/2/4

ip address 10.64.66.77 255.255.255.0
negotiation auto

I

interface GigabitEthernet0/2/5

no ip address

shutdown

negotiation auto

I

interface GigabitEthernet0/2/6
description connected to sumatra-pp-2 on G0/0/0
ip address 89.89.89.1 255.255.255.0
negotiation auto

bfd interval 50 min rx 50 multiplier 3
I

interface GigabitEthernet0/2/7

no ip address

speed 1000

no negotiation auto

I
interface GigabitEthernet0/2/7.152
encapsulation dotlQ 152

ip address 152.152.152.1 255.255.255.0
I
interface GigabitEthernet0/2/8

no ip address

negotiation auto

I
interface GigabitEthernet0/2/9
description connected to SA-1002HX-002 gi0/0/0
ip address 192.168.60.1 255.255.255.0
ip nat inside

negotiation auto

mpls ip

mpls label protocol 1ldp

I
interface GigabitEthernet0/2/10
description connected to UCS 10.104.56.170 on VMNIC 8
ip address 192.168.85.1 255.255.255.0
ip nat inside

negotiation auto

cdp enable

I
interface GigabitEthernet0/2/11

no ip address

shutdown

negotiation auto
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!
interface GigabitEthernet0/2/12
no ip address
shutdown
negotiation auto
!
interface GigabitEthernet0/2/13
no ip address
negotiation auto
!
interface GigabitEthernet0/2/14
no ip address
shutdown
negotiation auto
!
interface GigabitEthernet0/2/15
description connected to IXIA card 2 port 13
no ip address
negotiation auto
service instance 1 ethernet
encapsulation dotlg 100
rewrite ingress tag pop 1 symmetric
|
interface GigabitEthernet0/2/16
description connected to IR1101
ip address 69.69.69.1 255.255.255.0
ip ospf network point-to-point
ip ospf 12 area 0
negotiation auto
!
interface GigabitEthernet0/2/17
description connected to IR1101-cEDGE-002
ip address 192.168.8.1 255.255.255.0
ip nat inside
negotiation auto
cdp enable
!
interface GigabitEthernetO
vrf forwarding Mgmt-intf
no ip address
shutdown
negotiation auto
|
interface Virtual-Template4 type tunnel
bandwidth 1000000
ip unnumbered Loopbackl00
tunnel source GigabitEthernet0/2/6
tunnel bandwidth transmit 1000000
tunnel bandwidth receive 1000000
tunnel protection ipsec profile default No cert 1
|
interface nvel
no ip address
source-interface Loopbackl2
member vni 6001
ingress-replication 12.12.12.2
!
segment-routing mpls
]
set-attributes
address-family ipv4
sr—label-preferred
exit-address-family
]

global-block 16000 24000
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connected-prefix-sid-map
address-family ipvi4

3.3.3.3/32 index 1 range 1
exit-address-family

router eigrp 99
bfd interface GigabitEthernet0/0/4
bfd interface GigabitEthernet0/2/6
network 10.0.0.0
network 89.89.89.0 0.0.0.255
network 99.99.99.0 0.0.0.255

140.0 0.0.0.255

143.0 0.0.0.255

network
network
network
network
network
network
network
network
network
network

140.
143.
152.
192.
192.
192.
192.
192.
192.
192.

140.
143.
152.
168.
168.
168.
168.
168.
168.
168.

0.0
2.0
4.0
13.0
89.0
200.0
201.0
228.0

redistribute bgp 200 metric 100 1 255 1 1500
eigrp router-id 10.60.60.1

router ospf 1

router-id 192.168.201.6

segment-routing mpls
network 3.3.3.3 0.0.0.0 area 0

network 192.168.201.6 0.0.0.0 area O
bfd all-interfaces
mpls ldp sync

router ospf 4 vrf Management VRF
redistribute static
network 106.106.0.0 0.0.0.255 area O
default-information originate always metric 15
default-metric 15

router ospf 12
router-id 12.12.12.1
network 12.12.12.1 0.0.0.0 area O
bfd all-interfaces

router bgp 200
bgp router-id interface Loopback0
bgp log-neighbor-changes
.168.60.2 remote-as 2001
.168.60.2 shutdown

.168.60.2 ebgp-multihop 255
.168.70.1 remote-as 1001

.168.70.1 update-source LoopbackO

neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor
neighbor

192
192
192
192
192
192
192
192
192
192
192
192
192
192
192
192
192
192

.168
.168
.168
.168
.168
.168
.168
.168
.168
.168
.168
.168
.168

L111.
L111.
L111.
.113.
L113.
L113.
.198.
.198.
.198.
.198.
.198.
.199.
.199.

e e e

remote-as 200
ebgp-multihop
update-source
remote-as 200
ebgp-multihop
update-source
remote-as 200
shutdown

update-source
fall-over

fall-over bfd
remote-as 200
shutdown

255
Loopback0

255
Loopback0

Loopback0
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neighbor 192.168.199.1 update-source Loopback0
neighbor 192.168.199.1 fall-over
neighbor 192.168.199.1 fall-over bfd multi-hop
neighbor 192.168.201.4 remote-as 200
neighbor 192.168.201.4 update-source Loopback0
neighbor 192.168.201.10 remote-as 200
neighbor 192.168.201.10 update-source Loopback0
neighbor 192.168.202.1 remote-as 101
neighbor 192.168.202.1 ebgp-multihop 255
neighbor 192.168.202.1 update-source Loopback0
neighbor 192.168.203.1 remote-as 200
neighbor 192.168.203.1 update-source Loopback0
neighbor 192.168.220.2 remote-as 102
neighbor 192.168.220.2 ebgp-multihop 255
neighbor 192.168.220.2 update-source Loopback0
1
address—-family ipv4
bgp additional-paths install
bgp nexthop trigger delay 1
network 18.18.18.0 mask 255.255.255.0
network 30.1.0.0 mask 255.255.255.0
network 30.2.0.0 mask 255.255.255.0
network 140.140.140.0 mask 255.255.255.0
network 141.141.141.0 mask 255.255.255.0
network 192.168.189.
network 192.168.200.
network 192.168.201.
network 192.168.201.
network 192.168.205.

mask 255.255.255.255
mask 255.255.255.255
mask 255.255.255.255
mask 255.255.255.255
network 192.168.205.4 mask 255.255.255.255
network 192.168.220.2 mask 255.255.255.255
network 192.168.223.1 mask 255.255.255.255
redistribute connected

redistribute eigrp 99

neighbor 192.168.60.2 activate

neighbor 192.168.60.2 next-hop-self
neighbor 192.168.60.2 send-label
neighbor 192.168.70.1 activate
1
1

NN IR O oo

neighbor 192.168.70.1 next-hop-self

neighbor 192.168.70.1 send-label

neighbor 192.168.111.1 activate

neighbor 192.168.111.1 send-community extended
neighbor 192.168.111.1 next-hop-self

neighbor 192.168.113.1 activate

neighbor 192.168.113.1 send-community extended
neighbor 192.168.113.1 next-hop-self

neighbor 192.168.198.1 activate

neighbor 192.168.198.1 next-hop-self

neighbor 192.168.198.1 soft-reconfiguration inbound
neighbor 192.168.198.1 send-label

neighbor 192.168.199.1 activate

neighbor 192.168.199.1 weight 40000

neighbor 192.168.199.1 next-hop-self

neighbor 192.168.199.1 soft-reconfiguration inbound
neighbor 192.168.199.1 send-label

neighbor 192.168.201.4 activate

neighbor 192.168.201.4 weight 40000

neighbor 192.168.201.4 next-hop-self

neighbor 192.168.201.4 soft-reconfiguration inbound
neighbor 192.168.201.4 send-label

neighbor 192.168.201.10 activate

neighbor 192.168.201.10 next-hop-self

neighbor 192.168.201.10 soft-reconfiguration inbound
neighbor 192.168.201.10 send-label

neighbor 192.168.202.1 activate

N N e e R e e R )
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neighbor 192.168.202.
neighbor 192.168.202.
neighbor 192.168.202.
neighbor 192.168.203.
neighbor 192.168.203.
neighbor 192.168.203.

next-hop-self
soft-reconfiguration inbound
send-label

activate

next-hop-self
soft-reconfiguration inbound

NN R

neighbor 192.168.203.1 send-label
neighbor 192.168.220.2 activate
neighbor 192.168.220.2 next-hop-self
neighbor 192.168.220.2 send-label

distribute-1list 1 out
exit-address-family
]
address-family vpnv4
neighbor 192.168.70.1 activate
neighbor 192.168.70.1 send-community extended
neighbor 192.168.70.1 next-hop-self
neighbor 192.168.198.1 activate
neighbor 192.168.198.1 send-community extended
neighbor 192.168.198.1 next-hop-self
neighbor 192.168.199.1 activate
neighbor 192.168.199.1 send-community extended
neighbor 192.168.199.1 next-hop-self
neighbor 192.168.201.4 activate
neighbor 192.168.201.4 send-community extended
neighbor 192.168.201.4 next-hop-self
neighbor 192.168.201.10 activate
neighbor 192.168.201.10 send-community extended
neighbor 192.168.201.10 next-hop-self
exit-address-family
!
address-family 12vpn evpn
exit-address-family
]
address-family ipv4 vrf Management VRF
redistribute ospf 4 match internal external 1 external 2
exit-address-family
!
address-family ipv4 vrf VRF BUSINESS
redistribute connected
exit-address-family
!
address-family ipv4 vrf VRF GRIDMON
redistribute connected
exit-address-family
!
address-family ipv4 vrf VRF MGMT
redistribute connected
exit-address-family
!
address-family ipv4 vrf VRF PLANTLINK
redistribute connected
exit-address-family
!
address-family ipv4 vrf VRF SCADA
redistribute connected
exit-address-family
!
address-family ipv4 vrf VRF TSCADA
redistribute connected
exit-address-family
|
ip tcp path-mtu-discovery
ip telnet source-interface GigabitEthernet0/0/0
ip http server

S N N L
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ip http authentication local

ip http secure-server

ip forward-protocol nd

|

ip ftp source-interface Loopbackl

ip ftp username splunk

ip ftp password Sdu@l12345

ip tftp source-interface Loopback0
ip dns server
ip pim rp-address 12.12.12.1
ip nat inside source list NAT INSIDE POOL interface GigabitEthernet0/0/0 overload
ip route 0.0.0.0 0.0.0.0 GigabitEthernet0/0/0

ip route 10.64.66.0 255.255.255.0 10.64.66.1
ip route 18.18.18.0 255.255.255.0 192.168.84.2
ip route 52.59.49.252 255.255.255.255 GigabitEthernet0/0/0
ip route 106.106.0.0 255.255.255.0 10.64.66.67
ip route 192.168.21.0 255.255.255.0 192.168.70.1
ip route 192.168.201.7 255.255.255.255 192.168.75.1
ip route 192.168.201.8 255.255.255.255 192.168.75.1
ip route 192.168.220.2 255.255.255.255 99.99.99.2 255
ip route vrf Management VRF 0.0.0.0 0.0.0.0 10.64.66.1
ip ssh source-interface GigabitEthernet0/0/0
ip ssh version 2

!
ip access-1list standard FLEX ACL

211 permit 10.1.1.10 B

210 permit 10.2.2.20

13 permit 89.89.89.0

14 permit 99.99.99.0

15 permit 192.168.169.1

10 permit 10.60.60.0 0.0.0.255

11 permit 192.168.220.0 0.0.0.255
16 permit 140.140.140.0 0.0.0.255
20 permit 192.168.2.0 0.0.0.255
30 permit 192.168.4.0 0.0.0.255
40 permit 192.168.5.0 0.0.0.255
50 permit 192.168.199.0 0.0.0.255
60 permit 192.168.200.0 0.0.0.255
80 permit 192.168.202.0 0.0.0.255
90 permit 192.168.203.0 0.0.0.255

100 permit 192.168.204.0 0.0.0.255
110 permit 192.168.210.0 0.0.0.255
ip access-list standard internet
10 permit 192.168.6.0 0.0.0.255
!
ip access-list extended MISSION-CRITICAL-DATA
10 permit tcp any eqg 20000 any
20 permit tcp any eq 20100 any
30 permit tcp any eq 20101 any
40 permit tcp any eq 20102 any
50 permit udp any eq 1234 any
60 permit udp any eq 1235 any
ip access-list extended NAT INSIDE POOL
10 permit ip 192.168.60.0 0.0.0.255 any
11 permit ip 192.168.85.0 0.0.0.255 any
12 permit tcp 192.168.85.0 0.0.0.255 any
13 permit udp 192.168.85.0 0.0.0.255 any

14 permit icmp 192.168.85.0 0.0.0.255 any
15 permit esp 192.168.85.0 0.0.0.255 any
16 permit ahp 192.168.85.0 0.0.0.255 any
20 permit tcp 192.168.60.0 0.0.0.255 any
30 permit udp 192.168.60.0 0.0.0.255 any

40 permit icmp 192.168.60.0 0.0.0.255 any
50 permit esp 192.168.60.0 0.0.0.255 any
60 permit ahp 192.168.60.0 0.0.0.255 any
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71 permit ip 192.168.66.0 0.0.0.255 any
72 permit tcp 192.168.66.0 0.0.0.255 any
73 permit udp 192.168.66.0 0.0.0.255 any
74 permit icmp 192.168.66.0 0.0.0.255 any
75 permit esp 192.168.66.0 0.0.0.255 any
76 permit ahp 192.168.66.0 0.0.0.255 any
77 permit ip any any
78 permit gre any any
81 permit ip 192.168.6.0 0.0.0.255 any
82 permit tcp 192.168.6.0 0.0.0.255 any
83 permit udp 192.168.6.0 0.0.0.255 any
84 permit icmp 192.168.6.0 0.0.0.255 any
85 permit esp 192.168.6.0 0.0.0.255 any
86 permit ahp 192.168.6.0 0.0.255 any
91 permit ip 192.168.7.0 0.0.0.255 any
92 permit tcp 192.168.7.0 0.0.0.255 any
93 permit udp 192.168.7.0 0.0.0.255 any
94 permit icmp 192.168.7.0 0.0.0.255 any
95 permit esp 192.168.7.0 0.0.0.255 any
96 permit ahp 192.168.7.0 0.0.0.255 any
101 permit ip 192.168.8.0 0.0.0.255 any
102 permit tcp 192.168.8.0 0.0.0.255 any
103 permit udp 192.168.8.0 0.0.0.255 any
104 permit icmp 192.168.8.0 0.0.0.255 any

0 0.0.0

0 0.0.0

[eNe]
[eNe]

[eNe]

105 permit esp 192.168.8. .255 any
106 permit ahp 192.168.8. .255 any
107 permit ip 106.106.0.0 0.0.0.255 any
108 permit tcp 106.106.0.0 0.0.0.255 any
109 permit udp 106.106.0.0 0.0.0.
110 permit icmp 106.106.0.0 0.0.0.255 any
111 permit esp 106.106.0.0 0.0.0.
112 permit ahp 106.106.0.0 0.0.0.
|
ip prefix-list GRT-VRF seq 5 permit 10.64.66.0/24
!
ip prefix-list VRF GLO seq 2 permit 106.106.0.0/24
!
ip prefix-list iBGP GLOBAL seq 5 permit 192.168.2.0/24
!
ip prefix-list lab-net seq 1 permit 10.64.66.0/24
!
route-map GLOBAL TO MAGAGEMENT VRF permit 10
match ip address prefix-list GLOBAL TO VRF Management
!
route-map GRT-VRF-INTERNET permit 10
match ip address prefix-list GRT-VRF
]
route-map GLOBAL-TO-VRF PLANTLINK permit 10
match ip address prefix-list iBGP_GLOBAL
!
route-map VREF-GLOBAL permit 10
match ip address prefix-list VRF GLO
|
snmp-server community public RO
snmp-server trap link ietf
snmp-server trap link switchover
snmp-server location SA-HER
snmp-server contact SCADA
snmp-server host 192.168.5.11 version 2c public
snmp ifmib ifindex persist
!
tftp-server bootflash:ASR1002-HX-JAE225206QL.cfg
tftp-server bootflash:ciscosdwan.cfg
tftp-server bootflash:asrl1000-universalk9.17.03.04a.SPA.bin
!
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control-plane
!
line con O
exec-timeout 0 0
stopbits 1
line aux O
stopbits 1
line vty 0 4
transport input all
transport output all
!
call-home
! If contact email address in call-home is configured as sch-smart-licensing@cisco.com
! the email address configured in Cisco Smart License Portal will be used as contact email
address to send SCH notifications.
contact-email-addr sch-smart-licensing@cisco.com
profile "CiscoTAC-1"
active
destination transport-method http
ntp master
ntp server 45.86.70.11
ntp server 10.104.56.158
!
end

9500

hostname WF-0SS-C9500

!

vrf definition Management VRF

rd 100:1

!

address-family ipv4

route-target export 100:1
route-target import 100:1
exit-address-family
|
vrf definition Mgmt-vrf

--More-- !

address-family ipv4

exit-address-family

|

address-family ipv6

exit-address-family
|
vrf definition OT VRF

rd 700:1

|

address-family ipv4

route-target export 700:1
route-target import 700:1
exit-address-family
!
vrf definition VnV_VRF

rd 500:1

!

address-family ipv4

route-target export 500:1
route-target import 500:1
exit-address-family
!

--More-- no aaa new-model
switch 1 provision c9500-16x
switch 2 provision c9500-16x
ip routing
]
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ip multicast-routing vrf Management VRF
ip domain name wf.com
ip dhcp excluded-address 10.10.101.1 10.10.101.50
!
login on-success log
|
-—-More-- !
!
stackwise-virtual
domain 2
!
flow exporter 192.168.6.100
destination 192.168.6.100
transport udp 6007
!
crypto pki trustpoint SLA-TrustPoint
enrollment pkcsl2
revocation-check crl
hash sha256
!
crypto pki trustpoint TP-self-signed-3141569633
enrollment selfsigned
subject-name cn=I0S-Self-Signed-Certificate-3141569633
revocation-check none
rsakeypair TP-self-signed-3141569633
hash sha256
crypto pki trustpoint DNAC-CA
enrollment mode ra
enrollment terminal
usage ssl-client
revocation-check crl none
source interface VlanlOl
hash sha256
!
license boot level network-advantage addon dna-advantage
memory free low-watermark processor 131093
!
diagnostic bootup level minimal
!
spanning-tree mode rapid-pvst
spanning-tree extend system-id
!
enable secret 9 $9$rT5UEJjrWOcgDA. $e2FNehaH33Q0AJMEOMFTYOs1VMrUmX2wD5IymWpNaSDo
!
username dna password 0 Cisco@123
!
redundancy
mode sso
crypto engine compliance shield disable
!
transceiver type all
monitoring
!
vlan 2508
remote-span
!
class-map match-any system-cpp-police-ewlc-control
description EWLC Control
class-map match-any system-cpp-police-topology-control
description Topology control
class-map match-any system-cpp-police-sw-forward
description Sw forwarding, L2 LVX data packets, LOGGING, Transit Traffic
class-map match-any system-cpp-default
description EWLC Data, Inter FED Traffic
class-map match-any system-cpp-police-sys-data
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description Openflow, Exception, EGR Exception, NFL Sampled Data, RPF Failed
class-map match-any ot traffic o
match ip dscp af2l
class-map match-any system-cpp-police-punt-webauth
description Punt Webauth
class-map match-any system-cpp-police-121vx-control
description L2 LVX control packets
class-map match-any ot traffic
match access-group name IXIA TRAFFIC
class-map match-any system—cpﬁ—police—forus
description Forus Address resolution and Forus traffic
class-map match-any system-cpp-police-multicast-end-station
description MCAST END STATION
class-map match-any system-cpp-police-high-rate-app
description High Rate Applications
class-map match-any system-cpp-police-multicast
description MCAST Data
class-map match-any video o
match ip dscp af4l
class-map match-any system-cpp-police-12-control
description L2 control
class-map match-any system-cpp-police-dotlx-auth
description DOT1X Auth
class-map match-any network control
match ip dscp cs2
class-map match-any voice o
match ip dscp ef
class-map match-any system-cpp-police-data
description ICMP redirect, ICMP_ GEN and BROADCAST
class-map match-any scavenger o
match ip dscp csl
class-map match-any system-cpp-police-stackwise-virt-control
description Stackwise Virtual OOB
class-map match-any non-client-nrt-class
class-map match-any bulk data
match ip dscp afll
class-map match-any system-cpp-police-routing-control
description Routing control and Low Latency
class-map match-any system-cpp-police-protocol-snooping
description Protocol snooping
class-map match-any system-cpp-police-dhcp-snooping
description DHCP snooping
class-map match-any bulk data o
match ip dscp afll
class-map match-any video
match ip dscp af4l
class-map match-any system-cpp-police-ios-routing
description L2 control, Topology control, Routing control, Low Latency
class-map match-any system-cpp-police-system-critical
description System Critical and Gold Pkt
class-map match-any voice
match ip dscp ef
class-map match-any network control o
match ip dscp cs2
class-map match-any system-cpp-police-ios-feature
description
ICMPGEN, BROADCAST, ICMP, L2LVXCntrl, ProtoSnoop, PuntWebauth, MCASTData, Transit, DOT1XAuth, Swfwd, L
OGGING, L2LVXData, ForusTraffic, ForusARP,McastEndStn, Openflow, Exception, EGRExcption, NflSampled
,RpfFailed
class-map match-any scavenger
match ip dscp csl
|
policy-map system-cpp-policy
policy-map output
class voice o

170



Cisco Solution for Renewable Energy — Wind Farm 1.2 Implementation Guide

Configuration Examples

priority level 1
class video o
bandwidth remaining percent 10
class ot traffic o
bandwidth remaining percent 10
class network control o
bandwidth remaining percent 10
class bulk data o
bandwidth remaining percent 10
class scavenger o
bandwidth remaining percent 10
class class-default
bandwidth remaining percent 15
policy-map input
class voice
set dscp ef
class video
set dscp af4l
class ot _traffic
set dscp af2l
class network control
set dscp cs2
class bulk data
set dscp afll
class scavenger
set dscp csl
class class—-default
set dscp default
|
interface Loopback0
ip address 192.168.5.2 255.255.255.255
|
interface Port-channell
switchport mode trunk
|
interface Port-channel?2
switchport trunk allowed vlan 101,500,700
switchport mode trunk
|
interface Port-channelll
!
interface GigabitEthernet0/0
vrf forwarding Mgmt-vrf
no ip address
negotiation auto
|
interface TenGigabitEthernetl/0/1
description connectedToFPRO1dY015
switchport access vlan 100
switchport mode access
|
interface TenGigabitEthernetl/0/2
switchport access vlan 101
switchport mode access
!
interface TenGigabitEthernetl/0/3
switchport mode trunk
channel-group 1 mode active
service-policy input input
service-policy output output
|
interface TenGigabitEthernetl/0/4
|
interface TenGigabitEthernetl/0/5
switchport access vlan 100
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switchport mode access

!

interface TenGigabitEthernetl/0/6

]

interface TenGigabitEthernetl/0/7
switchport access vlan 100
switchport mode access

!

interface TenGigabitEthernetl1/0/8
!

interface TenGigabitEthernetl/0/9
switchport access vlan 100
switchport mode access

!

interface TenGigabitEthernetl1/0/10
!

interface TenGigabitEthernetl/0/11
switchport mode trunk

interface TenGigabitEthernetl/0/12
!

interface TenGigabitEthernetl1/0/13
switchport access vlan 214
switchport mode access

!

interface TenGigabitEthernetl1/0/14
!

interface TenGigabitEthernetl/0/15
shutdown

!

interface TenGigabitEthernetl/0/16
!

interface TenGigabitEthernetl/1/1
stackwise-virtual link 1

!

interface TenGigabitEthernetl/1/2
!

interface TenGigabitEthernetl/1/3
description Connected to Port TenGigl/1/1 on 0SS-C9300-Access SW
switchport mode trunk
channel-group 11 mode desirable
service-policy input input
service-policy output output

|

interface TenGigabitEthernetl/1/4
!

interface TenGigabitEthernetl/1/5
stackwise-virtual dual-active-detection
!

interface TenGigabitEthernetl/1/6
!

interface TenGigabitEthernetl/1/7
switchport trunk allowed vlan 101,500,700
switchport mode trunk
channel-group 2 mode active

|

interface TenGigabitEthernetl1/1/8
!

interface FortyGigabitEthernetl/1/1
!

interface FortyGigabitEthernetl/1/2
|

interface TenGigabitEthernet2/0/1
description connectedToFPRNewX02B
switchport access vlan 100
switchport mode access
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!

interface TenGigabitEthernet2/0/2
]

interface TenGigabitEthernet2/0/3
!

interface TenGigabitEthernet2/0/4
switchport access vlan 100
switchport mode access

]

interface TenGigabitEthernet2/0/5
switchport mode trunk
channel-group 1 mode active
service-policy input input
service-policy output output

!

interface TenGigabitEthernet2/0/6
!

interface TenGigabitEthernet2/0/7
!

interface TenGigabitEthernet2/0/8
|

interface TenGigabitEthernet2/0/9
!

interface TenGigabitEthernet2/0/10
!

interface TenGigabitEthernet2/0/11
]

interface TenGigabitEthernet2/0/12
!

interface TenGigabitEthernet2/0/13
!

interface TenGigabitEthernet2/0/14
!

interface TenGigabitEthernet2/0/15
]

interface TenGigabitEthernet2/0/16
!

interface TenGigabitEthernet2/1/1
stackwise-virtual link 1

!

interface TenGigabitEthernet2/1/2
!

interface TenGigabitEthernet2/1/3
description Connected to Port TenGigl/1/2 on 0SS-C9300-Access SW
switchport mode trunk
channel-group 11 mode desirable
service-policy input input
service-policy output output

!

interface TenGigabitEthernet2/1/4
!

interface TenGigabitEthernet2/1/5
stackwise-virtual dual-active-detection
!

interface TenGigabitEthernet2/1/6
!

interface TenGigabitEthernet2/1/7
switchport trunk allowed vlan 101,500,700
switchport mode trunk

channel-group 2 mode active
|

interface TenGigabitEthernet2/1/8
!

interface FortyGigabitEthernet2/1/1
!
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interface FortyGigabitEthernet2/1/2

!
interface Vlanl

no ip address

shutdown

!
interface V1anl00

vrf forwarding Management VRF

ip address 10.10.100.1 255.255.255.0
ip pim sparse-mode

!
interface Vl1anlOl

vrf forwarding Management VRF

ip address 10.10.101.1 255.255.255.0
ip pim sparse-mode

ip ospf network point-to-point

|

interface V1anl02

vrf forwarding Management VRF

ip address 10.10.102.1 255.255.255.0
|

interface Vl1anl03

vrf forwarding Management VRF

ip address 10.10.103.1 255.255.255.0
!
interface Vlanl04

vrf forwarding Management VRF

ip address 10.10.104.1 255.255.255.0
!
interface Vl1anl05

vrf forwarding Management VRF

ip address 10.10.105.1 255.255.255.0
|

interface Vl1anll4

vrf forwarding Management VRF

ip address 172.114.0.1 255.255.0.0

|

interface Vl1an214

ip address 172.214.0.2 255.255.0.0

|

interface V1an500

vrf forwarding VnV_ VRF

ip address 172.16.50.1 255.255.255.0
ip ospf network point-to-point

|
interface V1an600

vrf forwarding VnV_VRF

ip address 172.16.60.1 255.255.255.0
--More-- !
interface V1an700

vrf forwarding OT VRF

ip address 172.16.70.1 255.255.255.0
ip ospf network point-to-point

|
interface V1an701

vrf forwarding OT VRF

ip address 172.16.71.1 255.255.255.0
|

interface vV1an800

ip address 172.16.80.1 255.255.255.0
|
interface V1an2508

ip address 169.254.1.3 255.255.255.0
|

router ospf 101 vrf Management VRF
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router-id 1.1.1.1

redistribute connected

network 10.10.101.0 0.0.0.255 area 0.0.0.0

!
router ospf 500 vrf VnV_ VRF

router-id 1.1.1.1

--More-- redistribute connected

network 172.16.50.0 0.0.0.255 area 0.0.0.0

!
router ospf 700 vrf OT VRF

router-id 1.1.1.1

redistribute connected

network 172.16.70.0 0.0.0.255 area 0.0.0.0

!
iox
ip forward-protocol nd

ip tcp selective-ack
ip tcp mss 1460
ip tcp window-size 131072
no ip http server
ip http authentication local
no ip http secure-server
ip http client source-interface V1lanlO1l
ip pim rp-address 10.10.100.1
ip pim vrf Management VRF rp-address 10.10.100.1
ip route vrf Management VRF 10.10.106.0 255.255.255.0 10.10.100.3
ip ssh bulk-mode 131072
ip ssh source-interface VlanlOl

|
ip access-list extended IXIA TRAFFIC

10 permit ip 31.0.0.0 0.255.255.255 any

!
logging source-interface Vlanl0l vrf Management VRF
logging host 192.168.6.100 vrf Management VRF

|
snmp-server group default v3 priv
snmp-server group ciscogrp v3 priv read SNMPv3All write SNMPv3None
snmp-server view SNMPv3All iso included
snmp-server view SNMPv3None iso excluded
snmp-server community ciscol23 RW
snmp-server trap-source VlanlOl
snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart
snmp-server enable traps flowmon
snmp-server enable traps entity-perf throughput-notif
snmp-server enable traps call-home message-send-fail server-fail
snmp-server enable traps tty
snmp-server enable traps eigrp
snmp-server enable traps ospf state-change
snmp-server enable traps ospf errors
snmp-server enable traps ospf retransmit
snmp-server enable traps ospf lsa
snmp-server enable traps ospf cisco-specific state-change nssa-trans-change
snmp-server enable traps ospf cisco-specific state-change shamlink interface
snmp-server enable traps ospf cisco-specific state-change shamlink neighbor
snmp-server enable traps ospf cisco-specific errors
snmp-server enable traps ospf cisco-specific retransmit
snmp-server enable traps ospf cisco-specific lsa
snmp-server enable traps bfd
snmp-server enable traps smart-license
snmp-server enable traps auth-framework sec-violation
snmp-server enable traps rep
snmp-server enable traps memory bufferpeak
snmp-server enable traps config-copy
snmp-server enable traps config
snmp-server enable traps config-ctid
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snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server

enable traps energywise

enable traps fru-ctrl

enable traps entity

enable traps flash insertion removal lowspace
enable traps power-ethernet police

enable traps cpu threshold

enable traps syslog

enable traps udld link-fail-rpt

enable traps udld status-change

enable traps vtp

enable traps vlancreate

enable traps vlandelete

enable traps port-security

enable traps envmon

enable traps stackwise

enable traps mvpn

enable traps pw vc

enable traps ipsla

enable traps dhcp

enable traps event-manager

enable traps ike policy add

enable traps ike policy delete

enable traps ike tunnel start

enable traps ike tunnel stop

enable traps ipsec cryptomap add

enable traps ipsec cryptomap delete

enable traps ipsec cryptomap attach

enable traps ipsec cryptomap detach

enable traps ipsec tunnel start

enable traps ipsec tunnel stop

enable traps ipsec too-many-sas

enable traps ospfv3 state-change

enable traps ospfv3 errors

enable traps ipmulticast

enable traps msdp

enable traps pim neighbor-change rp-mapping-change invalid-pim-message
enable traps bridge newroot topologychange
enable traps stpx inconsistency root-inconsistency loop-inconsistency
enable traps bgp cbgp2

enable traps hsrp

enable traps isis

enable traps cef resource-failure peer-state-change peer-fib-state-change

inconsistency

snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server

enable traps lisp

enable traps nhrp nhs

enable traps nhrp nhc

enable traps nhrp nhp

enable traps nhrp quota-exceeded

enable traps local-auth

enable traps entity-diag boot-up-fail hm-test-recover hm-thresh-reached

scheduled-test-fail

snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server
snmp-server

enable traps mpls rfc 1ldp

enable traps mpls 1ldp

enable traps mpls rfc traffic-eng

enable traps mpls traffic-eng

enable traps mpls fast-reroute protected

enable traps bulkstat collection transfer

enable traps mac-notification change move threshold
enable traps errdisable

enable traps vlan-membership

enable traps transceiver all

enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down
enable traps rf

enable traps mpls vpn

enable traps mpls rfc vpn
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snmp-server host 192.168.6.100 vrf Management VRF version 3 priv cisco
|
control-plane

service-policy input system-cpp-policy
!
line con O

stopbits 1
line vty 0 4

login local

transport preferred none

transport input ssh
line vty 5 15

login local

transport preferred none

transport input ssh
|
call-home

! If contact email address in call-home is configured as sch-smart-licensing@cisco.com
! the email address configured in Cisco Smart License Portal will be used as contact email
address to send SCH notifications.

contact-email-addr sch-smart-licensing@cisco.com

profile "CiscoTAC-1"

active

destination transport-method http
1
End

FAN Ring Switch Configuration (Non Edge Switch that is Not a Part of
TAN Rings)

hostname FAN-BS4

|

no aaa new-model

rep ztp

rep autodisc

ptp mode e2etransparent
vtp mode transparent
vtp version 1

|

ip domain name wf.com
1

login on-success log
!
flow exporter 192.168.6.100
destination 192.168.6.100
transport udp 6007
!
device-tracking tracking
!
device-tracking policy IPDT POLICY
no protocol udp
tracking enable
!
diagnostic bootup level minimal
!
spanning-tree mode rapid-pvst
spanning-tree extend system-id
archive
log config
logging enable
logging size 500

177


mailto:sch-smart-licensing@cisco.com
mailto:sch-smart-licensing@cisco.com

Cisco Solution for Renewable Energy — Wind Farm 1.2 Implementation Guide

Configuration Examples

memory free low-watermark processor 63461

!

errdisable recovery cause udld

errdisable recovery cause bpduguard
errdisable recovery cause security-violation
errdisable recovery cause channel-misconfig
errdisable recovery cause pagp-flap
errdisable recovery cause dtp-flap
errdisable recovery cause link-flap
errdisable recovery cause sfp-config-mismatch
errdisable recovery cause gbic-invalid
errdisable recovery cause l2ptguard
errdisable recovery cause psecure-violation
errdisable recovery cause port-mode-failure
errdisable recovery cause dhcp-rate-limit
errdisable recovery cause pppoe-ia-rate-limit
errdisable recovery cause mac-limit
errdisable recovery cause vmps

errdisable recovery cause storm-control
errdisable recovery cause inline-power
errdisable recovery cause arp-inspection
errdisable recovery cause loopback
errdisable recovery cause psp

errdisable recovery cause mrp-miscabling
errdisable recovery cause loopdetect

!

alarm-profile defaultPort

alarm not-operating

syslog not-operating

notifies not-operating

|

enable secret 9 $9$SWvAxOEesAzfnN.SmRkA6cTyFxVetsh9504kUwfrc8RwWL6bLTpBCrpmk3iX.
|
username dna privilege 15 secret 9
$95yDOgMvOokBXORESGNMGIxJJEFgqdauVE/VUwO. /tvTz5TSeuKyWXarTFwic
!
transceiver type all

monitoring
vlan internal allocation policy ascending

|
vlan 101

1ldp run

!

interface GigabitEthernetl/1

description PNP STARTUP VLAN

switchport trunk allowed vlan 1-2507,2509-4094
switchport mode trunk

rep segment 12

rep ztp-enable

|

interface GigabitEthernetl/2

switchport trunk allowed vlan 1-2507,2509-4094
switchport mode trunk

device-tracking attach-policy IPDT POLICY
rep segment 12

rep ztp-enable

!

interface GigabitEthernetl/3

device-tracking attach-policy IPDT POLICY

1

interface GigabitEthernetl/4

device-tracking attach-policy IPDT POLICY

!

interface GigabitEthernetl/5

device-tracking attach-policy IPDT POLICY
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!

interface GigabitEthernetl/6

device-tracking attach-policy IPDT POLICY

!

interface GigabitEthernetl/7

device-tracking attach-policy IPDT POLICY

!

interface GigabitEthernetl/8

device-tracking attach-policy IPDT POLICY

!

interface GigabitEthernetl/9

device-tracking attach-policy IPDT POLICY

!

interface GigabitEthernet1l/10

device-tracking attach-policy IPDT POLICY

|

interface AppGigabitEthernetl/1

!

interface Vlanl

no ip address

shutdown

|

interface VlanlO1l

ip dhcp client client-id ascii cisco-0029.c23c.598b-V1101
ip address dhcp

!
no ip http server

ip http authentication local
no ip http secure-server

ip http client source-interface Vl1anlOl

ip forward-protocol nd

!

ip ssh bulk-mode 131072

ip ssh source-interface V1anlOl

ip scp server enable

!

logging source-interface VlanlO1l

logging host 192.168.6.100

!

snmp-server group DNACGROUPAuthPriv v3 priv read DNAC-ACCESS write DNAC-ACCESS
snmp-server view DNAC-ACCESS iso included

snmp-server trap-source VlanlOl

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart
snmp-server enable traps flowmon

snmp-server enable traps call-home message-send-fail server-fail
snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change
snmp-server enable traps ospf cisco-specific state-change shamlink interface
snmp-server enable traps ospf cisco-specific state-change shamlink neighbor
snmp-server enable traps ospf cisco-specific errors
snmp-server enable traps ospf cisco-specific retransmit
snmp-server enable traps ospf cisco-specific lsa
snmp-server enable traps power-ethernet police

snmp-server enable traps rep

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps envmon

snmp-server enable traps cpu threshold

snmp-server enable traps vtp

snmp-server enable traps vlancreate
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snmp-server enable traps vlandelete
snmp-server enable traps flash insertion removal lowspace
snmp-server enable traps port-security
snmp-server enable traps cisco-sys heartbeat
snmp-server enable traps auth-framework sec-violation
snmp-server enable traps smart-license
snmp-server enable traps event-manager
snmp-server enable traps ipsla
snmp-server enable traps transceiver all
snmp-server enable traps ike policy add
snmp-server enable traps ike policy delete
snmp-server enable traps ike tunnel start
snmp-server enable traps ike tunnel stop
snmp-server enable traps ipsec cryptomap add
snmp-server enable traps ipsec cryptomap delete
snmp-server enable traps ipsec cryptomap attach
snmp-server enable traps ipsec cryptomap detach
snmp-server enable traps ipsec tunnel start
snmp-server enable traps ipsec tunnel stop
snmp-server enable traps ipsec too-many-sas
snmp-server enable traps bfd
snmp-server enable traps config-copy
snmp-server enable traps config
snmp-server enable traps config-ctid
snmp-server enable traps bridge newroot topologychange
snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency
snmp-server enable traps syslog
snmp-server enable traps bgp cbgp2
snmp-server enable traps dhcp
snmp-server enable traps hsrp
snmp-server enable traps ipmulticast
snmp-server enable traps isis
snmp-server enable traps msdp
snmp-server enable traps ospfv3 state-change
snmp-server enable traps ospfv3 errors
snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message
snmp-server enable traps entity-diag boot-up-fail hm-test-recover hm-thresh-reached
scheduled-test-fail
snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change
inconsistency
snmp-server enable traps pimstdmib neighbor-loss invalid-register invalid-join-prune rp-
mapping-change interface-election
snmp-server enable traps errdisable
snmp-server enable traps vlan-membership
snmp-server enable traps alarms informational
snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down
snmp-server enable traps bulkstat collection transfer
snmp-server enable traps mac-notification change move threshold
snmp-server enable traps rf
snmp-server host 192.168.6.100 version 3 priv cisco
|
control-plane
|
line con 0
exec-timeout 0 0
stopbits 1
line aux 0
line vty 0 4
login local
transport preferred none
transport input ssh
line vty 5 15
login local
transport preferred none
transport input ssh
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!
call-home
! If contact email address in call-home is configured as sch-smart-licensing@cisco.com
! the email address configured in Cisco Smart License Portal will be used as contact email
address to send SCH notifications.
contact-email-addr sch-smart-licensing@cisco.com
profile "CiscoTAC-1"
active
destination transport-method http
|
pnp profile pnp-zero-touch
transport https ipv4 192.168.6.100 port 443
pnp startup-vlan 101
End

QoS on |E-3400

Extended IP access list OT TRAFFIC
10 permit ip 172.10.0.0 0.255.255.255 any
!

class-map match-any ot traffic
match access-group name OT TRAFFIC

class-map match-any network control
match ip dscp cs2

class-map match-any bulk data
match ip dscp afll

class-map match-any video
match ip dscp af4l

class-map match-any voice
match ip dscp ef

class-map match-any scavenger
match ip dscp csl
!

policy-map input
class voice
set dscp ef
class video
set dscp af4l
class ot _traffic
set dscp af2l
class network control
set dscp cs2
class bulk data
set dscp afll
class scavenger
set dscp csl
class class-default
set dscp default
|
policy-map output
class voice o
priority
class video_ o
bandwidth remaining percent 10
class ot traffic o
bandwidth remaining percent 10
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class network control o
bandwidth remaining percent 20
class bulk data o

bandwidth remaining percent 15
class scavenger o

bandwidth remaining percent 15
class class-default

bandwidth remaining percent 10

interface TenGigabitEthernet 1/1
service-policy input input
service-policy output output

QoS on FAN Aggregation and on the OSS and ONSS (C-9300/C-9500)

!
Extended IP access list OT TRAFFIC

10 permit ip 172.10.0.0 0.255.255.255 any
!

class-map match-any ot traffic
match access-group name OT TRAFFIC

class-map match-any network control
match ip dscp cs2

class-map match-any bulk data
match ip dscp afll

class-map match-any video
match ip dscp af4l

class-map match-any voice
match ip dscp ef

class-map match-any scavenger
match ip dscp csl
!
policy-map input
class voice
set dscp ef
class video
set dscp af4l
class ot _traffic
set dscp af2l
class network control
set dscp cs2
class bulk data
set dscp afll
class scavenger
set dscp csl
class class-default
set dscp default

|
policy-map output
class voice o
priority level 1
class video o
bandwidth remaining percent 10
class ot traffic o
bandwidth remaining percent 10
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class network control o
bandwidth remaining percent 20
class bulk data o

bandwidth remaining percent 15
class scavenger o

bandwidth remaining percent 15
class class-default

bandwidth remaining percent 10

interface TenGigabitEthernet 1/1
service-policy input input
service-policy output output

!
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Appendix B: Cisco Catalyst Center Day N
Templates

Cisco Catalyst Center templates can be used to apply configurations to multiple switches at a time. The following are various templates
that can be created on Cisco Catalyst Center for easy configuration changes on wind farm devices.

VLAN Creation

vlan $vlan id
name $vlan name

Vrf Creation

vrf definition $VRF name
rd $rd:1
!
address-family ipv4
route-target export $rd:1
route-target import S$rd:1
exit-address-family

VLAN Interface Creation and Addition of a VRF

interface Vlan$vlan id

vrf forwarding S$VRF name

ip address 10.10.$vlan id.1 255.255.255.0
!

Port-channel Creation

interface $int one

channel-group $PCNo mode desirable
no shut

interface $int two

channel-group $PCNo mode desirable
no shut

Shut/Unshut an Interface

#if (Sshut == 1)
interface $int name
shutdown

#else

interface $int name
no shut

#end
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Appendix C: Turbine Operator Network
Configuration

9300 Switch:

hostname SCADA-C9300-1

!

!
vrf definition Mgmt-vrf

!

address-family ipv4

exit-address-family

!

address-family ipvé

exit-address-family

!

aaa new-model

aaa local authentication MACSEC-UPLINK authorization MACSEC-UPLINK
!

!

aaa authentication dotlx default group radius local

aaa authentication dotlx MACSEC-UPLINK local

aaa authorization exec default local
aaa authorization network default group radius local
aaa authorization network MACSEC-UPLINK local
aaa authorization auth-proxy default group radius
aaa authorization credential-download default local
aaa authorization credential-download MACSEC-UPLINK local
aaa accounting identity default start-stop group radius
|

|
aaa attribute list MUST-SECURE

attribute type linksec-policy must-secure

!
aaa session-id common
clock timezone UTC 5 30
boot system switch all flash:cat9k iosxe.BLD POLARIS DEV LATEST 20231115 063559 V17 14 0 13.SSA.bin
switch 1 provision c¢9300-24ux
eap profile EAP-PROFILE

method tls

pki-trustpoint CA

ip routing
!

ip multicast-routing
ip domain name wf.com
!

!

!

login on-success log

vtp mode transparent

!

!
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|
!
!
!
!

access-session mac-move deny
|
key chain MAC-SEC macsec
key 4000000000000000000000000000000000000000000000000000000000000000
cryptographic-algorithm aes-128-cmac
key-string CAFECAFECAFECAFEOCAFEOCAFEOCAFEOQ
lifetime local 00:00:00 Jan 1 1993 infinite
crypto pki trustpoint SLA-TrustPoint
enrollment pkcsl2
revocation-check crl
hash sha256
|
crypto pki trustpoint TP-self-signed-1953829722
enrollment selfsigned
subject-name cn=I0S-Self-Signed-Certificate-1953829722
revocation-check none
rsakeypair TP-self-signed-1953829722
hash sha256
|
crypto pki trustpoint my-trustpoint
enrollment terminal pem
serial-number none
ip-address 10.10.101.25
subject-name C=IN, ST=KAR, L=BLR, O=cisco, OU=IOT, CN= SCADA-C9300-1-Y819.wf.com
subject-alt-name SCADA-C9300-1-Y819.wf.com
revocation-check none
rsakeypair my-4096rsa-key
hash sha256
|
crypto pki trustpoint CA
enrollment url http://10.20.200.1:80
serial-number
ip-address none
subject-name CN=Y819
revocation-check none
rsakeypair my-4096rsa-key
hash sha512
|
|
crypto pki certificate chain SLA-TrustPoint
certificate ca 01
30820321 30820209 A0030201 02020101 300D0609 2A864886 F70D0101 0B0O50030
32310E30 0C060355 040A1305 43697363 6F312030 1E060355 04031317 43697363
6F204C69 63656E73 696E6720 526F6F74 20434130 1E170D31 33303533 30313934
3834375A 170D3338 30353330 31393438 34375A30 32310E30 0C060355 040A1305
43697363 6F312030 1E060355 04031317 43697363 6F204C69 63656E73 696E6720
526F6F74 20434130 82012230 0D06092A 864886F7 0D010101 05000382 010F0030
82010A02 82010100 A6BCBD96 131E0S5F7 145EA72C 2CD686E6 17222EAl F1lEFF64D
CBB4C798 212AA147 C655D8D7 9471380D 8711441E 1AAF071A 9CAE6388 8A38ES520
1C394D78 462EF239 C659F715 B98COA59 5BBBSCBD OCFEBEA3 700A8BF7 D8F256EE
4AA4E80D DB6EFDICY9 60B1FD18 FFC69C96 6FA68957 A2617DE7 104FDCSF EA2956AC
7390A3EB 2B5436AD C847A2C5 DABS53EB 69A9A535 58E9F3E3 COBD23CF 58BD7188
68E69491 20F320E7 948E71D7 AE3BCC84 F10684C7 4BC8EOOF 539BA42B 42C68BB7
C7479096 B4CB2D62 EA2F505D C7B062A4 6811D95B E8250FC4 5DS5DSFB8 8F27D191
C55F0D76 61F9A4ACD 3D992327 A8BBO3BD 4E6D7069 7CBADF8B DESF4368 95135E44
DFC7C6CF 04DD7FD1 02030100 01A34230 40300E06 03551DOF 0101FF04 04030201
06300F06 03551D13 0101FF04 05300301 O1FF301D 0603551D 0E041604 1449DC85
4B3D31E5 1B3E6A17 606AF333 3D3B4C73 E8300D06 092A8648 86F70D01 010B0500
03820101 00507F24 D3932A66 86025DI9F EB838AESC 6D4DF6BO 49631C78 240DA905
604EDCDE FFAFED2B 77FC460E CD636FDB DD44681E 3A5673AB 9093D3B1 6C9E3D8B
D98987BF E40CBDY9E 1AECA0C2 2189BB5C 8FA85686 CD98B646 5575B146 8DFC66A8
467A3DF4 4D565700 6ADFOFOD CF835015 3CO4FF7C 21E878AC 11BA9CD2 55A9232C
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B1FCF9BB E973DE7F 5BDDEB86
07B85737 F3A58BE1l 1A48A229
8428787B 35202CDC 60E4616A
27E86F73 932E35B5 8862FDAE

TCATBTE6
5FBODAOG
80DDCD16
418616A9
D697DFTF

ClAFT74F6

152E99B7

BO2AFE7F 494E8A9E
D6BACECA EEBC7CF9

4093E049
28

quit
crypto pki certificate chain
certificate self-signed 01

30820330
31312F30
69666963
31365A17
4F532D53
32393732
0A028201
B1892FE7
53ED1714
8B66AD78
1BBDACF4
AF6A3E3B
BD88DBEC
5DD8D4A5
AOC6ABTD
301F0603
04301D06
300D0609
1DA22230
62FFD115
78F6E593
6098AB82
F7E949CB
68037219
70B3653E
ClEAIBCY

30820218
2D060355
6174652D
0D333330
656C662D
32308201
0100D294
3D3B6A8D
AF004717
CA1BD6AF
C034D861
38F8C847
262F5A60
86C2A603
616B0203
551D2304
03551D0E
27864886
7800F903
7241F686
F436165D
2E74937E
1908D833
8C64280A
7120FACC
85129630

quit
crypto pki certificate chain
certificate 5D0000000834C9B4516C9B5106000100000008

30820557
0008300D
4E2D504E
5A170D32
0C300A06
0355040A
04031319
22300D06
F959BE09
2D57D51B
704F916E
316BBDA2
9C5785E5
1F5A0980
3B084036
92CE8947
92AD4866
ClFFD219
A1F8C82D
E294571E
B59BE661
622EBI9EE
62774746
E92B0AAZ
010001A3
1D301B82
0603551D
03551D23
0603551D
3137554A
3348564F

3082043F
06092A86
3137554A
34313031
03550408
13056369
53434144
09278648
70AFOEBS
D1982A85
TC28EBCO
OFC3CF4C
5BOB7F4D
DB276F4B
36B454E3
B56AE(037
AGF957B4
CEEA25BC
989248A8
30532138
BA3D67A0
A195BB18
789DC676
AQC98E9B
82014030
19534341
0E041604
04183016
1F044730
54334856
2D434128

4D10AB75

A0030201
04031326
31393533
39303931
5369676E
22300D06
2D74E554
8ED577B6
09413FC9
9C6508FB
6FDI9A6CC
4000697B
77F9C033
C7102E54
010001A3
18301680
04160414
F70D0101
FCE40A0C
99D4658C
94C522FB
EDE1B3CB
5FD07E34
3F77509D
4CE4FAEA
7324C06C

A0030201
4886F70D
54334856
37303733
13034B41
73636F31
412D4339
86F70D01
ECO03303E
5138057D
8CE99372
170277BA
ED2A9364
BO9E167E3
8EES509FF
CF6DE834
3D323793
2A37FD92
16ACC6B6
C74BA5CA
03975084
E190A3EC
FF46CDBO
80067B5A
82013C30
44412D43
148707B2
8014423B
453043A0
4F2F4365
31292E63

TP-self-signed-1953829722

02020101
494F532D
38323937
34323031
65642D43
09278648
D2C51BB8
F3904883
EA864694
8507701B
F598A52F
C59FDD21
EB300981
BE29DE18
53305130
149AD8CS8
9AD8C8B5
05050003
0E008520
70BD7BFES
33B8FES5S
1CF943A4
F15C961A
33FCLEFO
38FE81DF
F2402E14

300D0609
53656C66
3232301E
365A3031
65727469
86F70D01
0OACA158C
OBOE82ED
53BD97C6
67CEFADY
06FADEA3
D4398617
F7F61A04
CF96E010
0F060355
B507AEE7
07AEE7B4
82010100
D4F1D7B6
CEE86844
98DODEOF
9B3FD21F
6DFA5AAQ
01552480
FAC4AT7CC
3CF7COF8

my-trustpoint

0202135D
01010BO5
4¥2D4341
3934355A
52310C30
0C300A06
3330302D
01010500
208BC446
F42EFEDC
TE3AT4F4
958D82DC
E34BE545
279841B2
BE4545C2
14CCBBDC
89704661
97BE765A
2E6BEFB6F
95DACDB4
963D1A1B
41458CF4
862F378B
OD30B3FA
0B060355
39333030
FA3A3D1E
8ABE6F52
41A03F86
7274456E
726C3069

00000008
00301D31
301E170D
306B310B
0A060355
0355040B
312D5938
0382020F
2ED3DDBS8
724A2D99
243BC6DE
BB7538C8
4E233C58
CD3AC307
6A49F535
848493FD
A730CC80
39969A9E
349AD372
OF7EBC80
E9462B96
C8CB5S17F
07EECOAF
1DD62ACB
1D0F0404
2D312D59
0B80517A
4DF00C73
3D66696C
726F6C6C
06082B06

27864886
2D536967
170D3233
312F302D
66696361
01010500
4F501283
572EB121
624E767C
1F9DBCY6
B6AD8CD6
48EF3791
25824B96
7AR06298
1D130101
B4230FFF
230FFF5C
2C228cC2C
A5E465F4
63A6FC3B
AF1EAES82
D429B5B8
16849D4D
2D5FFC4D
68896E8F

34C9B451
1B301906
32333130
30090603
04071303
1303494F
31392E77
00308202
CDBD9999
9B32F7E9
BF520D5D
12ADB3FD
F01D9398
828A8874
777BBB86
FC8E6BDS
874765D2
4366BA1A
C46D3E70
23106216
44BD25BD
55751976
6FB327EA
65ACTEL2
030205A0
3831392E
DBF6B2C2
041BSCBC
653A2F2F
2F57494E
01050507
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C71E3B49 1765308B
C37C1lE69 39F08678
B623CDBD 230E3AFB
0275156F 719BB2F0

F70D0101
6E65642D
30393130
06035504
74652D31
0382010F
28D76C6E
5760527A
AF2EFDBO
D1AA5609
E6D59760
7038C44E
D83DA37D
4E712F53
FF040530
5CA8E098
A8E0984C
05BE9ACA
708D8ECC
9F999E5B
E449B4F2
FO0883CEE
E498336A
E50D7533
9D1F70AA

6C9B5106
03550403
31373037
55040613
424C5231
54312230
662E636F
0A028202
5C288A8D
F38D6952
95F0ABOL
E942EAT2
577565D2
5DE23A36
TATADOBS8
B82B7B50
A3FCOCES
17545C23
88C628AC
4FC30798
4CE94410
3C8608E5
2C8978E8
19804EES8
30240603
77662E63
60532F77
2F5FE804
2F2F5749
2D504E31
0101045D

05050030
43657274
31343230
03132649
39353338
00308201
FOES2941
49560B0A
BES1FBDA
99A1FE32
ACI9C59D2
D92729F9
EF645079
34ECF102
030101FF
4C899939
89993904
9B2B60AC
OEFAE2A3
BCF1F558
02B7273B
D7027576
12F798F7
A49B8552
FDEBO75B

00010000
13125749
32393435
02494E31
0E300C06
20060355
6D308202
0100C111
DOFC1BD9
44E09CB7
89A464F5
1A37357E
OBFB26F6
6E71DB49
2F173F87
16507BEB
55C3EDB6
402BC449
29F2F282
8BE752F3
DE68A4B4
94DC820D
BEAF6ADE
278D0203
551D1104
6F6D301D
BB301F06
E4D1304E
4E2D504E
37554A54
305B3059
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06082B06
3348564F
57494E2D
0101FF04
A34D9F1A
50B37939
F5A9010A
4DE9A8SE
A50AF024
CC40935F
0698E537
D78C25C9

01050507
2F436572
504E3137
02300030
4F185EA7
02D53E07
70787C97
F7524FCF
BDA19225
TAAEAQOQF
BDA94EQF
86418D3D

quit
certificate ca 5E67662095B742BD41CAO0F583A64E1E6

3082033C
0D06092A
4E313755
32383130
3137554A
82010F00
1183ABF1
28ABCBOE
6C7BC494
09C2C325
EF6CF25F
560DF96A
2D63AB74
E9C62CFC
02018630
3B8ABEGF
04050203
B85013E2
2DA1A14F
5BDCD3DD
DOE8756F
BOAA45BF
DD63063D
8DB8OFOEA
AO3D7D95
8864BCC3

30820224
864886F7
47543348
30393135
54334856
3082010A
EABEFF63
CAGE8837
626FFT74A
D77B05S1E
1952D54C
45F3737E
3D882156
35C4FEAS8
0F060355
524DF00C
01000130
EEAG63F49
53FB976A
1FF865B9
5753C899
0393E97D
FD74CC5B
588711E5
41385914
4D535DA7

quit
crypto pki certificate chain
certificate 08

30820525
OE310C30
170D3235
313C3012
01090216
0222300D
11F959BE
D92D57D5
B7704F91
F5316BBD
TESC5785
F61F5A09
493B0840
8792CE89
EB92AD48
B6C1FFD2
49A1F8C8
82E29457
F3B59BE6
B4622EB9
0D627747
DEE92B0OA
03010001
80141307
148707B2

3082030D
0A060355
30313230
06035504
19534341
06092A86
0970AF0E
1BD1982A
6E7C28EB
A20FC3CF
ES55BOB7F
80DB276F
3636B454
47B56AE0Q
66A6F957
19CEEA25
2D989248
1E305321
61BA3D67
EEA195BB
46789DC6
A2A0C98E
A34F304D
525E8608
FA3A3D1E

3002864D
74456E72
554A5433
0D06092A
1D6AS788
C20F7AB7
516EF1CA
6A9E40AE
D8B8BD3E
B725776B
87005150
33B27ACS

A0030201
0D01010B
564F2D43
31333530
4F2D4341
02820101
C4093F0E
95921E49
2A41C6EE
9434AE78
4C720DB4
38629125
ESAE6T7A3
CF6BDEDO
1D130101
73041BOC
2306092B
EE18DCDC
659254D9
BE150462
EC42E405
75A9F6B6
CB67FF92
84A32459
B84084CD
ECD51219

A0030201
04031303
31333537
05130B46
44412D43
4886F70D
B5EC0330
85513805
CO8CE993
4C170277
4DED2A93
4BBO9E167
E38EES509
37CF6DES
B43D3237
BC2A37FD
A816ACC6
38C74BA5S
A0039750
18E190A3
T6FF46CD
9B80067B
300B0603
9D1968D8
0B80517A

66696C65
6F6C6C2F
48564F2D
864886F7
1EB3DD17
3DCFDF4F
73719002
81F72CA3
COCBD982
1042D81E
FF623F50
CFC9D968

0202105E
0500301D
41301E17
5A301D31
30820122
00BD39BA
5178777A
BOA04591
3EF37587
315B022B
C38B9AES
S5FADB62D
552308EC
DF020301
FF040530
BC2F5FES8
06010401
300D0609
D8109290
48434289
B10580B9
231D5B2E
7158C26B
3B6EBBB2
3E8A21BC
CC6BB7C9

CA

02020108
49535230
34375A30
4F433237
39333030
01010105
3E208BC4
TDF42EFE
T27F3AT74
BA958D82
64E34BES
E3279841
FFBE4545
3414CCBB
93897046
9297BE76
B62E6BEB
CA95DACD
84963D1A
EC41458C
BO862F37
5A0D30B3
551D0F04
F1F23140
DBF6B2C2

3A2F2F2F
57494E2D
43412831
0D01010B
5F77FD0O3
C9DF6006
6263B7CA
5E357A67
08B6303C
537BBC3A
DI9F90845
484DA38A

67662095
311B3019
0D323331
1B301906
300D0609
8D15127C
A58ABOA7
5E3C2C2B
E58F8945
63C14E37
41DA0D76
2DADE789
4DOEOE21
0001A378
030101FF
04E4D130
82371502
27864886
T7CFAE352
D907BEO07
7224E8DO0
1463A83C
AS5B6DSAF
22A814C1
7197CCFE7
9DC99B2C

300D0609
1E170D32
4D310D30
31325938
2D312D59
00038202
462ED3DD
DC724A2D
F4243BC6
DCBB7538
454FE233C
B2CD3AC3
C26A49F5
DC848493
61A730CC
5A39969A
6F349AD3
B40F7EBC
1BE9462B
F4C8CB51
8BO7EECO
FA1DD62A
04030205
CD3DAT76E
60532F77

2F57494E
504E3137
292E6372
05000382
6FF7F384
75776435
1A06E2BO
448D6522
5A6A1897
172765BD
EF70BES8B
6609533D

B742BD41
06035504
30303930
03550403
27864886
5A4E3239
4FC537A2
1EEB3C86
84EB6854
E0602A68
CBDD67AS
0F2997B8
DEEAB596
3076300B
301D0603
1206092B
04160414
F70D0101
F1AD8BF4
221DD566
4D43A675
BA539DCS8
7DBC8CB4
C333F34B
A44CB1FB
B86B4A55

27864886
34303132
0B060355
31393026
3831392E
0F003082
B8CDBD99
999B32F7
DEBF520D
C812ADB3
58F01D93
07828A88
35777BBB
FDFC8E6B
80874765
9E4366BA
72C46D3E
80231062
9644BD25
7F557519
AF6FB327
CB65ACTE
AO0301F06
D144301D
BB300D06

188

2D504E31
554A5433
74300C06
01010060
92EF37A0
7D6516B4
59A3A089
18CB2C5E
D53C013B
1697A0E3
E0383F8E
BA8759

CAOF583A
03131257
39313030
13125749
F70D0101
A91B657C
FC844FEO
TA389A57
C3B30689
2FC91A11
39D01535
338E0C14
BODF78CB
0603551D
551D0EO4
06010401
92052E45
0B050003
752D9791
AE368E55
08E421E8
COC703A0
3DD33EA4
CC373875
26F0ETF2
2BA25D48

F70D0101
31313335
04031304
06092A86
77662E63
020A0282
995C288A
E9F38D69
5D95F0AB
FDE942EA
98577565
745DE23A
867ATADO
D8B82B7B
D2A3FCOC
1A17545C
7088C628
164FC307
BD4CE944
763C8608
EA2C8978
1219804E
03551D23
0603551D
092A8648

37554A54
48564F5F
03551D13
985C7255
8BEF7DBBF
B2DB7B88
53F16486
4F2DCAEF
00CDB8F9
ES51DEC8A
8EE66COF

64E1E630
494E2D50
395A170D
4E2D504E
01050003
EB737C6C
DA345F8C
5A3C147D
TTARTAT4
B9083FD9
E27BF364
503BE66A
D7F4B3BA
0F040403
16041442
82371501
E2E20D2B
82010100
6114E46F
6A0B7DEF
8667A4E6
3B149D72
F9A44706
77BS089D
B1E77562
2128307D

0D050030
3734375A
59383139
4886F70D
6F6D3082
020100cC1
8DDOFC1B
5244FE09C
01897464
721A3735
D20BFB26
366E71DB
B82F173F
5016507B
ES55C3ED
23402BC4
AC29F2F2
988BE752
10DE68A4
E594DC82
E8BEAF6A
E8278D02
04183016
0E041604
86F70D01
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010D0500 03820201
AEFOEFEB 5138163C
54400113 197B6B15
FA14483B 3E238447
19AC6C00 D99AADID
D50A52F8 AEBBE7B7
71FB2861 06C7E640
D10EOS5A1 6E761E94
B1205388 E343FE64
EE111723 B688AGCE
6E1FA2D4 3BEC97B3
A6100C93 3CE41AC1l
C1lFD37F9 3AA573CB
D53DFD16 9A89C955
12EC2607 73F234FE
2E2D6EFE 0B2CC57E
8D7251C2 74755EC3
quit
certificate ca 01
308204FA 308202E2
0E310C30 0A060355
170D3236 31323231
82022230 0D06092A
C93FCBD8 F9044D93
DOF10B77 DC368C25
4EEEB656 D4374570
075D2689 BCC92916
362067CD 072D3285
60BBF346 F1957919
092C3546 C94EO0E19
5B2E2AD8 7C3CFBED
3D83213B 5ADBCBD5S
61385435 F20B03C6
B4E228EF AE5764BA
TE606F4B 68ACDE7B
9E3575FD DF3ACCF6
0C13A497 D8CLFEFF
B7231AD3 5CA1C579
D6E2F32C C864A2ED
02030100 01A36330
OF0101FF 04040302
D8F1F231 40CD3DA7
F1F23140 CD3DA76E
B8AD3E39 A6B19533
AE86430A E5F6399B
237357F6 0525D0E1
A754FCES5 B8758B34
07F2270F 1768CAQF
F6BBABE8 91046FC9
0419B1lEF 711A2C8E
D8FOA1E9 33D4E7C6
DO0790E88 31482F89
6C705E59 32985A51
02D1143D 7A8121D2
78BFC763 6E909872
FDAE7A33 DEES55B66
8B1A9DSF 2ACA1518
FF88F098 6638D179
A9700577 591F02AF
92
quit
|
|

license boot level network-advantage addon dna-advantage

009868EC
21C4680C
165908FC
4C1C1D18
DODDC15E
1C73E9E6
4EF3912C
9A1ACT22
404F06EC
D1934BC4
80D6B144
ED1A8B82
98BDCF69
FF461104
E135B13C
42BAFATE
71

A0030201
04031303
30363131
864886F7
TFD17F8C
31C4018E
A2923C21
0BEF88269
3A4046D7
CF6787D9
352E5815
760D92E9
B6ED1E44
D8FF9047
85094A44
S5F55AEE4
04E8C549
34AA67TEE
D79FD49D
327FA8FS
61300F06
0186301F
6ED14430
D144300D
3D029858
8B95AA07
4B2CAEE1
082A4BOF
90AEB12A
E37558EE
BC25E628
D90429BD
410D7A31
FOB10AlS8
21EFDE23
TAC5939C
FB52B3AE
CF24DC21
62F1FATE
FD3DBO2F

4441CD5SE
93A26F1A
7731C2B5
DB6FB924
OEA3C320
24EB218B
0AE53391
S5ADCDI1BB
920A9547
FE8808C3
A4E55A67
EDO2B33A
546FC2A3
EF578A6F
B5409A5F
AGE2FA40

02020101
49535230
31355A30
0D010101
F7A466CE
AB3AABD1
788364DD
1509DE8C
OAA2CBDF
0032295F
289419BA
FE5C4382
424F2372
95F14E8E
3BEEC94E
7084FA8D
0A76486C
42922309
30E24DEF
6A3DB351
03551D13
0603551D
1D060355
06092A86
35FC67B7
C2C1ADCS8
9C331260
8015A7C6
35AF668A
433BATFD
F2738D58
BAE9545F
3CC376CA
96252952
9C934085
B593A376
01818D63
8182A63A
026FAQSE
D8390514

DO2B96AF
1BFC886A
FCDAT715F
268F9ASF
6EA9BO7E
4E102D2D
929AC6CB
3F1D1066
F603C3C5
740BBFES
BAABSE1D
E790648D
04F1CC30
FB19CE99
E298D96D
AETCFEF359

300D0609
1E170D32
OE310C30
05000382
86303FB7
A2A33AA0
ABAATF51
10537C63
23F5A28C
D2796DAF
B2C840FD
85E73DES
B670FF9F
COF2545E
A6779A0D
C6C44BOA
E6D5F6C3
9D7E876F
DD93905D
A254182B
0101FF04
23041830
1DOEO416
4886F70D
CEF78131
ADSOECB5S
491421E0
09DD11CE
945721B5
19F16F4E
F9547857
EAESFT78E
5375D649
80DFBBFA
42835E29
FOO31BE3
5FE54C28
97166FF5
A5633F1l6
F3A812D7

BO94FAFE3
9E3E3579
461185F7
FAT7505F2
ESAQ7616
FO9BD3EBY
4E1D52EC
5915D68B
99645A41
E6BOD297
792BFTE6
AQAGFITE
65F70606
3B74F9CC
BEB5A35C
DAFO8F7B

27864886
33313232
0A060355
020F0030
961EF078
2DOF8606
F3E4099E
8A03D129
3B5B8551
E508294F
OAFCA295
8559B059
CD87DC38
A632418F
B3239873
06445DB7
CE7CT75F1
F3985091
8CD1FEB7
D4ACCO070
05300301
16801413
04141307
01010D05
AD879855
F5B42F69
AOOAAE96
5CE1A7BE
ABBB2641
1C4FALl4A
22C6CBDF
D48662B8
ABF76307
BE7A9605
CE11C60B
B428A015
95706297
7555D85F
4FB6B514
9E76BF4B

service-template DEFAULT LINKSEC POLICY MUST SECURE

linksec policy must-secure
service-template DEFAULT LINKSEC POLICY SHOULD SECURE

linksec policy should-secure
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DBO96EB1
2BO6DF9E
D7AB645E
B964B47A
0DC33612
6E4FE67B
B21928D4
7DC844FD
E74C1883
5F762F38
E9483963
8C345279
308549CF
11E66795
35B59F57
B9421015

F70D0101
32303631
04031303
82020A02
32735D8B
C34DF26F
5EB4CAAS
30792797
CB46C313
F49664B9
3FA7B91D
A2F9D88C
A4EB3D65
9C79141B
40B77AD9
CD32D8C7
0486FCOE
4A9024C2
56F1111F
DEABFE4C
01FF300E
07525E86
525E8608
00038202
B2C70CBD
028EFE47
FE196B18
26447759
B31B8D88
8E06217B
D79C27B0
2B6FD7B4
C5A6E5E9
4B8060A6
8A1452FE
CO07941FF
5D448562
84BCFEF8FE9
EBF135F5
2C2CBDA3

FAF7FD9D
DD84CC9C
3BB80E4E
05B48C89
50F5261A
779ED34C
0D06A483
ECC1EAE9
D4FADDSF
C42941F6
6217F0C9
6E43C903
2D51FDO03
15631337
83DA8084
Cl4E469C

0D050030
3131355A
49535230
82020100
B55E6105
E877546A
29EOFEOA
3EDA3630
F23430BC
D7031865
4E06CEEF
00F942C6
D8DES59F1
6C352661
FAA25B81
EE37393C
16BF7DB6
E62151F1
BE1D1E74
915FBCB9
0603551D
089D1968
9D1968D8
0100C5ED
4E9D7D4A
D551E18B
A43E9D54
FAFCT73A6
CE098C19
5A3469D0
52E36EC5
8405B1A7
59827A8E
98790B17
160BCFOD
AlEF4C63
3A380D9C
CF60DBBA
441CE34C
DA
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service-template DEFAULT CRITICAL VOICE TEMPLATE
voice vlan
service-template DEFAULT CRITICAL DATA TEMPLATE
service-template webauth-global-inactive
inactivity-timer 3600
dotlx system-auth-control
dotlx credentials DOT1X-CREDS
username usr-macsec
pki-trustpoint CA
!
memory free low-watermark processor 131696
!
diagnostic bootup level minimal
!
spanning-tree mode rapid-pvst
spanning-tree extend system-id
!
!
!
mka policy MKA-POLICY
key-server priority 150
sak-rekey interval 65535
!
!
!
username usr-macsec aaa attribute list MUST-SECURE
|
redundancy
mode ssoO
!
!
!
transceiver type all
monitoring
!
vlan 5
name Multicast VLAN
!
vlan 10
name PrivateVLANvlan
private-vlan primary
private-vlan association 101,102
|
vlan 20
name IXIA TrafficTestVLAN
!
!

vlan 101
name isolated VLAN

private-vlan isolated

|

]
vlan 111

name Management VLAN

|

|

!

1ldp run

!

!
policy-map type control subscriber DOT1X-MUST-SECURE-UPLINK
event session-started match-all

10 class always do-until-failure
10 authenticate using dotlx aaa authc-list MACSEC-UPLINK authz-list MACSEC-UPLINK both
event authentication-failure match-all
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10 class always do-until-failure
10 terminate dotlx
20 authentication-restart 10
event authentication-success match-all
10 class always do-until-failure
10 activate service-template DEFAULT LINKSEC POLICY MUST SECURE
|

policy-map system-cpp-policy

service-policy type control subscriber DOT1X-MUST-SECURE-UPLINK
!

interface Port-channell
switchport mode trunk

!

interface GigabitEthernet0/0

vrf forwarding Mgmt-vrf

no ip address

shutdown

negotiation auto

!

interface TenGigabitEthernetl/0/1
switchport mode trunk

!

interface TenGigabitEthernetl/0/2
!

interface TenGigabitEthernetl1/0/3
switchport mode trunk

|

interface TenGigabitEthernetl/0/4

!
interface TenGigabitEthernetl/0/5
switchport access vlan 20

switchport mode access

device-tracking

spanning-tree portfast

spanning-tree bpduguard enable

!
interface TenGigabitEthernetl/0/6
description Connected to WF-NUC-PC2 Windows 11 Host
switchport private-vlan mapping 10 101
switchport mode private-vlan promiscuous
speed 1000

duplex full

spanning-tree portfast

!

interface TenGigabitEthernetl/0/7
switchport access vlan 100

switchport mode access

|

interface TenGigabitEthernetl1/0/8

|

interface TenGigabitEthernetl/0/9

!

interface TenGigabitEthernetl1/0/10
switchport mode private-vlan promiscuous
|

interface TenGigabitEthernetl/0/11

|
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interface TenGigabitEthernetl1/0/12

!

interface TenGigabitEthernetl/0/13

!

interface TenGigabitEthernetl/0/14

!

interface TenGigabitEthernetl1/0/15

!

interface TenGigabitEthernetl/0/16

!

interface TenGigabitEthernetl/0/17

!

interface TenGigabitEthernetl1/0/18

!

interface TenGigabitEthernetl/0/19

[

interface TenGigabitEthernetl/0/20

!

interface TenGigabitEthernetl/0/21

|

interface TenGigabitEthernetl/0/22
switchport mode trunk

macsec network-link

access-session host-mode multi-host
access-session closed
access-session port-control auto
channel-group 1 mode active
service-policy type control subscriber DOT1X-MUST-SECURE-UPLINK
!

interface TenGigabitEthernetl/0/23
switchport private-vlan mapping 10 101
switchport mode private-vlan promiscuous
!

interface TenGigabitEthernetl/0/24
switchport mode trunk

macsec network-link

access-session host-mode multi-host
access-session closed
access-session port-control auto
channel-group 1 mode active
service-policy type control subscriber DOT1X-MUST-SECURE-UPLINK
|

interface GigabitEthernetl/1/1
switchport mode private-vlan promiscuous
|

interface GigabitEthernetl/1/2

|

interface GigabitEthernetl/1/3

!

interface GigabitEthernetl/1/4

|

interface TenGigabitEthernetl/1/1
switchport mode trunk

rep segment 1 edge

macsec network-link

mka policy MKA-POLICY

mka pre-shared-key key-chain MAC-SEC
service-policy type control subscriber DOT1X-MUST-SECURE-UPLINK
!

interface TenGigabitEthernetl/1/2
switchport mode trunk

mka policy MKA-POLICY

mka pre-shared-key key-chain MAC-SEC
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|
interface TenGigabitEthernetl/1/3
!
interface TenGigabitEthernetl/1/4
!

interface TenGigabitEthernetl/1/5

!
interface TenGigabitEthernetl/1/6

!
interface TenGigabitEthernetl/1/7

|
interface TenGigabitEthernetl/1/8

!
interface FortyGigabitEthernetl/1/1
|
interface FortyGigabitEthernetl/1/2
!
interface TwentyFiveGigEl/1/1

!
interface TwentyFiveGigEl/1/2

|
interface AppGigabitEthernetl/0/1

!
interface Vlanl

no ip address

!
interface Vlanb

ip address 10.5.1.2 255.255.0.0

ip pim sparse-mode

standby 5 ip 10.5.1.1
private-vlan mapping 501,502

!
interface VlanlO

ip address 10.10.1.2 255.255.255.0
standby 1 ip 10.10.1.1

standby 1 priority 105
private-vlan mapping 101,102

!
interface V1an20

ip address 10.20.1.2 255.255.0.0
standby 20 ip 10.20.1.1

|
interface V1anl00

ip address 10.10.100.2 255.255.255.0
!
interface Vlanlll

ip address 10.111.1.2 255.255.255.0
ip helper-address 10.10.1.10
standby 111 ip 10.111.1.1

!
router ospf 1

network 1.1.1.0 0.0.0.255 area 0
network 10.1.0.0 0.0.255.255 area O
network 10.10.102.0 0.0.0.255 area 0
network 10.10.0.0 0.0.255.255 area 0
|
ip forward-protocol nd
ip http server
ip http authentication local
ip http secure-server
ip pim rp-address 10.5.1.1
ip ssh bulk-mode 131072
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!
control-plane
service-policy input system-cpp-policy
|
|

Turbine Operator Network Configuration

line con O
stopbits 1
line vty 0 4
transport input ssh
line vty 5 31
transport input ssh
1
call-home
! If contact email address in call-home is configured as sch-smart-licensing@cisco.com
! the email address configured in Cisco Smart License Portal will be used as contact email address to
send SCH notifications.
contact-email-addr sch-smart-licensing@cisco.com
profile "CiscoTAC-1"
active
destination transport-method http
ntp server 10.10.1.10

end

IE9320 Switch:

hostname WF-SCADA-IE9320-1

!

!
no logging console

aaa new-model

aaa local authentication MACSEC-UPLINK authorization MACSEC-UPLINK
!

|

aaa authentication dotlx MACSEC-UPLINK local
aaa authorization network MACSEC-UPLINK local
aaa authorization credential-download MACSEC-UPLINK local
!

!

aaa attribute list MUST-SECURE

attribute type linksec-policy must-secure

!

aaa session-id common

!

!

!

clock timezone UTC 5 30
boot system switch all flash:ie9k iosxe.BLD POLARIS DEV_LATEST 20240313 033241 V17 15 0 18.SSA.bin
switch 1 provision 1e-9320-22s2c4dx

eap profile EAP-PROFILE

method tls

pki-trustpoint CA

|

rep ztp

!

!

!
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!

ip routing

!

|

!

|

login on-success log

vtp mode transparent
!
!
!
!
!

access-session mac-move deny
|
key chain MAC-SEC macsec
key 4000000000000000000000000000000000000000000000000000000000000000
cryptographic-algorithm aes-128-cmac
key-string CAFECAFECAFECAFEOCAFEOCAFEOCAFEQ
lifetime local 00:00:00 Jan 1 1993 infinite
|
crypto pki trustpoint SLA-TrustPoint
enrollment pkcsl2
revocation-check crl
hash sha256
|
crypto pki trustpoint TP-self-signed-2076045765
enrollment selfsigned
subject-name cn=I0S-Self-Signed-Certificate-2076045765
revocation-check none
rsakeypair TP-self-signed-2076045765
hash sha256
|
crypto pki trustpoint my-trustpoint
enrollment terminal pem
serial-number none
ip-address none
subject-name C=IN, ST=KAR, L=BLR, O=cisco, OU=IOT, CN= WEF-SCADA-IE9320-1.wf.com
subject-alt-name WF-SCADA-IE9320-1.wf.com
revocation-check none
rsakeypair my-4096rsa-key
hash sha256
|
crypto pki trustpoint CA
enrollment url http://10.20.200.1:80
serial-number
fgdn IE9320-1.wf.com
ip-address none
subject-name CN=IE9320-1
subject-alt-name IE9320-1.wf.com
revocation-check none
rsakeypair myrsakeys
auto-enroll regenerate
hash shab12
|
!
crypto pki certificate chain SLA-TrustPoint
certificate ca 01
30820321 30820209 A0030201 02020101 300D0609 2A864886 F70D0101 0B0O50030
32310E30 0C060355 040A1305 43697363 6F312030 1E060355 04031317 43697363
6F204C69 63656E73 696E6720 526F6F74 20434130 1E170D31 33303533 30313934
3834375A 170D3338 30353330 31393438 34375A30 32310E30 0C060355 040A1305
43697363 6F312030 1E060355 04031317 43697363 6F204C69 63656E73 696E6720
526F6F74 20434130 82012230 0D06092A 864886F7 0D010101 05000382 010F0030
82010A02 82010100 A6BCBD96 131E05F7 145EA72C 2CD686E6 17222EAl F1EFF64D
CBB4C798 212AA147 C655D8D7 9471380D 8711441E 1AAF071A 9CAE6388 8A38ES520
1C394D78 462EF239 C659F715 B98COA59 5BBB5CBD OCFEBEA3 700A8BF7 D8F256EE
4AA4E80D DB6FDICY9 60BlFD18 FFC69C96 6FA68957 A2617DE7 104FDC5F EA2956AC
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7390A3EB
68E69491
C7479096
C55F0D76
DFC7C6CF
06300F06
4B3D31E5

2B5436AD
20F320E7
B4CB2D62
61F9A4CD
04DD7FD1
03551D13
1B3E6ALl7

C847A2C5
948E71D7
EA2F505D
3D992327
02030100
0101FF04
606AF333

DABS553EB
AE3BCC84
C7B062A4
A8BB03BD
01A34230
05300301
3D3B4C73

69A9A535
F10684C7
6811D95B
4E6D7069
40300E06
01FF301D
E8300D06

58E9F3E3
4BC8EOQOF
E8250FC4
7CBADF8B
03551DOF
0603551D
09228648
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COBD23CF
539BA42B
5D5D5FB8
DE5F4368
0101FF04
0E041604
86F70D01

58BD7188
42C68BB7
8F27D191
95135E44
04030201
1449DC85
010B0500
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D3932A66 86025D9F E838AESC 6D4DF6B0O 49631C78 240DA905
CD636FDB DD44681E 3A5673AB
2189BB5C 8FA85686 CD98B646
CF835015 3CO4FF7C 21E878AC
B1FCF9BB E973DE7F 5BDDEB86
07B85737 F3A58BE1l 1A48A229
8428787B 35202CDC 60E4616A
27E86F73 932E35B5 8862FDAE

03820101
604EDCDE
D98987BF
467A3DF4
TCATBTE6
5FBODAOG6
80DDCD16
418616A9
D697DFTF

00507F24
FF4FED2B
E40CBDSE
4D565700
ClAF74F6
BO2AFETF
D6BACECA
4093E049
28

quit
crypto pki certificate chain
crypto pki certificate chain my-trustpoint
certificate 2300000004D96A262BD2A32F8A000000000004

30820552
0004300D
2D434130
31375A30
49453933
06035504
0A130563
1857462D
09278648
95616E3A
1BCE3305
867B0588
2158AC9B
227BDCD5S
CF5C266F
DBO7EE74
EAATEDOO
DAA2DE6GC
08EE323F
F5250C3C
F08B387B
451D364C
22E698ED
7D04B354
4F375F86
82011F30
1857462D
04160414
18301680
04373035
314C3444
05050701
57494E2D
32315552
3000300D
4D79B79C
484D395D
6211FD42
3ABF3816
DAC71AEB
895BFOBC
DBB578EC
9CA647B5

3082043A
06092A86
1E170D32
81933127
32302D31
0813034B
6973636F
53434144
86F70D01
122CDOCA
35D83634
C26F7494
3B5A642A
106DFES54
3451050E
A54F9115
19A8A2DF
FO011BB46
8FCEFBA4
AEE09316
C9E14D86
303B1D86
D15152B3
360010B2
2B235DC9
82011B30
53434144
0853300A
1414C04B
3033A031
2F436572
01044D30
38323155
4E41314cC
06092A86
5D59004F
9AD98891
CB18CE32
E4CF4DCF
AQ53AAT1
88C1ADCY
D5738D9C
17E33F58

quit
certificate ca 3557E375F43B3AA14CC7023E5EF23AD1

308202FB
0D06092A
301E170D
3010310E
01010105
9ACTE33B
E7ADFBFF
072B7A82
c003DCC8
EOEA44AB

308201E3
864886F7
32333132
300C0603
00038201
9D04D1AB
51A22D11
E3937236
2E92DFC2
9C811DD2

7TFC460E
1AECAQC2
6ADFOFOD
152E99B7
494E8A9E
EEBC7CF9
4D10AB75

A0030201
4886F70D
33313231
30250609
2ET77662E
4152310C
310C300A
412D4945
01010500
A213443C
B8B1F752
D790BB72
D370A6CA
DI9BFC1ES
FC4F298B
61C33ECO
DDC09530
FSFAD4EA
AABE2CI9E
FB6B5347
098D7522
665E99EF
8COED207
0625495E
7E44C8B4
0B060355
412D4945
C3D98AEB
830396F5
AO2F862D
74456E72
4B304906
524E4131
34445F57
4886F70D
265B455F
9A9BCEFE
EEES9BB42
5CCEAFCS8
DD06054F
393106B4
22B1A19A
CB354E59

A0030201
0D01010B
31313038
55040313
0F003082
35BA43F2
8F5B644B
8B7978FF
25990E48
351B07C3

TP-self-signed-2076045765

02021323
01010BO5
31303835
27864886
636F6D31
300240603
06035504
39333230
0382020F
94F812E6
3AA87A9B
644DC661
572DAF21
CD4704EF
35C4C683
10928CEA
E02075E8
9451A154
ABF95DF?2
69331BB3
EF6DI9CBO
6F48EEQOA
F2F2BY99E
04A2F3E4
58887525
1DO0F0404
39333230
9BFA6356
BCFEE923
66696C65
6F6C6C2F
082B0601
4C34442F
462D4341
01010BO5
E7F2E1B2
5C3BB116
CAO1AS5DD
8630C28B
B7C67E1F
3097AD17
TFOF6DA2
9EO030AE2

02021035
05003010
31333337
0557462D
010A0282
C948238D
834BF712
26EFEA9D
453FALTA
1328A54cC

00000004
00301031
3531375A
F70D0109
0B300906
55040713
0B130349
2D312E77
00308202
8CFC8062
DF4BE684
CC63271A
EA24CE32
81F97C87
9106E90A
A3021031
9AEEE6B2
C29B9BC2
22582502
9FEE38AC
ESECBD67
21E5EEAA
DB665785
AC5CD7A4
A5A098B7
030205A0
2D312E77
830519F'8
357FBEDS
3A2F2F2F
57462D43
05050730
43657274
2E637274
00038201
730F135E
6A825611
EFF316AA
71792D6E
4D56A8C7
AD97BFE4
57629DE2
BFC228AC

57E375F4
310E300C
5A170D32
43413082
010100C9
S5F4AFB2A
7DF5404C
92121113
497506B9
96B09759

DI96A262B
0E300C06
170D3234
02131857
03550406
03424C52
4r543121
662E636F
0A028202
B054B032
BDD872BA
26D73F9A
DEA36965
9843C7F9
955EC349
4A2AA4CS
4325BC89
945AFBF1
8D00BE92
DE344DFC
4EFB2283
A11AFC92
A8240A05
316EDC56
51BD7AA9
30230603
662E636F
3FEB7A50
2541B87C
2F57494E
412E6372
02863D66
456E726F
300C0603
0100B643
E64E77C1
OB8AD7E4
7C5354A4
18BOSF1F
EA3CO3A9
E984A455
93A04B7E
9EB2

3B3AA14C
06035504
38313231
0122300D
4E2F650A
6A9DCF57
DA023189
650EF3B3
12333B62
S5FCA65FC
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9093D3B1
5575B146

6CI9E3D8B
8DFC66A8

11BA9CD2 55A9232C
C71E3B49 1765308B
C37C1lE69 39F08678
B623CDBD 230E3AFB

0275156F

D2A32F8A
03550403
31323131
462D5343
1302494E
310E300C
301F0603
6D308202
010096D2
COCDA806
3882302D
42E3EA4C
BBC1B53F
4766712A
49F2F1B7
754ADD86
842DBE66
EQ97EASFE
5CD6325B
D0174310
25210BA1
8EAQC89F
383296B1
1B1730C4
B7410203
551D1104
6D301D06
301F0603
93303E06
2D383231
6C305906
696C653A
6C6C2F57
551D1301
3FE988CB
E93A40FF
D6AG4FFB
D1265509
2D3F1706
8C8C6325
9E46C52D
41CE1178

C7023E5E
03130557
31303832
06092A86
919384cCS8
2F8F59EE
83427288
7655FAQ00
AF6DD71C
3F6BF2ED

719BB2F0

00000000
13055746
30393035
4144412D
310C300A
06035504
55040313
22300D06
404EC7D3
9EO8ED7A
4F2CF08C
564AD9A3
F488432A
722C3EB6
2885296C
419B936F
A424043D
42DC792D
270988C7
3305DDDA
354EBATF
79423D62
4B3FES0B
7D40B04C
010001A3
1C301A82
03551D0OE
551D2304
03551D1F
55524E41
082B0601
2F2F2F2F
494E2D38
01FF0402
F49E5571
395E600E
4ECF8D58
6B6D83ED
355B95AA
11ECOEES
41BCOAS51
A6BE1D3B

F23AD130
462D4341
3333375A
4886F70D
2053EDCO
DEC9360D
E760D257
FB8DFEC7
8A3F75DA
7014EE88
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5558D298
B2794ADY9
2789F268
551D0F04
0E041604
04018237
F2167B6C
2A62740C
D481E2A3
54FB9AE3
1F591830
03AFA6DS8
8B24BD77
29262E20

B46D5233
5435B73F
10BF857C
04030201
1414C04B
15010403
00889A0C
802CB61D
07A65D6C
0CC242F1
2F11756E
E6446BA8
34C65D6F
T6A077F5

quit
crypto pki certificate chain
certificate 09

3082043B
OE310C30
170D3235
32302D31
4886F70D
27864886
B26DD240
96A86413
49D6AGEA
6FOABOSD
0CC99691
A689C397
60021043
4D1087B2
3069300B
32302D31
68D8F1E2
7C085E89
9C1l66BEL
69833DD0
84D7TEFET
4D95E59A
TAD9493F
ABD5SEOF6
776E6AT0
OAF5DOF1
D98D4820
ECE5034C
E71C8D9B
012E9769
09024 9BE
178E0D18
2D4EOFDF
98563284

30820223
0A060355
30313230
31323012
01090216
F70D0101
FC87FB4B
2AC664F4
AB834F008
6E395F74
51BC6EB7
8E8B0651
CC5137C4
05B82AE4
0603551D
2E77662E
3140CD3D
A5DA680D
6D6A2AC1L
D7B6FD67
0034BDES
66CDOA02
1DD04D33
2BD1ASFD
E0922C6D
F42E50B7
8EOD873A
356CF71D
A3BB1D6B
5810E7BA
9ADD250E
E1CD3DF9
BDCD2127
F677D415

quit
certificate ca 01

308204FA
0E310C30
170D3236
82022230
C93FCBDS8
DOF10B77
4EEEB656
075D2689
362067CD
60BBF346
092C3546
5B2E2ADS8
3D83213B
61385435
B4E228EF

308202E2
0A060355
31323231
0D06092A
F9044D93
DC368C25
D4374570
BCC92916
072D3285
F1957919
C94E0E19
7C3CFBED
S5ADBCBDS
F20B03C6
AE5764BA

F9779641
0FE12D44
D18042FD
86300F06
830396F5
02010030
9FB8D3EE
AB8B1931
42703D03
D8DOF314
963E0A40
03BA7410
4E007CBF
B10976DF

A0030201
04031303
31343136
06035504
0F494539
01050003
73671D75
794AF846
34A95096
B39FC126
0ABSAFE9
TA8DF3A1
6F31F45C
51A176D1
0F040403
636F6D30
AT76ED144
41583C30
B3812387
A55BCALl7
D311415D
4DFA7847
98B3D54C
OED16FE8
467ADD81
D189AB88
6BC184EC
564C6788
8C11FBFE
3FOF7B15
E73DFDB4
068EF56D
A31E3A77
06001A5B

A0030201
04031303
30363131
864886F7
TFD17F8C
31C4018E
A2923C21
OBF88269
3A4046D7
CF6787D9
352E5815
760D92E9
B6ED1E44
D8FF9047
85094A44

D67CEO11
424BBA0A
9A926891
03551D13
BCFEE923
0D06092A
9BA6B019
48C63425
39295694
8E33E6F9
7681CB71
D8433A0B
BCA264AE
4DBB4FF1

CA

02020109
49535230
35305A30
05130B46
3332302D
82010F00
96F0C592
F6ECL1F8
87C3ACEE
E065A68C
43444509
55E96AAS8
A420C26C
680F893A
0205A030
1F060355
301D0603
0D06092A
FO36AF2C
1782608A
EF093064
37239A49
8E2869A1
290D2C85
48A1676F
99E58074
Cl128262F
D940C3CE
E9DAF4A8
772122BD
F1522CBF
D3D3605A
8BB13ESD
43411B20

02020101
49535230
31355A30
0D010101
F7A466CE
AB3AABD1
788364DD
1509DE8SC
0AA2CBDF
0032295F
289419BA
FE5C4382
424F2372
95F14E8E
3BEEC94E

42655411
CAD97B96
TB28FF02
0101FF04
357FBEDS
864886F7
13D70061
TAA89FDA
4BCC7B5A
99BE3FAS8
2A801C74
A31CA430
650CC2A4
9C3BADC3

300D0609
1E170D32
47311130
44413237
312E7766
3082010A
32FEA394
9CB39C06
C99916B6
1755B107
D403A761
479F6C5A
AO6E112D
9DF2EB52
1A060355
1D230418
551D0EO4
864886F7
0CD0OC323
66804FBE
6F39909E
6F02870E
2269973C
2101BO6A
C90CBALA
62D7236B
7D014CB4
201D802B
6DE93120
4BEBE2C4
EDS2F372
9BC160A8
408EEB46
3E288B38

300D0609
1E170D32
OE310C30
05000382
86303FB7
A2A33AA0
ABAATF51
10537C63
23F5A28C
D2796DAF
B2C840FD
85E73DES8
B670FF9F
COF2545E
A6779A0D

1E239E3C
91F9DE11
03010001
05300301
2541B87C
0D01010B
43E94DA0O
555C9734
549EE2C1
74F19CF8
316E66D8
FA1FB1DA
5D383FC2
4B243445

27864886
34303132
0F060355
31334A4A
2E636F6D
02820101
BA6DO045A
859F0F8D
E1EO1D6F
F266100E
8F1D36B7
D8F73284
23F05622
2B42BEF2
1D110413
30168014
1604142F
0D01010D
1C9255A3
D6BA3F80
57D59943
26AC1FD6
626F58F7
6DCFO07DB
2BF3DD2B
F4984888
F527B6BE
84A738AC
39F70CCO
65BE3775
CE2342D1
C07190E0
7TBA6CBOF
B1478055

2A864886
33313232
0A060355
020F0030
961EF078
2D0F8606
F3E4099E
8A03D129
3B5B8551
E508294F
0AFCA295
8559B059
CD87DC38
A632418F
B3239873
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E73ECI9F5
84A53082
A351304F
01FF301D
93301006
05000382
07543FBB
D2E7C6FA
6CB20516
5108A4B0
4237C923
9FA48616
2F55D395
359E5B14

F70D0101
31313431
04031308
5A32301C
30820122
00C1D474
BOCE1086
B8B1D945
64982959
05130ED9
75900DFD
545378F2
07EEFAB7
3D020301
3011820F
1307525E
C8D84E19
05000382
1DD85EEC
5462EBCB
CBS57EF29
62E76396
BBBC24AA
3241A6F5
29A009A5
20BF5EEL
FOD30187
CD2064A5
FE4F9C71
2A26B602
DF42B27A
53FF3A97
E27E2347
F703C539

F70D0101
32303631
04031303
82020A02
32735D8B
C34DF26F
5EB4CAAS
30792797
CB46C313
F49664B9
3FA7B91D
A2F9D88C
A4EB3D65
9C79141B
40B77ADS

OCBCFCO09
16895BA4
300B0603
0603551D
092B0601
01010018
2E45FCDE
7785072E
F86ET711A
D5BO08A3
A3AFTB69
66882E2F
6B026B3F
65168A

0D050030
3635305A
49453933
06092A86
300D0609
716BDC22
B6189747
C9A819F8
1EECC3CE
38AA1BDD
75705205
855363C1
5A9AEQ7C
0001A36B
49453933
86089D19
ED10DE20
02010043
BCA859DD
265B526C
54EB8432
BDCC615F
DACBT7A42
D8092618
7DO1DOEF
9BF530AC
963618D3
BE1A3BAA
456998F9
F4D5290D
16900D9D
F6061D5A
FO9CB727
28185E

0D050030
3131355A
49535230
82020100
B55E6105
E877546A
29EOFEOA
3EDA3630
F23430BC
D7031865
4E06CEEF
00F942C6
D8DES59F1
6C352661
FAA25B81
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TE606F4B
9E3575FD
0C13RA497
B7231AD3
D6E2F32C
02030100
OFO0101FF
D8F1F231
F1F23140
B8AD3E39
AE86430A
237357F6
AT754FCES
07F2270F
F6BBABES
0419B1EF
D8FOA1EQ
DO790E88
6C705E59
02D1143D
78BFC763
FDAE7A33
8B1ASDSF
FF88F098
A9700577
92

68ACDE7B
DF3ACCF6
D8CLFEFF
5CA1C579
C864A2ED
01A36330
04040302
40CD3DA7
CD3DAT76E
A6B19533
ES5F6399B
0525D0E1L
B8758B34
1768CAQF
91046FC9
711A2C8E
33D4E7C6
31482F89
32985A51
7A8121D2
6E909872
DEE55B66
2ACA1518
6638D179
591F02AF

quit

5F55AEE4
04E8C549
34AA67EE
D79FD49D
327FA8F5
61300F06
0186301F
6ED14430
D144300D
3D029858
8BI95AAQ7
4B2CAEE1
082A4BOF
90AEB12A
E37558EE
BC25E628
D90429BD
410D7A31
FOB10ALS8
21EFDE23
TAC5939C
FB52B3AE
CF24DC21
62F1FATE
FD3DBO2F

7084FA8D
0A76486C
42922309
30E24DEF
6A3DB351
03551D13
0603551D
1D060355
06092A86
35FC67B7
C2C1ADCS8
9C331260
8015A7C6
35AF668A
433BA7FD
F2738D58
BAE9545F
3CC376CA
96252952
9C934085
B593A376
01818D63
8182A63A
026FA05SE
D8390514

C6C44BSA
E6D5SF6C3
9D7E876F
DD93905D
A254182B
0101FF04
23041830
1D0EO416
4886F70D
CEF78131
AD90ECB5
491421E0
09DD11CE
945721B5
19F16F4E
F9547857
EAESFT78E
5375D649
80DFBBFA
42835E29
FOO031BE3
5FE54C28
97166FF5
A5633F16
F3A812D7

06445DB7
CE7CT75F1
F3985091
8CD1FEB7
D4ACCO070
05300301
16801413
04141307
01010D05
AD879855
F5B42F69
AOOAAE96
5CE1A7BE
ABBB2641
1C4FALl4A
22C6CBDF
D48662B8
ABF76307
BE7A9605
CE11C60B
B428A015
95706297
7555D85F
4FB6B514
9E76BF4B

service-template DEFAULT LINKSEC POLICY MUST SECURE
linksec policy must-secure
service-template DEFAULT LINKSEC POLICY SHOULD SECURE

linksec policy should-secure

service-template DEFAULT CRITICAL VOICE TEMPLATE

voice vlan
service-template DEFAULT CRITICAL DATA TEMPLATE

service-template webauth-global-inactive
inactivity-timer 3600

dotlx system-auth-control

memory free low-watermark processor 59462

diagnostic bootup level minimal

spanning-tree mode rapid-pvst

spanning-tree extend system-id

alarm-profile defaultPort

alarm not-operating

syslog not-operating
notifies not-operating

mka policy MKA-POLICY
key-server priority 150
sak-rekey interval 65535

mka policy MKAPolicy

macsec—-cipher-suite gcm-aes-128 gcm-aes-256

username dna aaa attribute list MUST-SECURE
username usr-macsec aaa attribute list MUST-SECURE

|
redundancy
mode sso
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CD32D8C7
0486FCOE
4A9024C2
56F1111F
DEABFE4C
01FF300E
07525E86
525E8608
00038202
B2C70CBD
028EFE47
FE196B18
26447759
B31B8D88
8E06217B
D79C27B0
2B6FD7B4
C5A6E5E9
4B8060A6
8A1452FE
CO7941FF
5D448562
84BCFEF8FE9
EBF135F5
2C2CBDA3

EE37393C
16BF7DB6
E62151F1
BE1D1E74
915FBCB9
0603551D
089D1968
9D1968D8
0100C5ED
4E9D7D4A
D551E18B
A43E9D54
FAFC73A6
CE098C19
5A3469D0
52E36EC5
8405B1A7
59827A8E
98790B17
160BCFOD
AlEF4C63
3A380D9C
CF60DBBA
441CE34C
DA
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|
!
!
!
|

vlan 5
name Multicast VLAN
!
vlan 10
name PrivateVLANvlan
private-vlan primary
private-vlan association 101,102
!
vlan 20
name IXIA TrafficTestVLAN
!
!

vlan 101
name isolated VLAN
private-vlan isolated
|
!
vlan 111
name Management VLAN
|
|
!
1ldp timer 5
11dp holdtime 20
11dp run
|
class-map match-any system-cpp-police-ewlc-control
description EWLC Control
class-map match-any system-cpp-police-topology-control
description Topology control
class-map match-any system-cpp-police-sw-forward
description Sw forwarding, L2 LVX data packets, LOGGING, Transit Traffic
class-map match-any LevelHPD
match dscp cs3 af31 af32 af33 cs4 afdl afd2 af4d3
class-map match-any system-cpp-default
description EWLC data, Inter FED Traffic
class-map match-any LevelLPD
match dscp default csl
class-map match-any LevelMPD
match dscp cs2 af2l af22 af23
class-map match-any system-cpp-police-sys-data
description Openflow, Exception, EGR Exception, NFL Sampled Data, RPF Failed
class-map match-any LevelMCD
match dscp cs5 ef «c¢s6 «cs7
|
policy-map type control subscriber DOT1X-MUST-SECURE-UPLINK
event session-started match-all
10 class always do-until-failure
10 authenticate using dotlx aaa authc-list MACSEC-UPLINK authz-list MACSEC-UPLINK both
event authentication-failure match-all
10 class always do-until-failure
10 terminate dotlx
20 authentication-restart 10
event authentication-success match-all
10 class always do-until-failure
10 activate service-template DEFAULT LINKSEC POLICY MUST SECURE
|
policy-map system-cpp-policy
|
|
|
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|
!
!
|

interface GigabitEthernetl/0/1
!

interface GigabitEthernetl/0/2
!

interface GigabitEthernetl/0/3
|

interface GigabitEthernetl/0/4
switchport access vlan 10
switchport mode access
spanning-tree portfast
spanning-tree bpduguard enable
!

interface GigabitEthernetl1/0/5
switchport access vlan 5
switchport mode access

!

interface GigabitEthernetl/0/6
!

interface GigabitEthernetl/0/7
!

interface GigabitEthernetl/0/8
|

interface GigabitEthernetl/0/9
|

interface GigabitEthernetl1/0/10
!

interface GigabitEthernetl1/0/11
switchport voice vlan dotlp

!

interface GigabitEthernetl/0/12
!

interface GigabitEthernetl/0/13
!

interface GigabitEthernetl/0/14
!

interface GigabitEthernetl/0/15
|

interface GigabitEthernetl/0/16
|

interface GigabitEthernetl/0/17
!

interface GigabitEthernetl1/0/18
!

interface GigabitEthernetl1/0/19
!

interface GigabitEthernetl1/0/20
!

interface GigabitEthernetl/0/21
!

interface GigabitEthernetl/0/22
!

interface GigabitEthernetl1/0/23
switchport access vlan 10
switchport mode access

!

interface GigabitEthernetl1/0/24
I

interface TenGigabitEthernetl1/0/25

switchport mode trunk
rep segment 100 edge
macsec network-link
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service-policy type control subscriber DOT1X-MUST-SECURE-UPLINK
!

interface TenGigabitEthernetl/0/26

switchport private-vlan host-association 10 101

switchport mode trunk
!
interface TenGigabitEthernetl/0/27
switchport mode trunk
rep segment 1
macsec network-link
mka policy MKA-POLICY
mka pre-shared-key key-chain MAC-SEC
!
interface TenGigabitEthernetl1/0/28
switchport mode trunk
rep segment 1
macsec network-link
|
interface AppGigabitEthernetl/0/1
switchport voice wvlan dotlp
1
interface Vlanl
no ip address
!
interface Vlanlll
ip address 10.111.1.4 255.255.255.0
|
ip http server
ip http authentication local
ip http secure-server
ip forward-protocol nd
ip ssh bulk-mode 131072
!
snmp-server community private RW
snmp-server community public RO
!
!
!
control-plane
service-policy input system-cpp-policy
!
!
line con 0
exec—timeout 0 0
stopbits 1
line vty 0 4
transport input ssh
line vty 5 15
transport input ssh
|
ntp server 10.10.1.10
!
ptp clock transparent domain 0 profile default

end
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FSN Switch:

hostname WF-SCADA-FSN-Switch

|

!
no logging console

aaa new-model

aaa local authentication MACSEC-UPLINK authorization MACSEC-UPLINK
|

!

aaa authentication dotlx MACSEC-UPLINK local
aaa authorization network MACSEC-UPLINK local
aaa authorization credential-download MACSEC-UPLINK local
|

!

aaa attribute list MUST-SECURE

attribute type linksec-policy must-secure

|

aaa session-id common

clock timezone UTC 5 30

rep ztp

rep autodisc

iedt refresh-interval 21600

eap profile EAP-PROFILE

method tls

pki-trustpoint CA

|
ptp mode elZetransparent
vtp mode transparent

login on-success log
|
|

access-session mac-move deny
|
key chain MAC-SEC macsec
key 4000000000000000000000000000000000000000000000000000000000000000
cryptographic-algorithm aes-128-cmac
key-string CAFECAFECAFECAFEOCAFEOCAFEOCAFEQ
lifetime local 00:00:00 Jan 1 1993 infinite
|
crypto pki trustpoint CA
enrollment url http://10.20.200.1:80
serial-number
fgdn V0SZ.wf.com
ip-address none
subject-name CN=V0SZ
subject-alt-name V0SZ.wf.com
revocation-check none
rsakeypair myrsakeys
hash sha512
|
|
crypto pki certificate chain CA
certificate 02
3082052F 30820317 A0030201 02020102 300D0609 2A864886 F70D0101 0D050030
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0E310C30
170D3234
312E3012
01090216
01050003
FCE973F9
16557BB6
36C0712E
3C570A4B
B409D3B8
D1A36E04
5750C05A
86AD3E35
048FFDSE
D66B3E08
62E9BT7E9
70602EEDS
C41A88CB
9BD56019
6CC1D45E
16A0D1A7
0F040403
1F060355
301D0603
0D06092A
93FA4C65
446A6995
5AD4B871
F6F64C48
21C07169
599C46CE
09F309E5
BAF3370B
074EE053
2F8A1CDF
527FE4B9
78729483
3EA3T7FA6
9D7A18AA
2C575753
F2528F92

0A060355
31323231
06035504
0B563053
82020F00
1E3668D2
0C3D5CBE
8CF5F544
EBC364E8
2A9D3DAC
891B6CAlL
869ACI9D8
843F1BAO
725BF6A8
10F2EF89
TEC90762
9F82105D
196CF5FC
CECB4A0B
B7A78C44
5D85D0DC
0205A030
1D230418
551D0EO4
864886F7
9935FALE
ADC8B019
3A09D248
4DDC34AB
6DDABB53
CC3BOD3A
09EE1A57
7F8096BC
1D397E99
F71209CD
19E4F97F
13B4E424
8292309B
FC935DF9
32FCD959
OBCF67A4

quit
certificate ca 01

308204FA
0E310C30
170D3236
82022230
C93FCBDS8
DOF10B77
4EEEB656
075D2689
362067CD
60BBF346
092C3546
5B2E2ADS8
3D83213B
61385435
B4E228EF
TE606F4B
9E3575FD
0C13A497
B7231AD3
D6E2F32C
02030100
OF0101FF
D8F1F231
F1F23140
B8AD3E39

308202E2
0A060355
31323231
0D06092A
F9044D93
DC368C25
D4374570
BCC92916
072D3285
F1957919
C94EO0E19
7C3CFBED
S5ADBCBDS
F20B03C6
AE5764BA
68ACDE7B
DEF3ACCF6
D8C1FEFF
5CA1C579
C864A2ED
01A36330
04040302
40CD3DA7
CD3DAT76E
A6B19533

04031303
30363137
05130B46
5A2E7766
3082020A
610BAFEF
BDD58BAE
992F39D0
012B1DOE
TFD67232
538E7BE9
F1FO5DF9
E4818BEC
45262C82
6BEEAFA4
98A323C3
D5215B15
9DFCD646
AQO5A800B
E1C33387
C5AE8BBS
16060355
30168014
16041450
0D01010D
76BC3B49
01831BAC
8A8CFAE4
AFOB39AB
6A69F6D8
23203DC4
81C97750
69C1D63D
TE8ASF29
OFAB8BBB
7EB07032
7457097F
930A3024
6D317D6C
13D8F22A
04FACDSF

A0030201
04031303
30363131
864886F7
TFD17F8C
31C4018E
A2923C21
OBF88269
3A4046D7
CF6787D9
352E5815
760D92E9
B6ED1E44
D8FF9047
85094A44
5F55AEE4
04E8C549
34AA6TEE
D79FD49D
327FA8F5
61300F06
0186301F
6ED14430
D144300D
3D029858

49535230
30325A30
47433234
2E636F6D
02820201
16102218
D1F6F6DF
F19F4BD8
D4EASD39
BC131D24
6DEEDB49
4F6013C1
495D7667
S5AE64E9A
BFC28758
DE39CBA7
6DBF41F9
FCC32E1D
2C2FE791
Al686674
74D9E488
1D11040F
1307525E
BBOC8D2A
05000382
61AC9397
B8ABBD44
AAABT425
32E3AATF
C53E8DCS5
11623BC1
C1lA41D50
A1ACF647
1379E5E7
C3CB9746
071C6205
107BA060
8AF06842
12F68EAE
64E17C10
C948F69E

02020101
49535230
31355A30
0D010101
F7A466CE
AB3AABD1
788364DD
1509DE8SC
0AA2CBDF
0032295F
289419BA
FE5C4382
424F¥2372
95F14E8E
3BEEC94E
7084FA8D
0A76486C
42922309
30E24DEF
6A3DB351
03551D13
0603551D
1D060355
06092A86
35FC67B7

1E170D32
3F310D30
32395630
30820222
009D8A08
ABA18EA3
E39C38BB
51669C1D
EOCFF04D
19AA1F7TD
79545B07
D2F53288
094EF970
30FF46D9
49DA4FOC
59C405D0
C283FB86
07B75229
0B64B1AG6
55BE4F37
23020301
300D820B
86089D19
E604593F
02010027
B4E2EF7D
B27AE379
59AE7278
EOFC6E38
BFO95F34B
AT73E4ECT
AF4EQ084A
20B3FEDE
2999A6A8
EAODF60D
916801C1
DO1A0327
36559B53
201CAF47
0106A00B
2763D2

300D0609
1E170D32
0E310C30
05000382
86303FB7
A2A33AA0
ABAATFS51
10537C63
23F5A28C
D2796DAF
B2C840FD
85E73DES8
B670FFIF
COF2545E
A6779A0D
C6C44BSA
E6D5F6C3
9D7E876F
DD93905D
A254182B
0101FF04
23041830
1DOEO416
4886F70D
CEF78131

33313232
0B060355
535A3018
300D0609
D8135238
EB19878C
7TT9F5A6E
1D14E15B
1CD42A0B
3E075E31
5081EE3D
C415A4D8
807DE2C2
8ED803CB
9AD91CE4
9AT75FBF4
DED95AC3
2852BC4E
6C2F73FD
B20BB755
0001A367
5630535A
68D8F1F2
3C2C26D6
00B7A7C3
4EC79CAL
AT71E6A69
B98C6C0O4
D31CC1F4
B9O9295EAB
DED46CD9
C06935AC
295622E2
1D868950
195FD41B
2BF5E9ES8
D71AAA43
607F0D75
92392E71
F1E249A0

27864886
33313232
0A060355
020F0030
961EF078
2DOF8606
F3E4099E
8A03D129
3B5B8551
E508294F
OAFCA295
8559B059
CD87DC38
A632418F
B3239873
06445DB7
CE7CT75F1
F3985091
8CD1FEB7
D4ACCO070
05300301
16801413
04141307
01010D05
AD879855
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32303631
04031304
06092A86
2A864886
FOB4617A
1A53AA0A
891EF289
715DA3B7
B3197CE7
3939397B
E92CE’CF
5631D452
6FEES5732
474FB7E1
ECBEB354
B94A9F2C
BB75AE6C
73025AF6
OEB8C29C
9555B898
3065300B
2E77662E
3140CD3D
ADA838D2
C709947F
02F2A489
ABF5C979
7391EBDS
978362F1
01110C25
A81921BE
657799E9
72C699B5
4132892B
A1278797
35349618
82770C1C
9CE331FF
30D722AB
FEBD1DDC

F70D0101
32303631
04031303
82020A02
32735D8B
C34DF26F
5EB4CAAS5
30792797
CB46C313
F49664B9
3FA7B91D
A2F9D88C
A4EB3D65
9C79141B
40B77AD9
CD32D8C7
0486FCOE
4A9024C2
56F1111F
DEABFE4C
01FF300E
07525E86
525E8608
00038202
B2C70CBD

3730325A
5630535A
4886F70D
F70D0101
D655DA6A
5ED7058A
6CFFIOFCF
B57D423A
6E4C5E4C
DI91FF459
83CFOCES
25CFB343
C6E4BO5A
69B8B955
965EA3B2
61D75DED
904ACAGA
EO2EF586
DBESFFCB
51E3A013
0603551D
636F6D30
A76ED144
2130E930
41CCCF90
252796F8
3DFB4944
E1511E31
9F6ATESB
62A4FE3C
3F5F7799
98130AC1
63BAECBY9
84340907
O0DB2DAS7
B57E4835
5878A59F
B8E46047
CA267E19
3C979FA3

0D050030
3131355A
49535230
82020100
B55E6105
E877546A
29EO0FEQOA
3EDA3630
F23430BC
D7031865
4EQ06CEEF
00F942C6
D8DES9F1
6C352661
FAA25B81
EE37393C
16BF7DB6
E62151F1
BE1D1E74
915FBCBY9
0603551D
089D1968
9D1968D8
0100C5ED
4E9D7D4A
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AE86430A
237357F6
AT54FCES
07F2270F
F6BBABES
0419B1EF
D8FOA1EQ
D0790E88
6C705E59
02D1143D
78BFC763
FDAE7A33
8B1ASDSF
FF88F098
A9700577
92

ES5F6399B
0525D0E1
B8758B34
1768CAQF
91046FC9
T11A2C8E
33D4E7C6
31482F89
32985A51
7A8121D2
6E909872
DEE55B66
2ACA1518
6638D179
591F02AF

quit

8BI95AAQ7
4B2CAEE1
082A4BOF
90AEB12A
E37558EE
BC25E628
D90429BD
410D7A31
FOB10A1lS8
21EFDE23
TAC5939C
FB52B3AE
CF24DC21
62F1FATE
FD3DBO2F

C2C1ADCS8
9C331260
8015A7C6
35AF668A
433BAT7FD
F2738D58
BAE9545F
3CC376CA
96252952
9C934085
B593A376
01818D63
8182A63A
026FA05SE
D8390514

diagnostic bootup level minimal
service-template DEFAULT LINKSEC POLICY MUST SECURE

linksec policy must-secure
service-template DEFAULT LINKSEC POLICY SHOULD SECURE

linksec policy should-secure

AD90OECB5
491421E0
09DD11CE
945721B5
19F16F4E
F9547857
EAES8FT78E
5375D649
80DFBBFA
42835E29
FOO31BE3
5FE54C28
97166FF5
A5633F16
F3A812D7

F5B42F69
AOOAAE96
5CE1ATBE
ABBB2641
1C4FAl4A
22C6CBDF
D48662B8
ABF76307
BE7A9605
CE11C60B
B428A015
95706297
7555D85F
4FB6B514
9E76BF4B

service-template DEFAULT CRITICAL VOICE TEMPLATE

voice vlan

service-template DEFAULT CRITICAL DATA TEMPLATE

service-template webauth-global-inactive
inactivity-timer 3600
dotlx system-auth-control

dotlx credentials DOT1X-CREDS
username usr-macsec

pki-trustpoint CA

license boot level network-advantage

spanning-tree mode rapid-pvst

spanning-tree extend system-id
memory free low-watermark processor 64978

alarm-profile defaultPort

alarm not-operating

syslog not-operating
notifies not-operating

mka policy MKA-POLICY
key-server priority 150
sak-rekey interval 65535

username usr-macsec aaa attribute list MUST-SECURE

crypto engine compliance shield disable

transceiver type all

monitoring
|

!

vlan 5

name Multicast VLAN

!
vlan 10

name PrivateVLANvlan
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028EFE47
FE196B18
26447759
B31B8D88
8E06217B
D79C27B0
2B6FD7B4
C5A6E5E9
4B8060A6
8A1452FE
CO07941FF
5D448562
84BCFEF8F9
EBF135F5
2C2CBDA3

D551E18B
A43E9D54
FAFCT3A6
CE098C19
5A3469D0
52E36EC5
8405B1A7
59827A8E
98790B17
160BCFOD
AlEF4C63
3A380D9C
CF60DBBA
441CE34C
DA



Cisco Solution for Renewable Energy — Wind Farm 1.2 Implementation Guide

Turbine Operator Network Configuration

private-vlan primary
private-vlan association 101,102
|
vlan 20
name IXIA TrafficTestVLAN
|

vlan 101
name isolated VLAN
private-vlan isolated
|
!
vlan 111
name Management VLAN
|
!
11dp timer 5
11dp holdtime 20
11ldp run
!
!
class-map match-any MCD
match dscp cs5 ef cs6 cs7
class-map match-any LPD
match dscp default csl
class-map match-any MPD
match dscp cs2 af2l af22 af23
class-map match-any HPD
match dscp cs3 af31l af32 af33 cs4 afdl afd2 af4d3
match access-group name QoS ACL

|
class-map match-all HPD Output
match dscp cs4
|
policy-map type control subscriber DOT1X-MUST-SECURE-UPLINK
event session-started match-all
10 class always do-until-failure
10 authenticate using dotlx aaa authc-list MACSEC-UPLINK authz-list MACSEC-UPLINK both
event authentication-failure match-all
10 class always do-until-failure
10 terminate dotlx
20 authentication-restart 10
event authentication-success match-all
10 class always do-until-failure
10 activate service-template DEFAULT LINKSEC POLICY MUST SECURE
|
policy-map WE SCADA Ingress_ Policy
class MCD
set ip dscp ef
class HPD
set ip dscp cs4
class MPD
set ip dscp cs2
class LPD
set ip dscp csl
policy-map WE SCADA Egress Policy
class MCD
priority
queue-limit 48 packets
class MPD
bandwidth remaining percent 30
queue-limit 48 packets
class LPD
bandwidth remaining percent 30
queue-limit 272 packets
class HPD Output
bandwidth remaining percent 40
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queue-limit 48 packets
!
|
!
!
!
!
!
|
!
!
|

interface GigabitEthernetl/1
switchport mode trunk

rep segment 100
service-policy input WF_SCADA Ingress Policy
service-policy output WF SCADA Egress Policy
!

interface GigabitEthernetl/2
switchport mode trunk

rep segment 100
service-policy input WF_SCADA Ingress Policy
service-policy output WF SCADA Egress Policy
!

|
interface GigabitEthernetl/3

description PNP STARTUP VLAN

switchport access vlan 5

switchport mode access

spanning-tree portfast

spanning-tree bpduguard enable
service-policy input WF_SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
1
interface GigabitEthernetl/4

switchport access vlan 9

switchport mode access

spanning-tree portfast

spanning-tree bpduguard enable
service-policy input WF SCADA Ingress Policy
service-policy output WF SCADA Egress Policy
!
interface GigabitEthernetl/5

switchport access vlan 59

switchport mode access

ip access-group DAUNU ACL out

service-policy input WF_SCADA_Ingress_Policy
service-policy output WF SCADA Egress Policy
!
interface GigabitEthernetl/6

description ##ConnectedToWindowsCA##
switchport mode private-vlan host
service-policy input WF SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/7

switchport private-vlan mapping 10 101-102
switchport mode private-vlan promiscuous
service-policy input WF_SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/8
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service-policy input WF SCADA Ingress Policy
service-policy output WEF SCADA Egress Policy
!
interface GigabitEthernetl/9
service-policy input WF SCADA Ingress_ Policy
service-policy output WF SCADA Egress Policy
!
interface GigabitEthernetl/10
service-policy input WF_SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
!
interface AppGigabitEthernetl/1
!
interface Vlanl
no ip address
shutdown
!
!
|
interface Vlanlll
ip address dhcp
!
ip http server
ip http authentication local
ip http secure-server
ip forward-protocol nd
!
ip ssh bulk-mode 131072
!
ip access-list extended QoS ACL
10 permit ip 10.1.10.0 0.0.0.255 any
!
snmp-server community private RW
snmp-server community public RO
snmp-server contact Switch
|
1
!
!
control-plane
!
!
line con O
exec—-timeout 0 0
stopbits 1
line aux O
line vty 0 4
transport input ssh
line vty 5 15
transport input ssh
!
ntp server 10.10.1.10

End
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TSN Switch :

hostname WF-SCADA-TSN

!

aaa new-model

aaa local authentication MACSEC-UPLINK authorization MACSEC-UPLINK

aaa authentication dotlx MACSEC-UPLINK local
aaa authorization network MACSEC-UPLINK local
aaa authorization credential-download MACSEC-UPLINK local
|

!

aaa attribute list MUST-SECURE

attribute type linksec-policy must-secure

|

aaa session-id common

clock timezone UTC 5 30

rep ztp

rep autodisc

iedt refresh-interval 21600

eap profile EAP-PROFILE

method tls

pki-trustpoint CA

|
ptp mode eZetransparent
vtp mode transparent

login on-success log

access-session mac-move deny

|
crypto pki trustpoint SLA-TrustPoint
enrollment pkcsl2

revocation-check crl

hash sha256

|
crypto pki trustpoint TP-self-signed-4060431784
enrollment selfsigned

subject-name cn=I0S-Self-Signed-Certificate-4060431784
revocation-check none

rsakeypair TP-self-signed-4060431784

hash sha256

!

!
crypto pki trustpoint CA

enrollment url http://10.20.200.1:80
serial-number

fgdn Y1SL

ip-address none

subject-name CN=Y1SL

revocation-check none

rsakeypair my-4096rsa-key

hash sha512

|

|
crypto pki certificate chain SLA-TrustPoint
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certificat
30820321
32310E30
6F204C69
3834375A
43697363
526F6F74
82010A02
CBB4C798
1C394D78
4ARA4E80D
7390A3EB
68E69491
C7479096
C55F0D76
DFC7C6CF
06300F06
4B3D31ES
03820101
604EDCDE
D98987BF
467A3DF4
T7CATBTEG6
S5FBODAOG6
80DDCD16
418616A9
D697DF7F

e ca 01
30820209
0C060355
63656E73
170D3338
6F312030
20434130
82010100
212AA147
462EF239
DB6FD1C9
2B5436AD
20F320E7
B4CB2D62
61F9A4CD
04DD7FD1
03551D13
1B3E6AL7
00507F24
FFAFED2B
E40CBDYE
4D565700
C1AF74F6
BO92AFETF
D6BACECA
4093E049
28

quit
crypto pki certificate chain
certificate self-signed 01

30820330
31312F30
69666963
33325A17
4F532D53
33313738
0A028201
34987E43
6C3F9902
4BE56C8F
55F00020
9631815E
517E5796
73C6D1DD
CAA1DE79
301F0603
DC301D06
300D0609
B3173FAB
759A5BBA
9EC53168
3BB1783D
B7F907FB
0D22A1C6
604841B3
5EC534B8

30820218
2D060355
6174652D
0D333331
656C662D
34308201
01009E6A
103AB7FA
05D0D411
246ATF25
3FB35F3C
FA56D503
93BA0671
0054C002
46E10203
551D2304
03551D0E
27864886
6A434C91
055AEB22
BFD1AESB
1E440857
AE91CBAA
86398E26
6C7EB94C
E45FD0OA4

quit
crypto pki certificate chain
crypto pki certificate chain

A0030201
040A1305
696E6720
30353330
1E060355
82012230
A6BCBD96
C655D8D7
C659F715
60B1FD18
C847A2C5
948E71D7
EA2F505D
3D992327
02030100
0101FF04
606AF333
D3932A66
T7FC460E
1AECAQ0C2
6ADFOFOD
152E99B7
494E8A9E
EEBC7CF9
4D10AB75

A0030201
04031326
34303630
32303430
5369676E
22300D06
0139E090
A1E91DA5
14DA5951
D50C6663
168F8687
20B294D7
5AF1A7D2
4224F47F
010001A3
18301680
04160414
F70D0101
B44B9D54
0888815A
76376422
BB703128
1BF49B7C
1AB51E19
FE913E04
BC621619

02020101
43697363
526F6F74
31393438
04031317
0D06092A
131E05F7
9471380D
B98COA59
FFC69C96
DAB553EB
AE3BCC84
C7B062A4
A8BBO03BD
01A34230
05300301
3D3B4C73
86025D9F
CD636FDB
2189BB5C
CF835015
B1FCF9BB
07B85737
8428787B
27TE86F73

300D0609
6F312030
20434130
34375A30
43697363
864886F7
145EA72C
8711441E
5BBB5CBD
6FA68957
69A9A535
F10684C7
6811D95B
4E6D7069
40300E06
01FF301D
E8300D06
E838AESC
DD44681E
8FA85686
3CO4FF7C
ESQ73DETF
F3A58BE1L
35202CDC
932E35B5

27864886
1E060355
1E170D31
32310E30
6F204C69
0D010101
2CD686E6
1AAFO071A
OCFEBEA3
A2617DE7
58E9F3E3
4BC8EOQF
E8250FC4
7CBADF8B
03551DOF
0603551D
09228648
6D4DF6B0
3A5673AB
CD98B646
21E878AC
5BDDEB86
1A48A229
60E4616A
8862FDAE

TP-self-signed-4060431784

02020101
494F532D
34333137
39353533
65642D43
09278648
34B3DBCA
11BB80S5SE
2F081138
O0D1F1773
6F71B280
CB7BOESC
EOF35507
3A0EDB46
53305130
146F8C76
6F8C7689
05050003
3E6D84CA
3202861E
39852FA9
D38BDYC5
E32BA7BC
C076BAB4
F56A0C9C
76F6130F

Win-CA
CA

diagnostic bootup level minimal
service-template DEFAULT LINKSEC POLICY MUST SECURE
linksec policy must-secure
service-template DEFAULT LINKSEC POLICY SHOULD SECURE
linksec policy should-secure
service-template DEFAULT CRITICAL VOICE TEMPLATE

voice vlan

service-template DEFAULT CRITICAL DATA TEMPLATE

300D0609
53656C66
3834301E
325A3031
65727469
86F70D01
7982322A
E6033BB1
CT7TFC27AE
5F195F92
9B1C1ACA
35E0B5A2
DA340CFO
800784E5
0F060355
890A5019
0A50194F
82010100
CEA8BY9A2
21C61CD5
993F422A
45BOBA5SA
4AB210D6
68BE1CFE
AQOFDD762
B2D11423

27864886
2D536967
170D3233
312F302D
66696361
01010500
A310D739
3679F080
6D835C1B
24CF8BBA
CADOSDAE
B799CCCC
E047CT7F6
0503239B
1D130101
4F6522EE
6522EE15
19DC4593
423EB597
318C07DO0
27C3894B
557F3A49
643BF417
9TAG29F7
T72C6EE9E
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F70D0101
04031317
33303533
0C060355
63656E73
05000382
17222EAL
9CAE6388
700A8BE7
104FDC5F
COBD23CF
539BA42B
5D5D5FB8
DF5F4368
0101FF04
0E041604
86F70D01
49631C78
9093D3B1
5575B146
11BA9SCD2
C71E3B49
C37C1lE69
B623CDBD
0275156F

F70D0101
6E65642D
31323035
06035504
74652D34
0382010F
085EAAT2
80801DC5
CCD8A611
17120193
94B328C3
8EO0845FA
7TABF096
93E1A87C
FF040530
15F7BBE4
F7BBE497
92033710
9C74EC51
T422EF86
272251CE
DEABB46C
147BDE71
1029035F
A3CT7BF2D

0B050030
43697363
30313934
040A1305
696E6720
010F0030
F1EFF64D
8A38E520
D8F256EE
EA2956AC
58BD7188
42C68BB7
8F27D191
95135E44
04030201
1449DC85
010B0500
240DA905
6C9E3D8B
8DFC66A8
55A9232C
1765308B
39F08678
230E3AFB
719BB2FO0

05050030
43657274
30393535
03132649
30363034
00308201
9B50CE67
375D006A
FOAGFBCE
576E87AL
230FBES52
C524C327
C7A7378D
61D7B2C6
030101FF
978569E8
8569E8DC
80CEATAS
36E0C472
EC74B4D3
CF50BBA6
9A16549E
ABA998D6
00E80514
22D5A17E
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service-template webauth-global-inactive
inactivity-timer 3600
dotlx system-auth-control
dotlx credentials DOT1X-CREDS
username usr-macsec
pki-trustpoint CA
!
1l
spanning-tree mode rapid-pvst
spanning-tree extend system-id
memory free low-watermark processor 88360
|
|
alarm-profile defaultPort
alarm not-operating
syslog not-operating
notifies not-operating
1
!
|
username usr-macsec aaa attribute list MUST-SECURE

crypto engine compliance shield disable
|
!
transceiver type all
monitoring
vlan internal allocation policy ascending
!
vlan 5
name Multicast VLAN
!
vlan 10
name PrivateVLANvlan
private-vlan primary
private-vlan association 101,102
!
vlan 20
name IXIA TrafficTestVLAN
|
|

vlan 101
name isolated VLAN
private-vlan isolated
|
!
vlan 111
name Management VLAN
|
|
!
11dp timer 5
11dp holdtime 20
11ldp run
|
|
!
policy-map type control subscriber DOT1X-MUST-SECURE-UPLINK
event session-started match-all
10 class always do-until-failure
10 authenticate using dotlx aaa authc-list MACSEC-UPLINK authz-list MACSEC-UPLINK both
event authentication-failure match-all
10 class always do-until-failure
10 terminate dotlx
20 authentication-restart 10
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event authentication-success match-all
10 class always do-until-failure
10 activate service-template DEFAULT LINKSEC POLICY MUST SECURE

interface GigabitEthernetl/1

service-policy input WF SCADA Ingress_ Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/2

switchport mode trunk

rep segment 101

service-policy input WEF_SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/3

switchport mode trunk

rep segment 101

service-policy input WF SCADA Ingress_ Policy
service-policy output WF SCADA Egress Policy
1
interface GigabitEthernetl/4

service-policy input WF _SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/5

switchport access vlan 5

switchport mode access

spanning-tree portfast

spanning-tree bpduguard enable
service-policy input WF _SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/6

service-policy input WF _SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|
interface GigabitEthernetl/7

description Connected to WF-SCADA-UCS 10 64 66 115 vmnic?7
switchport private-vlan host-association 10 101
switchport mode private-vlan host

speed 1000

duplex full

spanning-tree portfast

service-policy input WF SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|

interface GigabitEthernetl/8

service-policy input WF SCADA Ingress Policy
service-policy output WF SCADA Egress Policy
!

interface GigabitEthernetl/9

service-policy input WF _SCADA Ingress_Policy
service-policy output WF SCADA Egress Policy
|

interface GigabitEthernetl/10

service-policy input WF SCADA Ingress Policy
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service-policy output WF SCADA Egress Policy

!
interface AppGigabitEthernetl/1
!
interface Vlanl
no ip address
!
!
interface Vlanlll
ip address dhcp
!
ip http server
ip http authentication local
ip http secure-server
ip forward-protocol nd
!
ip ssh bulk-mode 131072

!
ip access-list extended QoS ACL
10 permit ip 10.1.10.0 0.0.0.255 any
!
|
!
snmp-server community private RW
snmp-server community public RO
snmp-server contact Switch
|
!
control-plane
1
!
line con 0
stopbits 1
line aux 0
line vty 0 4
transport input ssh
line vty 5 15
transport input ssh
|
ntp server 10.10.1.10
call-home
! If contact email address in call-home is configured as sch-smart-licensing@cisco.com
! the email address configured in Cisco Smart License Portal will be used as contact email address to
send SCH notifications.
contact-email-addr sch-smart-licensing@cisco.com
profile "CiscoTAC-1"
active
destination transport-method http

end
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CA server sample configuration for auto-enrollment:

crypto pki server CA
no database archive
issuer-name CN=ISR
grant auto

hash sha512

crypto pki trustpoint CA
revocation-check crl
rsakeypair CArsaKeys
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Acronyms and Initialisms

The following table summarizes the acronyms and initialisms that apply to a wind farm solution.

Term Definition

4G LTE Fourth generation long-term evolution
AAA Authentication, authorization, and accounting
ACL Access control list

AD Active Directory

ADM Axis device manager

AlS Automatic identification system

AMP Advanced malware protection

AP Access point

ARP Address resolution protocol

AVC Application visibility and control

BGP Border gateway protocol

BS (Turbine) Base switch

BW Bandwidth

CA Certificate authority

CBWFQ Class-based weighted fair queuing

CC Control venter

CcCcTv Closed circuit television

CDN Cisco Developer Network

CE Carrier Ethernet

Cisco Catalyst Center Cisco Digital Network Architecture Center
cu Command line interface

CoS Class of service

CTS Cisco Trustsec

URWB Cisco Ultra Reliable Wireless Backhaul
cv (Cisco) Cyber Vision

cvC Cisco Cyber Vision Center

CvD Cisco Validated Design

DAD Dual active detection

DC Data center
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DHCP Dynamic host configuration protocol

DMz Demilitarized zone

DNS Domain names system

DODAG Destination oriented directed acrylic graph
DoS Denial of service

DSCP Differentiated services code point

DSRC Dedicated short-range communications

EB Enhanced beacon; external border

ECC Elliptic curve cryptography

ECMP Equal-cost multi path

EEBL Emergency electronic brake lights

EID End point identifier

EIGRP Enhanced interior gateway routing protocol
EN Extended nodes

EP Endpoint

ETS European teletoll services

ETSI European Telecommunications Standards Institute
EVA Emergency vehicle alert

FAN Farm area network

FAR Field area router

FC Fiber channel

FCAPS Enhanced fault, configuration, accounting, performance, and security
FCC Federal Communications Commission
FCoE Fiber channel over Ethernet

FCW Forward collision warning

FE Fabric edges

FI Fabric interconnects

FiaB Fabricin a box

FM FluidMesh

FMC Firepower Management Center

FND (Cisco) Field Network Director

FNF Flexible NetFlow

FP Firepower
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FW Firewall

HA High availability

HER Headend router

HMI Human machine interface

HQ Headquarter

HQoS Hierarchical quality of service
HSRP Hot standby touter protocol
HTDB Host Tracking Database

1/0 Input and output

1A Industrial automation

IB Internal border

ICA Intersection collision avoidance
IE (Cisco) Industrial Ethernet

IEC International Electrotechnical Commission
IED Intelligent end device

IKE Internet key exchange

IMA Intersection movement assist
10T Internet of things

P Internet protocol

IPAM IP address management

IPsec Internet protocol security

IR Cisco Industrial Router

iSCSI Internet small computer systems interface
ISE (Cisco) Identity Services Engine
IT Information technology

L2TP Layer 2 tunneling protocol
L3VPN Layer 3 virtual private network
LAN Local area network

LER Label edge router

LG Cimcon LightingGale

LLG Least loaded gateway

LoRa Long range

LoRaWAN Long range WAN
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LSP Label switched Path

LSR Label switched router

MAC Media access control

MAN Metropolitan area network

ME Mesh end

MIC Message integrity code

MMS Manufacturing message specification

MNT Monitoring node

MP Mesh point

MPLS Multi-protocol label switching

MQC Modular QoS CLI

MRP Media redundancy protocol

MTU Maximum transmission unit

MUD Manufacture usage description

NAN Neighborhood area network

NAT Network address translation

NBAR2 Cisco Next Generation Network-Based Application Recognition
NGFW Next general firewall

NGIPS Next-generation intrusion prevention system
NMS Network management system

NOC Network operations center

NS (Turbine) nacelle switch

NSF/SSO Non-stop forwarding with stateful switchover
NTP Network time protocol

OAM Operations, administration, and management
OBU On-board unit

OEM Original equipment manufacturer

OFTO Offshore transmission owner

ONSS Onshore substation

OPCUA Open platform communications unified architecture
OSPF Open shortest path first

(O Offshore substation

oT Operational technology
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OTAA

Over the air activation

PAgP

Port aggregated protocol

PAN

Policy administration node; personal area network

PCA

Pedestrian crossing assist

PEN

Policy extended node

PEP

Policy enforcement point

PHB

Per hop behavior

PIM-ASM

Protocol independent multicast - any source multicast

PKI

Public key infrastructure

PLC

Power line communication

PnP

Plug and Play

PoE

Power over Ethernet

PoP

Point of presence

PQ

Priority queuing

PQ

Priority Queuing

PRP

Parallel redundancy protocol

PSM

Personal safety message

PSN

Policy services node

PVD

Probe vehicle data

PVM

Probe vehicle management

PXG

Platform exchange grid node

pxGrid

Platform exchange grid

QoS

Quiality of service

RADIUS

Remote authentication dial-in user service

REP

Resilient Ethernet protocol

RLOC

Routing locator

RLVW

Red light violation warning

RPL

Routing protocol for low-power and lossy networks

RPoPs

Remote points-of-presence

RSA

Roadside alert

RSU

Roadside unit

RSZW

Reduce speed/work zone warning

RTA

Right turn assist
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RTU Remote terminal unit

SA Substation automation

SCADA Supervisory control and data acquisition
SCMS Security credential management system
SD-Access Software-defined Access

SD-WAN Software defined wide area network
SFC Secure network analytics flow collector
SFC Secure Network Analytics Flow Collector
SGACL Security group-based access control list
SGT Security group tag

SLC Street light controller

Sov Service operations vessel

SPAT Signal phase and timing message

SRM Signal request message

SSID Service set identifier

SSM Software security module

STP Spanning tree protocol

Svi Switched virtual interface

SVL StackWise virtual link

SXP SGT exchange protocol

TAN Turbine area network

TBN Turbine base network

TC Transit control

TCP Transmission control protocol

TFTP Trivial file transfer protocol

TIM Traveler information message

TLS Transport layer security

TLV Type length value

T™MC Traffic monitoring center

TPE ThingPark Enterprise

ucs Cisco Unified Computing System

ubP User datagram protocol

UHF Ultra high frequency
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UPS Uninterrupted power supply
V2I Vehicle to infrastructure

V2P Vehicle to pedestrian

vav Vehicle to vehicle

V2x Vehicle to infrastructure

VHF Very high frequency

VLAN Virtual local area network

VN Virtual network

VNI VXLAN network identifier

VoD Video on demand

VolP Voice over internet protocol
VPN Virtual private network

VRF Virtual routing and forwarding
VSM Video Surveillance Manager
VXLAN Virtual extensible LAN

WAN Wide area network

WAVE Wireless access in vehicular networking
WF Wind farm

Wi-Fi Wireless fidelity

WLAN Wireless local area network
WLC Wireless LAN controller

WPAN Wireless personal area network
WRED Weighted random early detect
WSMP WAVE short message protocol
WTG Wind turbine generator

ZTD Zero touch deployment

ZTP Zero touch provisioning
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